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LIMITED WARRANTY AND LIMITATION OF LIABILITY

Horner APG, LLC, ("HE-APG") warrants to the original purchaser that the Canvas 7D OCS module manufactured by HE-APG is free
from defects in material and workmanship under normal use and service. The obligation of HE-APG under this warranty shall be
limited to the repair or exchange of any part or parts which may prove defective under normal use and service within two (2) years from
the date of manufacture or eighteen (18) months from the date of installation by the original purchaser whichever occurs first, such
defect to be disclosed to the satisfaction of HE-APG after examination by HE-APG of the allegedly defective part or parts. THIS
WARRANTY IS EXPRESSLY IN LIEU OF ALL OTHER WARRANTIES EXPRESSED OR IMPLIED INCLUDING THE WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR USE AND OF ALL OTHER OBLIGATIONS OR LIABILITIES AND HE-APG NEITHER
ASSUMES, NOR AUTHORIZES ANY OTHER PERSON TO ASSUME FOR HE-APG, ANY OTHER LIABILITY IN CONNECTION
WITH THE SALE OF THIS Canvas 7D OCS MODULE. THIS WARRANTY SHALL NOT APPLY TO THIS Canvas 7D OCS MODULE
OR ANY PART THEREOF WHICH HAS BEEN SUBJECT TO ACCIDENT, NEGLIGENCE, ALTERATION, ABUSE, OR MISUSE. HE-
APG MAKES NO WARRANTY WHATSOEVER IN RESPECT TO ACCESSORIES OR PARTS NOT SUPPLIED BY HE-APG. THE
TERM "ORIGINAL PURCHASER", AS USED IN THIS WARRANTY, SHALL BE DEEMED TO MEAN THAT PERSON FOR WHOM
THE Canvas 7D OCS MODULE IS ORIGINALLY INSTALLED. THIS WARRANTY SHALL APPLY ONLY WITHIN THE BOUNDARIES
OF THE CONTINENTAL UNITED STATES.

In no event, whether as a result of breach of contract, warranty, tort (including negligence) or otherwise, shall HE-APG or its suppliers
be liable of any special, consequential, incidental or penal damages including, but not limited to, loss of profit or revenues, loss of use
of the products or any associated equipment, damage to associated equipment, cost of capital, cost of substitute products, facilities,
services or replacement power, down time costs, or claims of original purchaser's customers for such damages.

To obtain warranty service, return the product to your distributor with a description of the problem, proof of purchase,
postpaid, insured and in a suitable package.

ABOUT PROGRAMMING EXAMPLES

Any example programs and program segments in this manual or provided on accompanying media are included solely for illustrative
purposes. Due to the many variables and requirements associated with any particular installation, Horner APG cannot assume
responsibility or liability for actual use based on the examples and diagrams. It is the sole responsibility of the system designer utilizing
the Canvas 7D OCS module to appropriately design the end system, to appropriately integrate the Canvas 7D OCS module and to
make safety provisions for the end equipment as is usual and customary in industrial applications as defined in any codes or standards
which apply.

NOTE: The programming examples shown in this manual are for illustrative purposes only. Proper machine operation is
the sole responsibility of the system integrator.
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PREFACE

This manual explains how to use the Canvas 7D OCS.

Copyright (C) 2024 Horner APG, LLC, 59 South State Avenue, Indianapolis, Indiana 46201. All rights reserved. No part of this
publication may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language or computer
language, in any form by any means, electronic, mechanical, magnetic, optical, chemical, manual or otherwise, without the prior
agreement and written permission of Horner APG, Inc.

All software described in this document or media is also copyrighted material subject to the terms and conditions of the Horner
Software License Agreement.

Information in this document is subject to change without notice and does not represent a commitment on the part of Horner APG.

Cscape, SmartStack, SmartStix, SmartRail, and CsCAN are trademarks of Horner APG. Ethernet is a trademark of Xerox
Corporation®.

microSD® and CompactFlash are registered trademarks of SanDisk Corporation®.

Published with Madcap Flare®.

North America

Tel: (+) (317) 916-4274

Fax: (+) (317) 639-4279

Web: https://www.hornerautomation.com
Email: APGUSATechSupport@heapg.com

Europe

Tel: (+) 353-21-4321-266

Fax: (+) 353-21-4321-826

Web: https://hornerautomation.eu

Email: technical.support@hornerapg.com
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Chapter 1: Safety and Compliance
1.1: Warnings

When found on the product, the following symbols specify:

WARNING: Consult user documentation.

WARNING: Electrical Shock Hazard.
WARNING: EXPLOSION HAZARD - Substitution of components may impair suitability for Class I, Division 2.

WARNING: EXPLOSION HAZARD - Do not disconnect equipment unless power has been switched off or the area is
known to be non-hazardous.

1. To avoid the risk of electric shock or burns, always connect the safety (or earth) ground before making any
other connections.

2. Toreduce the risk of fire, electrical shock, or physical injury it is strongly recommended to fuse the voltage
measurement inputs. Be sure to locate fuses as close to the source as possible.

3. Replace fuse with the same type and rating to provide protection against risk of fire and shock hazards.

4. Inthe event of repeated failure, do not replace the fuse again as a repeated failure indicates a defective
condition that will not clear by replacing the fuse.

5. Only qualified electrical personnel familiar with the construction and operation of this equipment and the
hazards involved should install, adjust, operate, or service this equipment. Read and understand this
manual and other applicable manuals in their entirety before proceeding. Failure to observe this precaution
could result in severe bodily injury or loss of life.

WARNING: BATTERY MAY EXPLODE IF MISTREATED. DO NOT RECHARGE, DISASSEMBLE, OR DISPOSE OF IN
FIRE.

WARNING: BATTERIES MUST ONLY BE CHANGED IN AN AREA KNOWN TO BE NON-HAZARDOUS.

WARNING: The USB parts are for operational maintenance only. Do not leave permanently connected unless area is
known to be non-hazardous.

WARNING: If the equipment is used in a manner not specified by Horner APG, the protection provided by the equipment
may be impaired.

NOTE: All applicable codes and standards need to be followed in the installation of this product.
NOTE: For I/0 wiring (discrete), use the following wire type or equivalent: Belden 9918, 18 AWG, or larger.

NOTE: See the "Electrical Installation" on page 24for more details.

Page 9 of 209
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1.2: FCC Compliance

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:

1.
2.

This device may not cause harmful interference.

This device must accept any interference received, including interference that may cause undesired
operation.

1.3: Safety Precautions

Adhere to the following safety precautions whenever any type of connection is made to the module:

Il applicable codes and standards need to be followed in the installation of this product. Adhere to the following
safety precautions whenever any type of connection is made to the module:

1.

o0k o0Dd

10.
11.
12.

Connect the safety (earth) ground on the power connector first before making any other connections.
When connecting to the electric circuits or pulse-initiating equipment, open their related breakers.
Do NOT make connection to live power lines.

Make connections to the module first; then connect to the circuit to be monitored.

Route power wires in a safe manner in accordance with good practice and local codes.

Wear proper personal protective equipment including safety glasses and insulated gloves when making
connections to power circuits.

Ensure hands, shoes, and floor are dry before making any connection to a power line.

Make sure the unit is turned OFF before making connection to terminals.

Make sure all circuits are de-energized before making connections.

Before each use, inspect all cables for breaks or cracks in the insulation. Replace immediately if defective.
Use copper conductors in Field Wiring only, 60/75°C.

Use caution when connecting controllers to PCs via serial or USB. PCs, especially laptops may use
“floating power supplies” that are ungrounded. This could cause a damaging voltage potential between the
laptop and controller. Ensure the controller and laptop are grounded for maximum protection. Consider
using a USB isolator due to voltage potential differences as a preventative measure.

Page 10 of 209
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Chapter 2: Intro to the Canvas 7D

Chapter 2: Intro to the Canvas 7D

2.3: Connectivity to the Canvas 7D
2.4: Features of Canvas 7D OCS

2.1: Visual Overview of Canvas 7D

©

10.
11.
12.
13.

NOTE: See Precaution #12 on page 4 about USB and grounding.

O NSO R Db

EAHORNER

b a7
CANVAS: 4
"D —ie

T

HG-746

Touchscreen

Function Keys

MJ1: RS-232/MJ2: 1/2 Duplex RS-485
DIP Switches

MJ3: RS-232 / RS-485 Serial Port
CAN1 Port

Power: 10-30VDC In

Audio In & Out Ports

USB Type A 2.0: Flash Drive

LAN 1 & 2 Ports

CAN 2 Port

USB Type Mini B: Programming
microSD: Data Storage

Page 12 of 209
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2.2: Where to find more information for the Canvas 7D

Datasheets - The datasheets are the first documents to refer to for key information related to specific models. (A basic
datasheet is provided in the box with the unit.)

Find the documents via the Documentation Search page on the Horner website.

Datasheet Manual Numbers
Canvas 7D Model 0 MAN1385
Canvas 7D Model 2 MAN1386
Canvas 7D Model 3 MAN1387
Canvas 7D Model 4 MAN1388
Canvas 7D Model 5 MAN1389
Canvas 7D Model 6 MAN1392

2.3: Connectivity to the Canvas 7D

Connectivity

CAN 110 USB Serial Ethernet
Other OCS Devices | Sensors Flash Drive Other OCS Devices Cscape
SmartStix I/O Indicators Cscape Drives OPC Server
SmartBlock 1/0 Alarms PLCs Modbus TCP Devices
SmartRail I/0 Encoders Printers
OPC Pumps SCADA
Relays OPC Server
Solenoids Portal
I/O Devices
SmartRail Devices
Keyboard
Camera
Mouse

Page 13 of 209
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2.4: Features of Canvas 7D OCS

The Canvas 7D OCS are all-in-one industrial control devices. They combine control, user interface, /0 and networking into a
single, integrated package. Unique features of the Canvas 7D OCS include:

®  Bright, 65,536 color graphical touch sensing LCD display in all models of Canvas 7D.

®  Display of complex graphical objects including trends, gauges, meters and animations.

®  High performance graphic processing.

®  Advanced control capabilities including floating point, multiple auto-tuning PID loops, and string handling capabilities.
®  Removable media for 32GB of storage of programs, data logging, or screen captures.

®  CsCAN networking port for communication with remote I/O, other controllers, or PCs.

®  High speed USB port for communication with PCs and programming of controller.

®  Configurable serial protocols for communication to drives, PLCs, or other serial peripherals.

B Full featured, built-in I/O including high resolution analog, thermocouple, RTD, high speed counters, PWM outputs, and
relays (depending upon the Canvas 7D OCS model used).

®  Advanced high speed I/O capabilities.

®  Cscape programming software that allows all aspects of the Canvas 7D OCS to be programmed and configured from
one integrated application.

®  Optional communication add-on modules.

®  On board Ethernet port (10/100Mbps) for Cscape programming and application defined communication, with Auto
MDI/MDI-X.

Page 14 of 209



II HORNER

AUTOMATION GROUP

Mechanical
Installation




AUTOMATION GROUP

II HORNER

Chapter 3: Mechanical Installation

Chapter 3: Mechanical Installation

3.1: Mounting Requirements . . . 16
3.2: Mounting Orientation ... .. 17
3.3: Canvas 7D Back Cover DIMeNSIONS .......... ... 18
3.4: Canvas 7D DImeNnsioNs ... ... 19
3.5: Installation Procedure ... ... . 20
3.6: Factors Affecting Panel Layout Design and Clearances ..................................................................... 21

NOTE: The datasheet is the first document to refer to for model-specific information related to Canvas 7D models such as pin-
outs, jumper settings, and other key installation information. See the Documentation Search for datasheets.

The mechanical installation greatly affects the operation, safety and appearance of the system. Information is provided to
mechanically install the unit such as cut-out sizes, mounting procedures, and other recommendations for the proper mechanical
installation of the unit.

3.1: Mounting Requirements

i

Once the panel design has been completed using the criteria and suggestions in the following sections, use the following steps
to panel mount the Canvas 7D OCS.

1. Remove all connectors from the Canvas 7D OCS unit.

2. Make sure the gasket is installed on the Canvas 7D OCS and is free from dust and debris. Check that the corners of the
gasket are secure.

3. Pass the unit through the panel.

4. Insert each of the four (4) mounting clips into the slots in the Canvas 7D OCS case. One clip should be installed on
each corner. Lightly tighten each screw so the clip is held in place.

5. Tighten the screws on the clips such that the gasket is compressed against the panel. Recommended torque is 7-10
inelbs (0.8-1.13 N*m).

Page 16 of 209
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3.2: Mounting Orientation

Canvas 7D OCS Mounting Clip

Canvas 7D OCS Mounting Orientation

v

NOTE: There are no orientation restrictions on the Canvas 7D OCS. However, the above orientation provides for optimum
readability of the screen and ease of use of the keypad.

Page 17 of 209
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3.3: Canvas 7D Back Cover Dimensions
Standard Back Cover Dimensions

297
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(8.500mm) |_| opr
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351"
(89.15mm)
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HG-550

Extended 1/0 Back Cover Dimensions
3.38"
(85.85mm)

-~ 33

139 (8.500mm)
(33.78mm) B

351"
(89.15mm)

3.05” i
He-s49  (TTA7mm)
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3.4: Canvas 7D Dimensions
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3.5: Installation Procedure

®  The Canvas 7D utilizes a clip installation method to ensure a robust and watertight seal to the enclosure. Please follow
the steps below for the proper installation and operation of the unit.

®  This equipmentis suitable for Class |, Division 2, Groups A, B, C and D or non-hazardous locations only.
= Digital outputs shall be supplied from the same source as the operator control station.

= Jumpers on connector JP1 shall not be removed or replaced while the circuit is live unless the area is known to be free
of ignitable concentrations of flammable gases or vapors.

The Canvas 7D utilizes a clip installation method to ensure a robust and watertight seal to the enclosure. Please follow the steps
below for the proper installation and operation of the unit.

1. Carefully locate an appropriate place to mount the Canvas 7D. Be sure to leave enough room at the top of the unit for
insertion and removal of the microSD™ card.

2. Carefully cut the host panel per the diagram, creating a 131.2mm x 189.7mm with a +1.6mm /-Omm panel cutout
tolerance, opening into which the Canvas 7D may be installed. If the opening is too large, water may leak into the
enclosure, potentially damaging the unit. If the opening is too small, the OCS may not fit through the hole without
damage.

3. Remove any burrs and or sharp edges and ensure the panel is not warped in the cutting process.

4. Remove all Removable Terminals from the Canvas 7D. Insert the Canvas 7D through the panel cutout (from the front).
The gasket must be between the host panel and the Canvas 7D.

5. Install and tighten the four mounting clips (provided in the box) until the gasket forms a tight seal NOTE:
Recommended torque is 7 to 10 in¢lbs (0.8 to 1.13N*m)

6. Reinstall the Canvas 7D I/O Removable Terminal Blocks. Connect communications cables to the serial port, USB
ports, Ethernet port, and CAN port as required.

Page 20 of 209
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3.6: Factors Affecting Panel Layout Design and Clearances

WARNING: It is important to follow the requirements of the panel manufacture and to follow all applicable electrical codes and
standards.

The designer of a panel layout must assess the requirements of a particular system and to consider the following design factors.

3.6.1: Clearance / Adequate Space

Install devices to allow sufficient clearance to open and close the panel door.

Minimum Clearance Requirements for Panel Box and Door

Minimum Distance between base of device and sides of cabinet 2” (50.80 mm)

Minimum Distance between base of device and wiring ducts 1.5” (38.10 mm)

If more than one device installed in panel box (or on door): , )
o . . 4” (101.60 mm) between bases of each device
Minimum Distance between bases of each device

When door is closed:
Minimum distance between device and closed door 2”7 (50.80 mm)
(Be sure to allow enough depth for the OCS.)

3.6.2: Grounding

Panel Box: The panel box must be properly connected to earth ground to provide a good common ground reference.

Panel Door: Tie a low impedance ground strap between the panel box and the panel door to ensure that they have the same
ground reference.

WARNING: Be sure meet the ground requirements of the panel manufactuer and also meet applicable electrical codes and
standards.

3.6.3: Temperature / Ventilation

Ensure that the panel layout design allows for adequate ventilation and maintains the specified ambient temperature range.
Consider the impact on the design of the panel layout if operating at the extreme ends of the ambient temperature range. For
example, if it is determined that a cooling device is required, allow adequate space and clearances for the device in the panel
box or on the panel door.

3.6.4: Noise

Consider the impact on the panel layout design and clearance requirements if noise suppression devices are needed. Be sure to
maintain an adequate distance between the OCS and noisy devices such as relays, motor starters, etc.

3.6.5: Shock and Vibration

The OCS has been designed to operate in typical industrial environments that may inflict some shock and vibration on the unit.
For applications that may inflict excessive shock and vibration please use proper dampening techniques or relocate the OCS to
a location that minimizes shock and/or vibration.

3.6.6: Panel Layout Design and Clearance Checklist

The following list provides highlights of panel layout design factors:

Page 21 of 209
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Meets the electrical code and applicable standards for proper grounding, etc.?
Meets the panel manufacturer’s requirements for grounding, etc.?

Is the panel box properly connected to earth ground? Is the panel door properly grounded? Has the appropriate
procedure been followed to properly ground the devices in the panel box and on the panel door?

Are minimum clearance requirements met? Can the panel door be easily opened and closed? Is there adequate space
between device bases as well as the sides of the panel and wiring ducts?

Is the panel box deep enough to accommodate the controller?
Is there adequate ventilation? Is the ambient temperature range maintained? Are cooling or heating devices required?

Are noise suppression devices or isolation transformers required? Is there adequate distance between the base of the
controller and noisy devices such as relays or motor starters? Ensure that power and signal wires are not routed in the
same conduit.

Are there other requirements that impact the particular system, which need to be considered?
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Chapter 4: Electrical Installation

4.1: Ground SpecCifiCatioNs ... 24
4.2: How to Test for Good Ground ... ... ... . . 24
4.3: Primary Power Port 25

NOTE: The datasheet is the first document to refer to for model-specific information. Refer to the Documentation Search on
the Horner website.

4.1: Ground Specifications

Ideally, a ground resistance measurement from equipment to earth ground is 0Q. In reality it typically is higher. The US National
Electrical Code (NEC) states the resistance to ground shall not exceed 25Q. Horner Automation recommends less than 15Q
resistance from the equipment to ground. Resistance greater than 25Q can cause undesirable or harmful interference to the
device.

Grounding Definition - The term ground is defined as a conductive connection between a circuit or piece of equipment and the
earth. Grounds are fundamentally used to protect an application from harmful interference

causing either physical damage such as by lightning or voltage transients or from circuit disruption often caused by radio
frequency interference (RFI).

4.2: How to Test for Good Ground

In order to test ground resistance, a Ground Resistance Tester must be used. A typical Ground Resistance Meter Kit contains a
meter, two or three wire leads, and two ground rods. Instructions are supplied for either a two-point or a three-point ground test.
The figure shows a two-point ground connection test.

GROUND RESISTANCE METER

- v

T

GROUND
DISCONNECTED
FROM SERVICE

e |

METAL WATER PIPE OR
HG-187 OTHER GOOD GROUND

GROUND ROD
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4.3: Primary Power Port

The Primary Power Range is 10-30 VDC.

Primary Power Port Pins

PIN Signal Description
1 Ground Frame Ground
2 DC- Input Power Supply Ground
3 DC+ Input Power Supply Voltage

4.3.1: DC Input/Frame

¢ Solid/Stranded Wire: 12-24 AWG (92.5-0.2 mm?)
e Strip length: 0.28” (7 mm)
e Torque, Terminal Hold-Down Screws: 4.5 — 7 in+Ibs (0.50 — 0.78 N+m)

¢ DC-isinternally connected to I/0 V-, but is isolated from the V- connection of both CAN1 and CAN2 ports.
A Class 2 power supply must be used.

4.3.2: Power Up

1. OPTIONAL: Attach ferrite core with a minimum of two turns of the DC+ and DC- signals from the DC
supply that is powering the controllers.

HG-006 0714-2023

2. Connect to earth ground.
3. Apply recommended power.

NOTE: Refer to datasheet for power specifications
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Chapter 5: System Settings

5.1: System Menu - Overview, Navigation, and Editing .................. ... . . . . 27
5.2: LED Indicator Lights ... ... .. . 29
5.3: System MenU Map ... ... 30

B4 St NEWOITKS . 31

5.5: View Status & Diags ... ... ...l 34
5.6: Removable Media ... ... ... . 45
5.7: Fail — Safe System .. 46
5.8 User INterface .. ... ... 50
5.9: Touch Screen Calibration 51

NOTE: To access the Main Menu, press the upper, right corner of the screen to expose thefunction keys and SYSTEM key.

5.1: System Menu - Overview, Navigation, and Editing

System Menu Overview
Canvas 7D has a built-in System Menu. Use the System Menu to view and adjust the System Settings.
* To Start the System Menu: Press the SYSTEM key (or set %SR3 to 1). This will display the Main Menu.

¢ To Navigate the Main Menu: On the Main Menu, use 1 and | (click the sliding for up & down) to select a Main Menu
item and to display the submenu for the item.

¢ To Close the System Menu: Press Close to exit the System menu.
SYSTEM MENU (X) Close

s == X

Performance Diagnostics Capacity

Network

L L 9

Serial Port Time & Date Media Fail Safe

19-Apr-24 IP1:192.168.254.128 CVv-070D-00 (0] ¢ m

-

13:11:46 IP2: 000.000.000.000 CANID: 2 Run Linear View
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System Menu View Options
There are two available System Menu views: Linear and Grid.

e System Menu - Linear View: On the System Menu screen, select Linear View to display the System Menu items in a
single line. Scroll left and right to view all menu options.

SYSTEM MENU (X) Close

: X @

Performance Diagnostics

Capacity

19-Apr-24 1P1:192.168.254.128 CV-070D-00
13:21:.04 1P2: 000.000.000.000 CANID: 2 Run Grid View

e System Menu - Grid View: On the System Menu screen, select Grid View to display the System Menu items in a table
containing multiple items.

SYSTEM MENU (%) Close

Performance Diagnostics

I 4

Serial Port Time & Date Media Fail Safe

19-Apr-24 IP1: 192.168.254.128 Cv-070D-00 (0] 4
13:11:46 IP2: 000.000.000.000 CANID: 2 Run Linear View

System Menu Navigation

Note: Select Close to exit submenus and return to the Main Menu, and to exit the Main Menu to return to the System Menu
screen.

Following accessing the System Menu, use the up & down sliders to select an item and display the submenu of the item. The
submenu contains a list of choices for the System Settings and their values.

System Settings that can be edited are highlighted. Use the up & down sliders to scroll through the available System Setting
options. Use the touchscreen icons to select new values. Tap the touchscreen to change the values.

¢ Select Enter to save the changes.

e Select Back to cancel the edit.

Numeric Keys

The numeric keys are used to enter number values into the System Settings. Use the arrows on the display to select digits and
the number keys to change the values.

Press Enter to save or Back to cancel the change.

Page 28 of 209



AUTOMATION GROUP

II HORNER

Chapter 5: System Settings

0000000000

5.2: LED Indicator Lights

Canvas series controllers have virtual OK and Run LEDs in the System Menu as shown in the following image.

SYSTEM MENU (X) Close

N

Performance Diagnostics

.

Serial Port Time & Date Media

02-Apr-24 IP1:192.168.254.128 Cv-070D-00
11:43:41 IP2: 000.000.000.000 CAN ID: 253 Run Linear View

OCS LEDs

B OFF indicates OCSis in IDLE/STOP mode.

®  Flashing indicates DO /10 mode or RUN with no ladder program.

RUN

B ON indicates ladder code running.

B OFF indicates one or more self-tests failed.
G B ON indicates all self-tests passed.

®  Flashing at 1 Hz indicates forcing is active.
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5.3: System Menu Map

HG-749

Sub-Menus Sub-Menus
CAN CPU & Memory
LAN 10 Slots
WIFI CAN Network
Version
CANT1ID: 253
CAN1 Baud: 125KB CANVAS 7D Scan Rate: 1.4ms
CANT1 Protocol: CsCAN System Menu Map Internal Mem A: 1-10%
CAN2 ID: 0 Internal Mem B: 1-10%
CAN2 Baud: 125KB CPU Temperature: 77.9°C
CAN2 Protocol: NONE Min CPU Temp: 51.6°C
Max CPU Temp: 78.7°C
RTC Battery Age: <Tyrs
MAC-ID1: 00:E£0:C4:09:88:4E
IP Addresst: 192.168.254.128
NetMask: 255.255.255.255 Network 10 System: ) Ok
Gatewayl: X X X Slot O1: 1/0: Empt
DHCP1: / 000-000:000 Oﬁg Performance Slot 02: 1/0: Emm
DNS1: 000.000.000.000 ’ ) Slot 03: 1/0: ETN300
MAC-ID2: Diagnostics 0CS-1/0 Config: >
IP Address2: 000.000.000.000 i
NetMask2: 000.000.000.000 Capacity
gatggvzayl 000.000.000.000 Serial Port Eﬁm g;;?; Oﬁ
: No .
DNS2: 000.000.000.000 Time & Date gﬁm ::I):)ljlplicate o: Zgi
Media Local Network Usage: 0
WiFi Hardware: No A All Network Usage: 0
WiFi Mode: Disabled Fail Safe
MAC ID: 000.000.000.000
Access Point:: User Interface EP"g‘AW;"e Rev: 16.33.202
. ev: 0.2
gaeg\év\scr)t:dl\:lame (SSID): :ggg (Press Close to Exit) 0S Version: 419.49
Network IP: 000.000.000.000 System Version: 59
Channel: Auto
=Client:
Join Network: None
Password: None
Auto Connect: No
Status: None Local Time: 15:29:45
Client IP: 000.000.000.000 Local Date: 04:April:2024
Signal Health: None UTC Time: 15:29:45
UTC Date: 04:April:2024
Time Zone: off
Mode: Run Daylight Savings: Off
Self Test: Ok
Logic Error: Ok
Watch Dog Trips: 0
User Prog?”am:p Ok [ Media Directory |
User Graphics: Ok [ Media Card Not Present |
Real Time Clock Error: Warn
Auto Run: Off
Logic Size: 8518 0.04% Full Backup/Restore Data: >
1/0 Config Size: 780B  0.15% Full Auto Load SD: off
Graphic Size: 521748 0.01% Full Auto Load USB: Off
Protocol Size: 248 0% Full
SMS File Size: 1728 0.13% Full
Text Table Size: 60B 0.01% Full Screen Saver Enable: Off
Screen Saver Timeout: 15min
Pop Up Notification: Off
Default Prog Port: MJ1-232 SYS Fn Enable: On
MJ2 RS485 Bias: No Beeper Enable: On
MJ3 RS485 Bias: No Fkeys: Momentary
MJ1 Protocol: (None Loaded)
MJ2 Protocol: (None Loaded)
MJ3 Protocol: (None Loaded)
COM Protocol: (None Loaded)
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5.4: Set Networks

SYSTEM MENU > NETWORKS

2
-' 0

LAN WiFi

02-Apr-24 1P1:192.168.254.128 CV-070D-00
11:45:03 IP2: 000.000.000.000 CAN ID: 253

This sub menu allows the setting for the CAN, LAN and WiFi network to be viewed or changed.
CAN Settings

ﬁHome SYSTEM MENU > NETWORK > CAN SETTINGS 4= Back

CAN1ID

CAN1 Baud

CANT1 Protocol

CAN2ID

253

125KB

CsCAN

]

CAN2 Baud

CAN2 Protocol

02-Apr-24 IP1:192.168.254.128 CV-070D-00
11:45:07 IP2: 000.000.000.000 CAN ID: 253

Yes = CAN1 connected to a CAN network and functioning properly

CAN Ok? .
No = Not ready to communicate on CAN network

CAN1 ID 1to 253 = This node’s CsCAN Network ID
110 127 = This node's CANopen Network ID; must be unique on network

CAN1 Baud 125kB = 125k Bd CAN network 500kB =500 kBd CAN network
250kB =250 kBd CAN network 1MB = 1 MBd CAN network

CAN1 Protocol | CsCAN/CANopen

Yes = CAN1 connected to a CAN network and functioning properly

CAN2 Ok? .
No = Not ready to communicate on CAN network
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1 to 253 = This node’s CsCAN Network ID
CAN2 ID 110 127 = This node's CANopen Network IDor J1939 Network ID;

0-63 = This node's CsCAN Network ID; must be unique on network

125kB = 125 kBd CAN network 500kB =500 kBd CAN network
CAN2 Baud

250kB = 250 kBd CAN network 1MB = 1 MBd CAN network
CAN2 Protocol | CsSCAN/CANopen/DeviceNet/J1939

LAN Settings

ﬁ Home

MAC-ID1

SYSTEM MENU > NETWORK >

IP Address1

NetMask1

Gateway1

DHCP1

DNS1

02-Apr-24
11:45:12

IP1:192.168.254.128
IP2: 000.000.000.000

CGVv-070D-00
CAN ID: 253

LAN SETTINGS 4 Back

00:E0:C4:09:88:4E
192.168.254.128
255.255.255.000

000.000.000.000

000.000.000.000

OK

MAC ID1 Displays the Ethernet MAC ID of the LAN1

IP Address 1 Displays the Ethernet IP address of the LAN1
NetMask1 Displays the Ethernet NetMask of the LAN1
Gateway1 Displays the Ethernet Gateway of the LAN1
DHCP1 Enable/Disable DHCP of the LAN1

DNSA1 Displays the DNS server of the LAN1

MAC ID2 Displays the Ethernet MAC ID of the LAN2

IP Address2 Displays the Ethernet IP address of the LAN2
NetMask2 Displays the Ethernet NetMask of the LAN2
Gateway?2 Displays the Ethernet Gateway of the LAN2
DHCP2 Enable/Disable DHCP of the LAN2

DNS2 Displays the DNS server of the LAN2

NOTE: The IP address, Net Mask, and Gateway can be changed from the System Menu. This is designed for commissioning or

temporary field changes. The actual parameters are defined in Cscape under the Ethernet configuration.

WiFi Settings
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ﬁ Home

SYSTEM MENU > NETWORK > WIFI SETTINGS 4 Back

WiFi Hardware? No

WiFi mode

MAC ID

Disabled

00:00:00:00:00:00

:: Access Point ::

Network Name(SSID)

Password

02-Apr-24
12:10:06

IP1:192.168.254.128
1P2: 000.000.000.000

Cv-070D-00
CAN ID: 253

WiFi Hardware?

Displays Hardware present or not

WiFi Mode

Displays as None/Access Point/Client

MAC ID

Displays the MAC ID of WiFi Hardware, if installed

Access Point

Network Name (SSID)

View/Modify the Network Name

Password

View/Modify thePassword Network Name

Encryption View/Modify the Encryption standard
Network IP View/Modify the Network IP
Channel View/Modify the Channel

Client

Join Network

View/Select the list of available Networks to join

Auto Connect

Set the network to Auto Connect or None

Status Displays the Status as Connected or None
Client IP Displays the Client IP address
Signal Health Displays the Signal Health
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5.5: View Status & Diags
5.5.1: View Status

Performance
ﬁ Home SYSTEM MENU > PERFORMANCE

Mode
Self Test

Logic Error

Watch Dog Trips

User Program
User Graphics

02-Apr-24 IP1:192.168.254.128 CV-070D-00
11:56:00 IP2: 000.000.000.000 CAN ID: 253

Idle = Canvas 7D OCS is in Idle Mode
Mode DolO =Canvas 7D is in Do I/O Mode
Run = Canvas 7D is in Run Mode

Ok = All power-on self tests passed

Self-Test .
Fault = One or more power-on self-tests failed
Lodic Error Ok = All executed ladder instructions are legal for loaded firmware
< Fault = A ladder instruction not supported by firmware was found
. 0 = Watchdog timer has not tripped since the last power-up
Watchdog Trips

X =Number of times the watchdog timer has tripped

Ok = Ladder program and I/O configuration loaded successfully

User Program
< Fault = Ladder program or I/O configuration not loaded or load failed

Ok = Application graphics objects loaded successfully

User Graphics
: Fault = Application graphics objects not loaded or load failed

Ok = Time and date have been set
Warning = Time and date need to be set

Real Time Clock Error

5.5.2: View Diags

Diagnostics
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4 Home SYSTEM MENU > DIAGNOSTICS

CPU & Memory CAN Network Version

02-Apr-24 IP1:192.168.254.128 Cv-070D-00
12:02:30 IP2: 000.000.000.000 CAN ID: 253

This submenu displays the CPU and Memory, I/O Slots, CAN Network and Version to be viewed.

CPU and Memory
ﬂ Home SYSTEM MENU > DIAGNOSTICS > CPU AND MEMORY | 4% Back
Internal Mem A 1-10 %
Internal Mem B 1-10 %
CPU Temperature 70.6°C
Min CPU Temp 43.7°C

Max CPU Temp 81.6°C

RTC Battery Age <7yrs

02-Apr-24 IP1:192.168.254.128 CVv-070D-00
12:02:35 IP2: 000.000.000.000 CAN ID: 253

0.0 = Canvas 7D OCS is not in Run Mode
Scan Rate (mS) . R

0.1 10 999.9 = Average timefor each ladder scan, in milliseconds (ms)
Internal Memory A 1to 100% = Internal Memory A percent used by this OCS node
Internal Memory B 1 to 100% = Internal Memory B percent used by this OCS node
CPU Temperature X = Displays CPU in degrees Celsius (°C)
Ul e s X = Displays CPU minimum in degrees Celsius (°C)
Temperature
Maximum CPU X = Displays CPU maximum in degrees Celsius (°C)
Temperature
RTC Battery Age X = Displays RTC Battery Age in years

5.5.3: View 1/O Slots
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4 Home SYSTEM MENU > DIAGNOSTICS > 10 SLOTS 4 Back

10 System Ok

Slot 01 1/0: Empty

Slot 02 1/0: Empty

Slot 03 1/0: ETN300

0OCSIO Configuration

02-Apr-24 IP1:192.168.254.128 CV-070D-00
12:02:44 IP2: 000.000.000.000 CAN ID: 253

I/O System

Ok = I/0O configuration matches the installed I/O and COM modules.
Warning = I/0O configuration needs updating to match installed modules.

The View I/O Slots submenu displays four System Settings, all of which are not editable.

Internal to the OCS, there is a CPU board, and up to two installed modules. Model 0 has no installed 1/O or COM modules. All
other models have an I/O module and can have a user-installed COM module.

Depending on which 1/0 module is installed and which I/O module has been configured by Cscape, one of the following six
System Settings should appear for Slot 1:

Slot 1: I/O: Empty

= No I/0 module installed or configured

Slot 1:*Unsupported

= Unsupported I/0 module installed

Slot 1:- I/O Missing

= No I/O module installed but an I/O module is configured

Slot 1:+ 1/0: XExyy

=yy I/0 module installed but no I/O module configured

Slot 1:? I/O: XExyy

=yy I/0 module installed but another 1/O module configured

Slot 1: 1/0: XExyy

=yy I/O module installed and configured properly
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six System Settings appears for Slot 2:

Slot 2: 1/0: Empty

= No COM module installed or configured

Slot 2:*Unsupported

= Unsupported COM module installed

Slot 2:- 1/0 Missing

=No COM module installed but a COM module is configured

Slot 2:+ 1/0: XzC

=z COM module installed but no COM module configured

Slot 2:? 1/0: XzC

=z COM module installed but another COM module configured

Slot 2: I/0: XzC

=z COM module installed and configured properly

| Slot 3: 1/0: ETN300

| = ETN300 has been configured through Cscape

| OCs-1/0 Configuration

| = OCS-1/O has been configured through Cscape

OCS-I/O Configuration

ﬁ Home

02-Apr-24
12:22:03

SYSTEM MENU > DIAGNOSTICS > |0 SLOTS > OCSIO 4 Back
CONFIGURATION

NO OCSIO BASES CONFIGURED

IP1:192.168.254.128 CV-070D-00
IP2: 000.000.000.000 CAN ID: 253
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CAN Network

4 tome, SYSTEM MENU > DIAGNOSTICS > CAN NETWORK | 4% Back

CAN?1 Error

CAN1 State

CANT1 ID

CAN1 Duplicate ID
LCL Network Usage
All Network Usage

02-Apr-24 IP1:192.168.254.128 Cv-070D-00
12:02:50 IP2: 000.000.000.000 CAN ID: 253

0 = No CAN Network bus-off errors have occurred

CAN1 Error
X =Number of CAN Network bus-off errors that have occurred
Ok = At least one other node was found on the CAN Network
CAN1 State .
Warning = No other nodes were found on the CAN Network
Ok =This node's CAN Network ID is in the range 1 to 253
CAN1ID ' work 1S 9

Warning = This node's CAN Network ID was out of range at power-up

Ok = This node's Network ID is unique on the CAN Network

CAN1 Duplicate ID
> Warning = This node's Network ID is duplicated in another node

Ok = Time and date have been set

Clock Error . .

Warning = Time and date need to be set
Local Network Usage 0.0 to 100.0 = CAN Network bandwidth percent used by this OCS node
All Network Usage 0.0 to 100.0 = CAN Network bandwidth percent used by all nodes

Page 38 of 209



II HORNER

AUTOMATION GROUP
Chapter 5: System Settings

Version

ﬁ Home SYSTEM MENU > DIAGNOSTICS > VERSION 4 Back
Firmware Rev 16.33.201
FPGA Rev 0.2
0S Version
System Version
02-Apr-24 IP1:192.168.254.128 Cv-070D-00
12:02:54 IP2:000.000.000.000 CAN ID: 253

Firmware Rev XX.yy.zz = Current Firmware version

FPGA Rev x.y = Current FPGA version (High Speed I/O Sub System)

OS Version x.yy.zz = Current Operating System version

System Version xx = Current System version
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Capacity

ﬂ- Home SYSTEM MENU > CAPACITY 4 Back
Logic Size 851B 0.04% Full
I/0 Config Size 780 B 0.15% Full
Graphics Size 48079 B 0.01% Full
Protocol Size 24B 0% Full
SMS File Size 172B 0.13% Full
Text Table Size 60 B 0.01% Full
02-Apr-24 IP1: 192.168.254.128 Cv-070D-00 OK
12:14:37 IP2: 000.000.000.000 CAN ID: 253

Logic Size x = Number of bytes in application ladder program

I/O Configuration Size: x = Number of bytes in application I/O configuration

Graphics Size: x = Number of bytes in application graphic screens

Protocol Size:

x = Number of bytes in application downloaded protocols

SMS File Size:

x = Number of bytes in application SMS protocol configuration

Text Table Size:

x = Number of bytes in application text tables
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5.5.4: Set Serial Ports

See also: "Serial Communications"

4 Home SYSTEM MENU > SERIAL PORT 4 Back

Default Prog Port MJ1-232

MJ2 RS485 Bias PR

MJ3 RS485 Bias D

MJ1 Protocol (None Loaded)

MJ2 Protocol

(None Loaded)

02-Apr-24 IP1:192.168.254.128
12:16:55 IP2: 000.000.000.000

CV-070D-00 OK
CAN ID: 253

The Set Serial Ports submenu displays three System Settings, all of which are editable & displays three System Settings (View
Protocol), none of which are editable.

For the Default Prog Port System setting MJ1-232 / MJ3- 232 can be selected, unless a Modem (XMC) COM module is installed.

MJ1-232 = MJ1 RS-232 port is the default programming port

Default Program Port . .
Modem = Modem COM module is the default programming port

No = MJ2 RS-485 bias resistors are not enabled

MJ2 RS-485 Bi
as Yes = MJ2 RS-485 bias resistors are enabled

No = MJ3 RS-485 bias resistors are not enabled
Yes = MJ3 RS-485 bias resistors are enabled

MJ3 RS-485 Bias

As mentioned in Downloadable Serial Communication Protocols section, both the MJ1 (Port 1), MJ2 (Port 2), MJ3 (Port 3) &
COM serial ports support downloadable protocols. To assign a downloadable protocol to an OCS serial port, select the Protocol
Config item in Cscape’s Program menu and then setup a protocol for Port 1, Port 2, Port 3 or COM (or All).

The currently downloaded protocol, if any, and its version number are displayed for both Port 1, Port 2, Port 3 and COM.

Port 1

Protocol Name

(None loaded) or name of the protocol assigned to MJ1

Protocol Version

Blank or version of the protocol assigned to MJ1

Port 2

Protocol Name

(None loaded) or name of the protocol assigned to MJ2

Protocol Version

Blank or version of the protocol assigned to MJ2

Port 3

Protocol Name

(None loaded) or name of the protocol assigned to MJ3

Protocol Version

Blank or version of the protocol assigned to MJ3

COM

Protocol Name

(None loaded) or name of the protocol assigned to COM

Page 41 of 209



../../../../../../../Content/XL7/XL7_UM/XL7_SerialCom.htm

Il HORNER

AUTOMATION GROUP
Chapter 5: System Settings

| Protocol Version | Blank or version of the protocol assigned to COM
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The following instructions are to set and display the real-time clock in the controller. More details can be found in the Help File in

Cscape.

Clock and Time Setting Terms

Coordinated Universal Time (UTC)

Abbreviated to UTC, Coordinated Universal Time is the primary time standard by which
the world regulates clocks and time.

Time Offset

In order to obtain the local time (anywhere in the world), the user needs to subtract / add
a certain number of hours from UTC depending on how many time zones user is away
from Greenwich.

Network Time Protocol (NTP)

A Networking Time Protocol (NTP) for clock synchronization between computer
systems over packet-switched, variable latency data networks.

Daylight Saving Time

Time as adjusted to achieve longer evening daylight, especially in summer, by setting
the clocks an hour ahead of the standard time.

Apply Daylight Saving (DST)

Daylight Saving Time (DST) is the practice of setting the clocks forward one hour from
standard time during the summer months, and back again in the fall, in order to make
better use of natural daylight. Selecting this option increases the Time offset by 1 hour.

System Registers for UTC (Coordinated Universal Time)

%SR210 (R/W)

Time Zone: setin hours £ UTC.

%SR211 (R/W)

Daylight Saving: YES =1
Daylight Saving: NO=0
(If daylight saving is enabled, one hour will be added to the local time).

%SR212 (R) UTC — Seconds
%SR213 (R) UTC — Minutes
%SR214 (R) UTC —Hours
%SR215 (R) UTC - Date
%SR216 (R) UTC — Month
%SR217 (R) UTC - Year
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ﬁ- Home SYSTEM MENU > TIME AND DATE

Local Time 12 17
Local Date p

Local Day

UTC Time 12 17
UTC Date 2

Time Zone +

02-Apr-24 IP1:192.168.254.128 CVv-070D-00
12:17:17 IP2: 000.000.000.000 CAN ID: 2563

To Set Time Zone: The Time Zone setting is an hourly offset from UTC time. If using the Time Zone setting, set it first, then set
the local time. UTC time will be automatically set based on the time zone and local time settings.

If using NTP: NTP utilizes UTC time, therefore when using NTP, the appropriate hourly offset from UTC time must entered into
the time zone setting.

Daylight Saving Time: If currently observing Daylight Saving Time, set to Yes. If not currently observing Daylight Saving Time,
set to No. The OCS controller does not automatically switch to daylight saving time; however, program logic can be written to
accomplish an automatic switchover using system register %SR211. In program logic, move a “1” (INT) into %SR211 to enable
Daylight Saving Time. Move a “0” (INT) into %SR211 to disable Daylight Saving Time. Trigger the move to %SR211 based on a
compare function to the RTC date according to daylight saving practices in your desired region.

To Set Local Time: The Set Time/Date submenu displays three system settings. Time and Date may be edited, and Day is
automatically calculated from the Date setting.

NOTE: Time and Date are splitinto three fields each, all of which may be edited. Touch the edit enable buttons of Local Time /
Local Date to edit all the three fields.

Time 16:09:49 = Current time (hours:minutes:seconds in 24-hour format)
Date 11-Jun-2024 = Current date (day-month-year)
Day Monday = Current day of week calculated from the Date setting
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5.6: Removable Media

The Removable Media submenu displays the Removable Media Manager. Select Removable Media from the Main Menu to
open available submenu screens.

SD Card USB Drive
Name Date modified
- =
m CAPTURES 02Apr2024 12:22:02 Dir 5.76 MB
[ JAUTOLOAD.PGM 02Apr2024 12:26:17 File 295.34 KB
[ ) DEFAULT.PGM 02Apr2024 12:26:06 File 294.67 KB

oo ey A e iy _—

The Removable Media Sub-Menu displays the Removable Media Manager. After selecting Removable Media from the Main
Menu, one of four Sub-Menu screens will appear:

Directory Empty MicroSD card is installed and initialized, but contains no files.

S0 Card
(1307.28.8MPbmp (2Ap2N24 130658 File wsme  MicroSD card is installed and it contains files.
1307-29.BMPLmD [i71 7 : File 115 MB
esuR Peambamat e Shows size of highlighted file or <DIR> if directory is highlighted.
1307-31.BMPbmp O2Apc2024 130716 File 15 MB
"1307-32.BMP.bmp D2Apc2024 13:0 1.15MB
— — - L1sne Shows the date file or directory was created or last modified.
"1307-34. BMPbmp 2Apr2024 13:07:26 [2) § MB
11307-35 BMPbmp 02472024 130726 File 115M8 Shows the time file or directory was created or last modified.
"11307-36.BMP bmp O2Apr2024 13:07:26 File 1.15 MB

"1307-37.BMP.bmp DIJ.M# 13:07:28 Flle 1.15MB

a;‘tﬂ ﬁém-«:'f e * 1I5MB

HG-1017

If a directory name is highlighted, pressing on the folder will switch to that directory showing its files and sub-directories. In a sub-
directory, highlighting .. (dot dot) and pressing Enter will move up one directory.
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5.7: Fail — Safe System

See also: "Fail-Safe System"

The Fail-Safe System is a set of features that allow an application to continue running in the event of certain types of "soft"
failures. These "soft" failures include:

®  Battery-Backed Register RAM or Application Flash corruption due to, for example, an excessive EMI, Electromagnetic

Interference, event.

Selecting “Fail-Safe System” menu will open the following menu screen:

4 Home SYSTEM MENU > FAIL SAFE
Auto run

Backup/Restore Data

Auto Load SD

Auto Load USB

02-Apr-24 IP1:192.168.254.128 Cv-070D-00
12:37:54 IP2: 000.000.000.000 CAN ID: 253

Selecting Backup/Restore Data displays the following screen in:

Clear Backup

Backup Copies battery-backed RAM contents on to the onboard flash memory of the OCS.
Restore Copies the backed-up data from onboard flash to the battery-backed RAM.

Clear Backup The backup data will be erased from the onboard flash.

Exit Goes back to previous menu
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5.7.1: Enable AutoRun

“Enable AutoRun” displays the following options which can be selected:

A Home SYSTEM MENU > FAIL SAFE

Auto run
Backup/Restore Data
Auto Load SD

Auto Load USB

02-Apr-24 IP1:192.168.254.128 Cv-070D-00
12:37:54 IP2: 000.000.000.000 CAN ID: 253

No = OCS will be in IDLE mode after AutoLoad or Automatic Restore.
Yes = OCS will automatically be placed into RUN mode after AutoLoad or Automatic Restore.

Enable AutoRun
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5.7.2: Enable AutoLoad

“Enable AutoLoad” displays the following options which can be selected:

ﬂ Home

Auto run

SYSTEM MENU > FAIL SAFE

Backup/Restore Data

Auto Load SD

Auto Load USB

02-Apr-24 IP1:192.168.254.128 CVv-070D-00

12:37:54

IP2: 000.000.000.000 CAN ID: 253

Enable AutoLoad SD/
AutoLoad USB

No = Does not load AUTOLOAD.PGM automatically when application program is absent or
corrupted.

Yes = Loads AUTOLOAD.PGM file automatically from RM (SD card/USB) when application
program is absent or corrupted.
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5.8: User Interface

ﬁ Home SYSTEM MENU > USER INTERFACE

Screen Saver Enable
Screen Saver Timeout
Pop Up Notification
SYS_Fn enable

Beeper Enable

FKeys Momentary

02-Apr-24 IP1:192.168.005.128 CV-070D-00 0],
15:33:03 1P2: 000.000.000.000 CAN ID: 253

Yes = Enable Screen Saver

Screen Saver Enable
No (default) = Disable Screen Saver

5-1200 = Amount of time in minutes to expire with no touch activity before activating screen

Screen Saver Timeout (min) saver (black screen)

Off (default) = Disable Pop Up status

Warning = Display Pop Up status onl if controller status changes to NOT Ok or NOT Run
Mode

On = Display Pop Up status on any controller status change

Pop Up Notification

Yes = Reset and All Clear system functions enabled
No = Reset and All Clear system functions disabled

SYS Fn Enable

Yes (default)= Enables beeper

Beeper Enable )
No = Disables beeper (does NOT affect ladder access)

Momentary = %K1-5 bits go ON and OFF as F1-F5 are pressed & released

FKeys . .
Toggle = %K1-5 bits toggle each time F1-F4 are pressed
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5.9: Touch Screen Calibration

The touch screen is calibrated at the factory and rarely needs modification. However, if actual touch locations do not appear to
correspond with responding objects on the display, field adjustment is available. Ensure SYS_fn Enable is set to YES in System
Menu. To access the field adjustable touch screen calibration dialog, press and hold both the SYS and F1 key for longer than 2
seconds and a dialog similar to the figure below will appear.

For best results in screen calibration, use a stylus with a plastic tip. When the crosshair appears, touch the center of the
crosshair as exactly as possible and release. A small “+” should appear and will move closer to the center of the crosshair. Once
it has done so and disappeared again, repeat the process until “+” appears in the center of the crosshair. Then move on to the
next step.

CALIBRATION IN-PROGRESS

Touch crosshair with stylus for calibration, [: J
Repeat for all the crosshair points.
Click on YES or page will load in 10s.

TN
Touch crosshair.

_\\_\

Touch crosshair.

/—I_
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Chapter 6: System Register Tables

6.1: Register DefinitioNs . . . . 53
6.2: oS RIS OIS . . 54
6.3: oS R RegiSters . . 55
6.4: 1/0 Register Map for Canvas 7D ... ... ... ... . 63
6.5: Default PWM Function Registers Map ... ... ... . 63
6.6: Default HSC Functions Registers Map ... ... ... 64
6.7: Canvas 7D Resource Limits ... ... . 65

There are two types of System Registers that may be used during programming. %S registers indicate the status of several
system operations. %SR registers indicate the state of many system operations and can be used to control them in several
cases. Some of the system registers have predefined I/0 names, though they may still be changed if desired.

6.1: Register Definitions

When programming the an OCS, data is stored in memory that is segmented into different types. This memory in the controller is
referred to as registers. Different groups of registers are defined as either bits or words (16 bits). Multiple registers can usually be
used to handle larger storage requirements. For example, 16 single-bit registers can be used to store a word, or two 16-bit
registers can be used to store a 32-bit value.

Types of Registers
16-bit input registers used to gather analog input data such as voltages,
temperatures, and speed settings coming from an attached device.

%Al = Analog Input

16-bit output registers used to send analog information such a voltages,

%AQ = Analog Output
° ¢ 2 levels or speed settings to an attached device.

These are digital flags used to control the displaying of screens on a unit

which has the ability to display a screen. If the bit is SET, the screen is displayed.
Single-bit input registers. Typically, an external switch is connected to the registers.
Single-bit flags used to give the programmer direct access

to any front panel keys appearing on a unit.

%D = Display Bit

%I = Digital Input

%K = Key Bit

%M = Retentive Bit Retentive single-bit registers.

Single-bit output registers. Typically, these bits are connected to an actuator,

%Q = Digital Output
° < 2 indicator light or other physical outputs.

%R = General Purpose Register

Retentive 16-bit registers.

%S = System Bit

Single-bit bit coils predefined for system use.

%SR = System Register

16-bit registers predefined for system use.

%T = Temporary Bit

Non-retentive single-bit registers.
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6.2: %S Registers

%S registers indicate system status as follows:

S# Name Predefined Notes

1/0 Name
%S1 First Scan FST_SCN On for 1 scan only each time the program is first run
%S2 Network OK NET_OK If on, the Network is OK
%S3 10ms pulse T_10MS Cycling pulse that is high for 5ms and low for 5ms
%S4 100ms pulse T_100MS Cycling pulse that is high for 50ms and low for 50ms
%S5 1 second pulse T_1SEC Cycling pulse that is high for 500ms and low for 500ms
%S6 /0 OK 10_OK If on, the I/O system is OK
%S7 Always On ALW_ON This bit is always on
%S8 Always OFF ALW_OFF This bit is always off
%S9 Pause Scan PAUSING_SCN On for at least 1 scan prior to Pause 'n Load
%S10 Resume Scan RESUMED_SCN On for 1 scan only after Pause 'n Load is done
%S11 Forcing Present | FORCE If on, I/O is presently being forced
%S12 Forcing Enabled| FORCE_EN If on, I/O forcing is been enabled
%S13 Net I/0 OK NET_IO_OK If on, Network I/O is OK
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6.3: %SR Registers

%SR registers are special word-length registers that display and/or control system operations in the controller. Not all controllers
support all defined system registers. Click on the name of the register to see more information on that register.

SR # Name and Description Default /0| Min -| Program (Read/Write) Display
Name /10| Max (Read/Write)
Name Values
%SR1 User Screen Number (0=none) USER_SCR Oto Read/Write Read/Write
1023
%SR2 Alarm Screen Number ALRM_SCR | 0to 1-23 Read Only Read Only
%SR3 System Screen Number SYS_SCR 0to 28 Read/Write Read/Write
1= Main System Menu
2= Networks
5= Performance
6= Diagnostics
=1/O Slots
8 = User Interface
9 = Serial Ports (%SR34)
10 = Time & Date (%SR44-%SR50)
13 = Media
16 = Fail Safe
21=Touch Calibration
22= Capacity
23= CAN Network
25= WIFI Settings
26= CAN Settings (%SR29-30)
27=LAN Settings
28= 0OCSIO Configuration
%SR4 Self Test Results SELF_TEST Read Only Read Only
%SR4.1 Self Test Results - BIOS Error Read Only Read Only
%SR4.2 Self Test Results - Engine Error Read Only Read Only
%SR4.3 Self Test Results - Ladder Error Read Only Read Only
%SR4.4 Self Test Results - RAM Error Read Only Read Only
%SR4.5 Self Test Results - Duplicate ID Read Only Read Only
Error
%SR4.6 Self Test Results - Bad ID Error Read Only Read Only
%SR4.7 Self Test Results - I/O Configuration Read Only Read Only
Error
%SR4.8 Self Test Results - Bad Network Read Only Read Only
Error
%SR4.9 Self Test Results - Bad Logic Error Read Only Read Only
%SR4.10 Self Test Results - Bad Clock Error Read Only Read Only
%SR4.11 Self Test Results - DeviceNet Error Read Only Read Only
%SR4.12 - Reserved
16
%SR5 Control Station Mode CS_Mode Oto3 Read Only Read/Write
0=Idle
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1=Do I/O
2=Run
3= Online Change
%SR6 Average Scan Rate ms (/10) Read Only Read Only
%SR7 Minimum Scan Rate ms (/10) Read Only Read Only
%SR8 Maximum Scan Rate ms (/ 10) Read Only Read Only
%SR9 Current Touch Pressure TCH_ Oto Read Only Read Only
PRESSURE | 3000
%SR10 Threshold Touch Pressure TCH_ 0 to Read/Write Read/Write
PRESSURE_ | 3000
TSH
%SR11-12 Ladder Size (32-Bit DINT) Read Only Read Only
%SR13-14 User Text Screen Size (32-Bit Read Only Read Only
DINT)
%SR15-16 System Text Screen Size (32-Bit Read Only Read Only
DINT)
%SR17-18 I/0 Configuration Table Size (32-Bit Read Only Read Only
DINT)
%SR19-20 Network Config Table Size (32-Bit Read Only Read Only
DINT)
%SR21-22 Security Data Table Size (32-Bit Read Only Read Only
DINT)
%SR23 Ladder Code CRC Read Only Read Only
%SR24 User Text CRC Read Only Read Only
%SR25 System Text CRC Read Only Read Only
%SR26 I/O Configuration Table CRC Read Only Read Only
%SR27 Network Configuration Table CRC Read Only Read Only
%SR28 Security Data Table CRC Read Only Read Only
%SR29 Network ID Read Only Read/Write
CsCAN Mode NET_ID 1to0 253
DeviceNet Mode 0to 63
CANopen Mode 1to 127
%SR30 Network Baud Rate Oto4 Read Only Read/Write
0=125kB
1=250kB
2=5000kB
3=1MB
4=50kB
%SR31 Network Required Oto3 Read Only Read Only
0= Network not required
1= Network required
2= Network optimized
3= Network required and optimized
%SR32 LCD Display Contrast setting 0to 255 Read Only Read/Write
%SR33 Function Key Toggle Mode Oto1 Read/Write Read/Write
0= Momentary
1=Toggle
%SR34 RS-232 Serial Protocol Mode Read Only Read Only
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0= Firmware Update (RISM)

1= CsCAN

2= Generic (Ladder- Controlled)
3= Modbus RTU

4= Modbus ASCII

%SR35-36 Unique Serial Number / Read Only Read Only

Hexadecimal

ILAN1 MAC ID
%SR37 Model Number Read Only Read Only
%SR38 Engine Version (/100) Read Only Read Only
%SR39 BIOS Rev Number (/ 100) Read Only Read Only
%SR40 FPGA Image Rev Number (/ 10) Read Only Read Only
%SR41 Vertical Pixel Count Read Only Read Only
%SR42 Horizontal Pixel Count Read Only Read Only
%SR43 Keypad Type Read Only Read Only
%SR44 Real-Time-Clock Second RTC_SEC O0to 59 Read Only Read Only
%SR45 Real-Time-Clock Minute RTC_MIN 0to 59 Read Only Read Only
%SR46 Real-Time-Clock Hour RTC_HOUR 0to 23 Read Only Read Only
%SR47 Real-Time-Clock Date RTC_DATE 1to 31 Read Only Read Only
%SR48 Real-Time-Clock Month RTC_MONTH | 1t012 Read Only Read Only
%SR49 Real-Time-Clock Year RTC_YEAR 1996 to Read Only Read Only

2095

%SR50 Real-Time-Clock Day (1=Sunday) | RTC_DAY 1to7 Read Only Read Only
%SR51 Network Error Count Read Only Read Only
%SR52 Watchdog-Tripped Error Count Read Only Read Only
%SR53-54 Reserved
%SR55.13 Self-Test: Battery Low or Missing Read Only Read Only
%SR56 Key Currently Pressed Read Only Read Only

No key =0 (No key pressed since

power-up)

F1=1

F2=2

F3=3

F4=4

F5=5

F6=6

F7=7

F8=8

F9=9

F10=10

F11=11

F12=12

System = 26

Release = 255 (Keys pressed since

power-

up but not currently)
%SR57 LCD Backlight Dimmer Register 0to 255 Read Only Read Only

0-100 = 0% to 100% On
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100-255=100% On

%SR57.16 Temporarily disable Screen Saver Read/Write Read/Write
%SR58 User LEDs USER_LEDS Read/Write Read/Write
%SR59 Engine Build Number Read Only Read Only
(Only last three numbers displayed)
%SR60 Build Option Oto2 Read Only Read Only
Build Test=0
Build Beta =1
Build Product = 2
%SR61 Number of CsCAN Network IDs NUM_IDS Read Only Read Only
%SR62-103 | Reserved
%SR104-105| For security enabled PGM/Clone Read/Write Read/Write
files enter password of current
program running in the controller
%SR106-107 | For security enabled PGM/Clone Read/Write Read/Write
files enter password of program file
that to be loaded in the controller.
%SR108-130 | Reserved
%SR131-135| OCS Model: ASCII, 10 characters Read Only Read Only
%SR136 Communication Download Timeout Read Only Read Only
%SR137 Communication Idle Timeout Read Only Read Only
%SR138-148 | Reserved
%SR149-150 | Free-running 10kHz count: 1 count Read Only Read Only
=0.1ms
(32-Bit DINT)
%SR151 Reserved
%SR152 RS-485 Termination Read/Write Read/Write
%SR152.1 MJ2 Termination Enable Read/Write Read/Write
%SR152.6 Setting True saves the currently Read/Write Read/Write
loaded program as PGM file in the
Micro SD card as “DEFAULT.PGM”
%SR152.7 Setting True loads, the Read/Write Read/Write
“‘DEFAULT.PGM’ file located in
Micro SD card.
%SR153.1 EGD protocol for LAN2 Read/Write Read/Write
%SR153.2 Modbus TCP slave protocol for Read/Write Read/Write
LAN2
%SR153.4 FTP for LAN2 Read/Write Read/Write
%SR153.12 -| CAN protocol running Read/Write Read/Write
%SR153.16
%SR154.9 set by user to upgrade firmware via Read/Write Read/Write
uSD card.
%SR154.10 | set by user to upgrade firmware via Read/Write Read/Write
USB.
%SR154.11 | will be set by the firmware to ask for Read/Write Read/Write

confirmation to upgrade firmware,
resetting %SR154.9 / %SR154.10.
When user resets SR154.11, the
upgrade process will start.
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%SR154.12 | setting this bit high (ON) will not Read/Write Read/Write
retain programs / variables after
firmware update. Setting this bit low
(OFF) will retain programs /
variables after firmware update.

%SR154.14 | If firmware upgrade is not required, Read/Write Read/Write
then %SR154.14 will be set.
For example —in case firmware on
device and on uSD / USB is same.

%SR154.15 | this bit will be set by firmware if Read/Write Read/Write
there is any error in updating
firmware like missing firmware file.

%SR155 Reserved

%SR156 Protocols Read/Write Read/Write

%SR156.1 EGD protocol for LAN1 Read/Write Read/Write

%SR156.2 Modbus TCP slave protocol for Read/Write Read/Write
LAN1

%SR156.4 FTP for LAN1 Read/Write Read/Write

%SR156.5 WebMI for both LAN1 and LAN2 Read/Write Read/Write

%SR157-163 | Reserved

%SR164 FailSafe / Clone

%SR164.1 RS485 Port Biasing #1 (MJ1 or Read/Write Read/Write
MJ2)

%SR164.2 RS485 Port Biasing #2 (MJ2 or Read/Write Read/Write
MJ3)

%SR164.3 Indicates Automatic Restore AUTO_ Read Only Read Only
Operation RESTRD
has been performed

%SR164.4 Indicates Backup of Registers has | BCKUP_TAKN Read Only Read Only
been taken

%SR164.5 Enable AUTORUN - Sets “Enable | EN_AUTO_LD Read/Write Read/Write
AutoRun” to “Yes” or “No”

%SR164.6 Enable AUTOLOAD — Sets “Enable | EN_AUTO_LD Read/Write Read/Write
AutoLoad” to “Yes” or “Not”

%SR164.7 Start Backup trigger bit — STRT_BCKUP Read/Write Read/Write
Setting TRUE starts backup of all
register data

%SR164.8 Clear Backup trigger bit — Setting CLR_BACKUP Read/Write Read/Write
TRUE
clears backup of all register data
(if a backup was done previously)

%SR164.9 MAKE_CLONE trigger bit = MAKE_ Read/Write Read/Write
Setting TRUE does a Load Clone CLONE
(if a media card is present)

%SR164.10 | LOAD_CLONE trigger bit — LOAD_CLONE Read/Write Read/Write
Setting TRUE does a LOAD CLONE
(if a media card is present that
contains clone files)

%SR164.11 | Make Clone Fail MK_CLN_FL Read/Write Read/Write
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(This bit goes high when
Make/Create Clone fails)
%SR164.12 | Load Clone Fail LD_CLN_FL Read/Write Read/Write
(This bit goes high when Load
Clone fails)
%SR164.14 | Reserved Read/Write Read/Write
%SR164.15 | Reserved Read/Write Read/Write
%SR165-166 | Reserved
%SR167 Screen Update Time, Default=5 2t0 50 Read/Write Read/Write
%SR168-170 | Reserved
%SR171 X-Coordinate Touched Read Only Read Only
%SR172 Y-Coordinate Touched Read Only Read Only
%SR173 System-Function Disable Oto1 Read/Write Read/Write
%SR174 Removable Media Protect Read/Write Read/Write
%SR174.1 Request Media Card be Removed Read/Write Read/Write
%SR174.2 Indicates safe to remove Media Read/Write Read/Write
Card
%SR175 Removable Media - Status Read Only Read Only
%SR176-177 | Removable Media Free Space (32- Read Only Read Only
Bit DINT)
%SR178-179 [ Removable Media Total Space (32- Read Only Read Only
Bit DINT)
%SR180 Reserved
%SR181 Bits 1-16 indicate Unacknowledged | ALM_UNACK Read Only Read Only
in Alarm Groups 1-16
%SR182 Bits 1-16 indicate Active in Alarm ALM_ACT Read Only Read Only
Groups 1-16
%SR183 Beep on Keypress Enable SYS_BEEP Oto1 Read/Write Read/Write
0= Disabled
1= Enabled
%SR184 Internal Beeper USER_BEEP Oto1 Read/Write Read/Write
0=0OFF
1=ON
%SR185 Screen Saver Enabled Oto1 | ReadOnly Read Only
0= Disabled
1= Enabled
NOTE: See %SR57.16
%SR186 Screen Saver Time in minutes 5to Read Only Read Only
(delay) 1200
%SR187 Network Usage (Avg) NET_USE Oto Read Only Read Only
1000
%SR188 Network Usage (Min) Oto Read Only Read Only
1000
%SR189 Maximum Net Usage of all units on O0to Read Only Read Only
the CAN network 1000
%SR190 Network TX Usage % (/ 10) (Avg) NT_TX_AVG Oto Read Only Read Only
1000
%SR191 Network TX Usage % (/10) (Min) Oto Read Only Read Only
1000
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%SR192 Network TX Usage % (/ 10) (Max) Oto Read Only Read Only
1000
EXTENDED SYSTEM REGISTERS
%SR193 Online Change ONLINE_CHG
%SR193.1 TRUE if 2 programs in target Read Only Read Only
FLASH
%SR193.2 TRUE to switch programs, FALSE Read Only Read Only
when complete
%SR193.3 TRUE if executing program is Read Only Read Only
temporary test
%SR193.4 TRUE during last scan of switched- Read Only Read Only
from program
%SR193.5 TRUE during first scan of switched- Read Only Read Only
to program
%SR193.6 TRUE to revert to FLASH and Read Only Read Only
delete all RAM;
FALSE when complete
%SR193.9 TRUE if error in temporary program Read Only Read Only
%SR194-199 | Reserved
%SR200 InitRD Version (/100) Read Only Read Only
%SR201 - Linux Kernel version: ASCII, 10 Read Only Read Only
205 characters
%SR206-208 | Reserved
%SR209.3 WebMI Server Status. Bit 3 is ON if Read Only Read Only
server running.
%SR209.4 WebMI User Logged in Status. Read Only Read Only
Bit 4 is ON if 1 or more users logged
in.
%SR209.8 - | Number of Users. Read Only Read Only
209.14 Shows in upper byte in decimal
format.
%SR210 Time Zone: setin minutes +/-UTC Read/Write Read/Write
(Ex: EST is -4 hours =-240 minutes)
%SR211 Daylight Saving: YES =1 Read/Write Read/Write
Daylight Saving: NO =0
(If daylight saving is enabled,
one hour will be added to the local
time).
%SR212 UTC - Seconds Read Only Read Only
%SR213 UTC - Minutes Read Only Read Only
%SR214 UTC - Hours Read Only Read Only
%SR215 UTC - Date Read Only Read Only
%SR216 UTC - Month Read Only Read Only
%SR217 UTC - Year Read Only Read Only
%SR218 Not applicable for Canvas series
%SR219 Not applicable for Canvas series

%SR220-222

Not applicable for Canvas series

%SR223-265

Reserved
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%SR266-351

WiFi SR Registers

Read Only

Read Only

%SR266

WIFI Connection Mode

%SR267-275

WIFIMAC ID

%SR276-291

WIFI AP Mode Name

%SR292-307

WIFI AP Mode Password

%SR308 WIFI AP Mode Encryption
%SR309-310| WIFI AP Mode IP
%SR311 WIFI AP Mode Channel

%SR312-327

WIFI Client Mode Name

%SR328-343

WIFI Client Mode Password

%SR345

WIFI Autoconnect Enable

%SR346

WIFI Status

%SR347-348

WIFI Client IP

%SR349

WIFI Client Signal Health

%SR352-448

Reserved
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6.4: 1/0 Register Map for Canvas 7D

NOTE: These registers can be used as general purpose registers

Registers Description
no /0 102 1/0 103 1/0 104 1/0 105 1/0 106 1/O
%11-%I112 Unused Digital Inputs
%I113-%116 Unused Reserved Digital Inputs Reserved
%I17-%124 Unused Reserved Digital Inputs Reserved
%I125-%129 Unused Reserved
%I130 - %1131 Unused PWM Table, see "High Speed I/O (HSC / PWM) " on page 1
%132 Unused | ESCP Alarm* (Electronic Short Circuit Protection)
%Q1 Unused PWM Table , see "High Speed I/0 (HSC / PWM) " on page 1
%Q2-%Q6 Unused Digital Outputs
%Q7-%Q12 Unused Reserved | Digital Outputs
%Q13-%Q16 Unused Reserved Digital Outputs | Reserved
%Q17 - %Q20 Unused HSC Table, see "High Speed I/0 (HSC / PWM) " on page 1
%Q21-%Q24 Unused Reserved
%Al - %AI2 for Analog Input Channels Mirror of first four
Lalalias Unused | Analog Inputs "ZjAIS - ";:AI4 - Unusedg " analog channels
%AI33 - %AI38 Unused f(’:r”;:zgc':g:;ils
%AQ1-%AQ8 Unused PWM Table, see "High Speed I/0 (HSC / PWM) " on page 1
%AQ9-%AQ10 Unused | Analog Outputs

*The ESCP bit is set high when the output current is too high, and the output driver has shut down for thermal protection. This

typically happens when outputs are shorted, or they are driving loads that are higher than the output rating.

6.5: Default PWM Function Registers Map

NOTE: Addressing is editable
See HSC/PWM Section Chapter 9

Register

PWM Stepper

%AQ421-422

PWM 1 Duty Cycle (32-bit)

Start Frequency - Stepper 1

%AQ423-424

PWM 1 Frequency

Run Frequency - Stepper 1

%AQ425-426

Acceleration Count - Stepper 1

%AQ427-428

Run Count - Stepper 1

%AQ429-430

Deceleration Count - Stepper 1

%AQ431-432

PWM 2 Duty Cycle (32-bit)

Start Frequency - Stepper 2

%AQ433-434

PWM 2 Frequency

Run Frequency - Stepper 2

%AQ435-436

Acceleration Count - Stepper 2

%AQ437-438

Run Count - Stepper 2

%AQ439-440

Deceleration Count - Stepper 2

%Q1

Start Move Bit - Stepper 1
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%Q2 Start Move Bit - Stepper 2
%11617 Ready/Done - Stepper 1
%11618 Error - Stepper 1
%11619 Ready/Done - Stepper 2
%11620 Error - Stepper 2

6.6: Default HSC Functions Registers Map

NOTE: Addressing is editable
See HSC/PWM Section Chapter 9

Register Frequency | Totalize Pulse Quad
%AI401-402 HSC1 (function) Accumulator Quad 1 Acc
%Al405-406 HSC2 (function) Accumulator
%AI409-410 HSC3 (function) Accumulator Quad 2 Acc
%AI413-414 HSC4 (function) Accumulator

%AQ401-402 HSC1 Preset
%AQ407-408 HSC2 Preset

%Q1603 Clear HSC1 Clear Quad 1

%Q1619 Clear HSC2 Clear Quad 2

%Q1635 Clear HSC3

%Q1651 Clear HSC4
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6.7: Canvas 7D Resource Limits

Resource Value
%S 13
%SR 448
%T 16384
%M 16384
%R 50000
%K 5
%D 1023
%l 2048
%Q 2048
%Al 512
%AQ 512
Ethernet CsCAN, Ping, EGD, SRTP, Modbus TCP Master (downloadable protocol) & Slave,
Ethernet IP, FTP
CsCAN 125kBd, 250kBd, 500kBd, or 1TMBd
i 1 with RS-232and RS-485 on first Modular Jack (M1/2)
Serial Ports

1 RS-232 or 1 RS-485 on second Modular Jack (MJ3)

IDs Per CsCAN Network

64 w/o repeat (253 w/ 3 repeaters)

Keypad 6 keys (5 Function keys and a System Key)
Display 800x4807” TFT, 65K colors
Screen Memory 64MB
User Screens 1023
Data Fields Per User Screen 1023
Ladder Code 2048kB

Page 65 of 209




II HORNER

AUTOMATION GROUP

Cscape
Configuration

666666



II HORNER

AUTOMATION GROUP

Chapter 7: Cscape Configuration

Chapter 7: Cscape Configuration

T Cscape Status Bar ... .. 67
7.2: Establishing Communications ... ... . 68
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Canvas 7D OCS hardware is programmed with a Windows based PC application called Cscape. This application can be used to
program, configure, monitor, and debug all aspects of the Canvas 7D OCS unit. Please see the Online Help provided with
Cscape for additional details.

7.1: Cscape Status Bar

When the Canvas 7D OCS is connected to a PC using Cscape software, a Status Bar appears at the bottom of the screen. The
Cscape Status Bar can be used to determine if communications have been established between the Canvas 7D OCS and the
Cscape program. Components of the Cscape Status Bar are explained below:

Message Line - Equal Indicator - indicates whether the current program in Cscape is equal to the program

The contents of stored in the Target Controller.

these messages e |If Fqual the program in Cscape is the same as the program stored in the Target Controller.
are context e |f Not Equal, the program in Cscape is not the same as the program stored in the Target
sensitive. The Controller.

Message line can e If Unknown, there may have been a change since the last time the program in Cscape was
be empty. compared to the Target Controller.

Current User -
indicates who is logged
(for security purposes).

File Modified Indicator - indicates that
the file in the selected window has
been modified but has not been saved.

Ready User: HE-XExx1-CsCAN Equal Local 1 Target :2(R) [no  MOD
(Model=) forces]
Controller Model - Network (Model Confirmation) Communications Status - indicates the current status of the

“pass through” Connector.
. Controller Mode/indicates the controller model for

which the program in Cscape is configured. e  Local: xx - indicates the Network ID of the OCS to which
Lo the Cscape program is physically connected through its
*  Network [ndlcates the type of network that the serial port. It can serve as a pass through device to other
program in Cscape expects to use (e.g., CsCAN). nodes on the network.
*  (Model Confirmation) provides the following e  Target: yy(R) - indicates the Network ID of the device with
indications: which the Cscape program is exchanging data.
Note: The Local unit and Target unit can be the same
e (Model=) - the actual Target Controller matches the unit or they can be separate units.

configured Controller Model and Network.

The following are status indicators:
e  (Model Not=) - the actual Target Controller does not

match the configured Controller Model and Network. (R) - Running
(D)-Do I/0
e  (Model ?) - there may have been a change since the ) - Idle
last time the Target Controller was compared to the (?) - Cscape is not communicating with the remote unit.
configured Controller Model and Network. [no forces] - indicates no I/O has been forced.
HG-120
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7.2: Establishing Communications

The Canvas 7D OCS can communicate with Cscape using USB to USB, USB to serial adapters, serial port communications via
MJ1 Port, Ethernet (with an Ethernet adapter board), onboard Ethernet Port, CAN (CsCAN), or modems.

If a direct USB connection is to be used, connect the Mini-USB port on the OCS (only on select models) to an open USB port on
the PC. (A cable for doing this is included in HE-CPK, the programming kits.) The OCS will install as a device once plugged in.
Drivers for it are normally found automatically by the Windows operating system as long as an Internet connection is established.

See also the Tools of the Trade on the Horner website.

The PC will detect a new device has been plugged into the USB port.

Now that the Canvas 7D is plugged in, go to Cscape > Controller > Connection Wizard. If you are just opening Cscape,
Connection Wizard usually opens by default.

Connection Wizard X

How i your PC connected to the local controller?

I@

" Serial

" Modem * USB

[~ Show connection wizard on startup. | Next >> | Cancel

Select USB and click Next >>.
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r A
Configure
USB list [ Controller USB COM Port (COMS) | I Don't Know
[ Show connection wizard on startup. << Back w Finish Cancel |

HG-115

If the Connection Wizard does not pop up upon opening Cscape, then select Controller (in the Cscape tool bar) > Connection
Wizard, choose your connection method. If you are connecting for the first time, we suggest connecting via USB.

é\ BaXFeEs s %#0e POEESEV a6 ¢ Cscape - Logged I
- Home Edit Logic Editing User Interface Debug Toaols My Account Help
Froject Navigator| ) Frogram Variables | [@] Set Target 1D & Hardware Config | [T) Download @] [ start
’ﬁmaj:‘roalhm(l‘_o Defines Window EHSetlocal [+] [m] mUpload s LJ:v.-‘I-;-s-J Online Change
QOMmeindow &Connenion Wizard (}? Disconnect a\-feriry g 4N Revert
View Controller | Online Change
_;:? Project Toolbax Connection Wizard X [
e Contacts and Coils 1
= — n How iz your PC connected to the local contraller?
2 | @ Bitwise Operations
‘E;. [ Compare Operations
1 @ Conversion Operations
@ Math - Standard
& Math — Advanced © Serial AN " Modem * UsB
# Mowve Operations :
5| Networking = CCAN [~ Show cornection wizard on startup. ’—I ’}'P“TI Caneel
& Networking — CANopen 1 1 ’f
PID Operations Connection Wizard o
® Programs Operations
Recipe Operations | Configure
@ ja Media . USE st Controler USB COM Part (COMS) =] 1 Don't Know
@ Serial Operations
@ String Operations
@ Time And Date Operations
@ Timer/Counter Operations
| I Show connection wizard on startup. << Back [ Finish 1 Cancel
I

If Controller USB COM Port is not present in the dropdown list, the Windows operating system has not yet recognized the OCS
as an installed device. Be sure the installation process is complete and that the correct drivers are installed. The Connection
Wizard must be completely closed and reopened to refresh the USB dropdown list.

An alternate way to select the COM setting is to go to Cscape > Tools > Application Settings > Communication >
Configure and choose connection method in Add Target.
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Project Navigator o x =

= B Project Navi E—g
SRl untitled1 | . Andsl

Set Targat work ID...

& = Control Save P
e #‘ Mai Save Program As...

B ¢ Close Program

. 4% UDF
i SetPoin
P L Data Lo/
@L; User Interfal
-4 Networking

Check Controller Status
I Logic User Settings I
e | T
e —
| Adv Program
i
| Appearance | - Commenication Settings -
| Communication Settings =
| Logic Editor | | [Name:Dedault]
| ?wﬂum”% LR Taiget Name:
: Ladder Numbering e ey
H r - = |
| Logic Display Com Port: I] =i
|  LAN 192 . 168 . 5 . 201 Pot IlBSGi Modec | Buitin/ETN Ethernet Mode +
i Download
b |1EDD ¥ Auto Detect MTU See
H
Application
; " Installed Modem =l
Communicati Configure >» | Help me Connect Phane Humbes I
Com Ihf i
piler Options & UsB [Controller USB COM Port (COMS] =
~ Conrected Devica
@ ComectedDevice TagetNodeD [T =]
+ Connection Settings
Manirvum Baud Rate IE?GUU 'I
Timeout: 1000 mg
i L
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Communication Configuration Dialog

Name for connection. This is not a mandatory column to be filled, by default Cscape will populate

Target Name ‘Default1’ in edit box.

Connection Medium

Select this option to communicate over serial communication with the device. The port number can be

(ST HE configured here.

Select this option to communicate over Ethernet. Provide the IP address of the device and select the
mode: HE GSM GPRS mode, Built in/ ETN Ethernet mode, or HE XEC Ethernet mode.

Select HE GSM GPRS mode if communication with XL series controller on GPRS is required and the
device has GSM modem installed in XL series controller.

Select Built in/ ETN Ethernet mode if the device has on-board Ethernet port.

Ethernet Select HE XEC Ethernet mode if the device has Ethernet comm. option board installed in Canvas
series controller.

NOTE: For GPRS connectivity, GPRS configuration from Programs Messaging GPRS needs to be
done.

NOTE: The controller should support the type of connectivity selected and configured for Ethernet
communication.

Select this option to communicate to the device through the internal modem of the computer. Cscape
will automatically detect the internal modem attached with PC and list in the attached drop down. User
can select modem and telephone number for target controller.

NOTE: Cscape will do necessary initialization for the selected internal modem.

Installed Modem

Select this option to communicate over USB. Now Horner devices and Horner USB to serial

L) converters are recognized and can be specifically selected.

Connected Device

NOTE: This configuration is required if the controller to which Cscape is communicating is connected to a CsCAN network.

Connected Device By default, this option is selected and networking feature of Cscape is disabled.

On selecting this option, Networking feature of Cscape is enabled. CsCAN ID for the target controller

[roettic el to be provide here.

Connection Settings (General Communication Settings)

Maximum Baud

Select the baud rate for serial communication.
Rate

Select the communication timeout.

Timeout
NOTE: Select a larger timeout for GPRS and installed modem communication configuration
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If communications are successful, the message line should show “USB (COM8)” for this example, and an (R) should follow the
Target number.

Register Advanced Ladder USB [COM14) User: NONE Canvas 7D - CsCAN Model Equa| Equal Local:253 Target:253(R) [no forces] | MOD

When connected directly to the controller to which
Cscape communications are required, the Local ID
and the Target ID should match.

Local ID and Target ID match.

HG-1029

If the controller is not communicating, you may need to set the target ID of the controller in Cscape or on the unit. The Target ID
allows directing communications to a particular unit when multiple units are connected via a CsCAN network. Units without
CsCAN network ports respond to any network ID and do not require the ID to be configured.

To check or change the ID on the Canvas 7D OCS, press the System Menu key. .

The first item in the menu is Set Networks. Pressing Enter allows you to view or modify the ID of the unit.

4 Home SYSTEM MENU > NETWORK > CAN SETTINGS

CANT1 ID
CAN1 Baud
CAN?1 Protocol
CAN2 ID
CAN2 Baud
CAN2 Protocol

02-Apr-24 IP1:192.168.254.128 Cv-070D-00
11:45:07 IP2: 000.000.000.000 CANID: 253

To change the Target ID of Cscape, highlight CAN ID and press Enter to provide a new number.

0000000000
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7.2.1: Communicating via MJ1 Serial Port

If a serial programming connection is to be used and the PC has a 9-pin serial COM port, which is increasingly rare, there is
nothing to install assuming the port already works. All that is needed is a programming cable to go from the COM port to the OCS
programming port.

If a serial programming connection is to be used and the PC does not have a COM port, a USB-to-Serial adapter may be used.
Drivers for it are normally found automatically by the Windows operating system as long as an internet connection is established.
Otherwise, the drivers may be loaded from the Horner FTP site at https://hornerautomation.com/support-files.

Connect the PC’s serial port or the USB-to-Serial adaptor to the port labeled MJ1 on the Canvas 7D.
The instructions are similar to using a USB port, as shown above. In the Connection Wizard, select the “Serial” option.

If communications are successful, the target indicator should show the mode of the controller Target: yy(R) as shown in the "7.1:
Cscape Status Bar" on page 67.

If the controller is not communicating, you may need to set the Target ID of the controller in Cscape or on the unit. The Target ID
allows directing communications to a particular unit when multiple units are connected via a CsCAN network. Units without
CsCAN network ports respond to any network ID and do not require the ID to be configured.

To check or change the ID on the Canvas 7D OCS, press the System Menu Key.

The first item in the menu is Set Networks. Pressing Enter allows you to view or modify the ID of the unit.
Pressing Enter allows you to view or modify the ID of the unit.

To change the Target ID of Cscape use the Controller > Set Target Network ID dialog.
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7.2.2: Communicating via On Board Ethernet Port

From Cscape go to Controller > Hardware Configuration and do auto configuration for the connected controller, Click on
Config of Ethernet and select Module Setup.

Hardware Configuration

Controllr | Local 140 | CANT (CsCAN) L/O | CAN2 (CsCAN) 1/0 | LAN11/0 | LAN2 10 |

Series |Canvas OCS Series | Description:
c‘:;-‘s Touch screen Operator Control Station with
Device Type |Can\ras D ﬂ L fixed /0
Model #  [HE-CV-0700-02 v [ Propeties
2 480 by 800 LCD
— Network Ports ! Display Type | by
CANT m Corfig Keypad Type: |5fu|‘|dlol'l keys
Program M (2048 K
CAN2 [CCAN 7] Config m Memory: | Bytes
Network Type:  |CSCAN
LAN1 [ETN300 Config
4 Advanced Ladder Functions
LAN2 |5—N3:3 ~| Config Supports Analog Data
Real Time Clock Support
Supports Retentive Data
Serial Ports Config |
0OCS Wi-F Module Config

The IP address, Net Mask, and Gateway of the controller may be temporarily set from the System Menu under the Set Networks
menu item. Once running or power cycled the configuration will come from the Cscape configuration stored in the unit.
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In Module configuration dialog, go to IP Address field enter unused IP Address and configure unused registers in Register field &

then click OK. Screen shot for the same as follows:

Configuration Detail

™ Use DHCP
Stabic Configuration

Diymaric: configuistion Get setlings fiom

IPAddress: [ 152 168 254 . 128 | Naene: | v | B [Sigic Configuration  w| [T Use CAN ID for last Octet

NetMask: | 265 256 266 0 | Name: | v | B[St Corfiguration  ~|
Gateway: [0 .0 .0 .0 | Name: | x| B8 [Siatic Conliguration ]
DINS Server | 0. 0.0.0 | le j L |5‘|2‘.ic Canfiguration ;I

Statusz: | Name:| LJ 1wmnn |

“Wersion: | Mame: | j 4B |

Frotocol Support
Residert Protocols
CJ1CMP (Ping) Configue Selected Frotocol |
[]EGD (Ethernet Global Data)
[[] SRTP Slave (90-30 Service Request)
[ Modbus TCP/UDP Server
[] Ethernet IP I/O Adapter (UDP)
[C]FP (File Server)
[ ASCI TCP/IP Server
[C1NTP Protocol(Obtain clock from web based server)
Diownloadable Protocots
ETN1A1 [ Hone - =] | | | |
ETN1/2 [~one - =] | | | |
Ok | Cancel

Download the configuration in to Controller. Connect LAN cable to the Controller in default LAN Port.

From Cscape go to Tools > Editor Options > Communication Port > Configure. Select Ethernet and enter IP address which
is configured in the file. Select mode as Canvas Series mode from drop down list.

The controller should connect to Cscape. If communications are successful, the target indicator should show the mode of the
controller Target: yy(R) as shown in the as shown in the "7.1: Cscape Status Bar" on page 67 section.
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7.3: Cscape Configuration

An overview of configuration:

1.  Start the configuration by selecting the Controller > Hardware Configuration menu item.

2. Ifthe Canvas 7D OCS is connected to the PC press the Auto Config System button to automatically detect the Base
model, I/O and any communication options.

3. Ifthe Canvas 7D OCS is not connected press the Config button to the right of the top of the unit. This allows the base
CPU to be selected.

4. Select either Canvas 7D OCS CsCAN from the type drop down box.

5. Once the type of Canvas 7D OCS is selected, the model # drop down box will provide the Canvas 7D OCS model
numbers from which to choose from.

6. Oncethe Canvas 7D OCS is selected, press OK to exit the dialog and configure the I/O that is present in the first slot.

7. The Hardware Configure dialog (specifically the Module Setup tab) provides four buttons to configure all of the I/0.
Go through each area of I/O and configure it.

8.  Once done configuring the /0 ,0K out of configuration dialogs.

Configuring the Canvas 7D OCS /O has four main portions that are covered in this chapter. For additional information on I/O,
refer to "General I/O Configuration" on page 1 or "High Speed I/0O (HSC / PWM) ".
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8.1: Built-in Digital and Analog /0 Overview ... . . . 78
8.2: Removing the Back CoVer ... ... ... . 79
8.3: Digital / HSC Input Configuration ... ... . 80
8.4: Digital / PWM Output Configuration ... ... .. 84
8.5: Analog Input Configuration ... . . . 89
8.6: Analog OUIPULS . ... 96

8.1: Built-in Digital and Analog I/O Overview

The Horner OCS is a compact unit that contains high density and very versatile 1/0. Using the I/O properly requires wiring to the
proper terminals, configuring jumpers inside the Horner OCS unit, and configuring Cscape properly. This section will offer some
tips and suggestions to configure the I/O properly. For the register mapping of the I/O, refer to the "System Register Tables" for

more details.

Built-in Digital & Analog /O
Digital Analog
mA/V
DCIn DC(Sut Relay Out HSC In* Pulse Out** mA/V In RTD/TC n(l)l-:lt\l
(Universal)
Model 2 12 - 6 4 -- 4 - -
Model 3 12 12 4 2 2 - -
Model 4 24 16 - 4 2 2 - -
Model 5 12 12 - 4 2 2 2
Model 6 12 12 - 4 2 -- 6 4

*Shared with total DC inputs
**Shared with total DC outputs

For more details, see the controller datasheets via Document Search.
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8.2: Removing the Back Cover

WARNING: Power, including I/O power must be removed from the unit prior to removing the back cover. Failure to do
so could result in electrocution and/or damage to equipment.

Some /O configurations require jumper settings to be changed inside the Horner OCS unit. Examples of these settings are
setting positive or negative logic on digital inputs or setting current or voltage on analog inputs.

Each Horner OCS I/0 jumper is set to a factory default. Refer to the datasheet for a specific Horner OCS model to find the default
setting to determine if a jumper change is necessary. Refer to Horner's Documentation Search page.

To remove the back cover of the Horner OCS, remove the four (4) Phillips screws from the back of the unit. It may help to place
the Horner OCS unit face down on a clean work surface. Once the four screws are removed the back cover can be lifted straight
off.

Once the back is removed the jumper selection can be changed. The jumper settings are documented on each data sheet using
a diagram such as the figure below and a description of the jumper settings.

Ja

/\ J3

To re-install the back cover, place the cover back on the unit. The DIN clip should be on the same side as the power connector.

Place the screw back into the hole and turn the screw slowly counter clockwise until it clicks into the threads. This prevents the
screw from being cross-threaded. Now turn the screw clock-wise until the cover is firmly secured. Repeat this process for all four
(4) screws. Recommended torque is 3 - 4 in¢Ibs (0.34 — 0.45 Nem).
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8.3: Digital / HSC Input Configuration

Horner controllers vary greatly on series and model numbers. Refer to the datasheets on the Document Search table on the
Horner website.

The inputs are designed to support both positive and negative input modes. For many models, the mode is set by a jumper
setting and a configuration parameter in Cscape. The Model 6 does not require jumpers, and only requires a configuration
parameter in Cscape. All the inputs on the unit must be configured to the same mode.

Positive Logic vs. Negative Logic Wiring

The OCS can be wired for positive logic inputs or negative.

e e

12-24VDC

Positive Logic In Negative Logic In

In positive logic mode a positive voltage applied to the input will turn the input. The internal design of this mode is basically a
resistor from the input to 1/0 ground. This mode is sometimes called sourcing.

In negative logic mode, connecting the input to the I/O ground or zero volts will turn the input on. The internal design of this mode
is basically a resistor from the input to the positive 1/0 voltage (usually 12 or 24V). This mode is sometimes called sinking.

Some of the digital inputs may support high-speed input functional such as counting or frequency measurement.
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8.3.1: Digital Input Configuration

Home > Hardware Configuration [select Device Type/Model#] > Local I/O Tab > 1/0 / Config Button > Module Setup >
Digital In/HSC

Select Hardware Configuration from the Home menu and ensure that the correct Device Type and Model# are selected. Then
select the Local 1/0 tab.

Hardware Configuration x
Controller | Local /0 | CAN1 (CsCAN) /O | CAN2 (CSCAN) 10 | LANT 1/0 | LAN21/0 |
Series ICanvas OCS Series E‘ Description:
GA;;AS Touch screen Operator Control Station with
Device Type |Can\ra5 7D ﬂ fixed 1O
Model#  [HECV-070D02 =] e
i 480 by 800 LCD
— Network Ports | Display Type: ety
CANT [m Config Keypad Type:  |5function keys
Memory: [2048 K
CAN2 ICsCAN ~| Config Progam Memoy: | Bytes
Network Type:  [CSCAN
LANT |E Col
ﬁ Advanced Ladder Functions
LAN2 |E‘.‘13:: ~| Config Supports Analog Data
Real Time Clock Support
Supports Retentive Data
Serial Ports Corfig [
0CS Wi-Fi Module Config
Auto Config
oKk | cancel | | hHep
After selecting Local I/O, select the Config button next to the I/O connector.
Hardware Configuration X

Controller Local /0 \CANW (CSCAN) uol LANT 110 |

XL 1O type 2

Emply l EMPTY [I Config

ok | cewa | Help

The Module Configuration screen will appear, select the Module Setup tab. See below.

Page 81 of 209



II HORNER

AUTOMATION GROUP

Module Configuration

| 1o Ma% | Module Setup |

Chapter 8: General I/O Configuration

Description: Please Refer User Manual for register values

Module
(Mudal XLI/Otype 6

HG-211

OK ] Cancel

Appl |

The Module Setup allows a user to configure four types of I/O. NOTE: Not all controllers offer all four types. Refer to the
controller's datasheet on the using Horner's Documentation Search page.

Module Configuraficn

140 Map  Module Setup

Digital bn / HSC

Degital Qut # PYWM

=

ok | cace |

o
il |
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Select Digital In/HSC to open the Digital / HSC Input configuration dialog for a specific controller.

Digital / HEC Input Configuration b
Digital Inputs acthe mode Coarder Modes
# 2 Counder moge  Mole: 2 Channel Supports:
¥ Positier Logic Hole: This sel 51 N 2HSC
: rrm?.-nm:'lmurrm'ghn:lw-ﬂ: R 2] 2 Guadrabure

T Wegathar Logh: on th product C v g 2-Fiepper tuapars
HEE KD Mapping

Starting Dighal In: B e = ! £
Dartieng Anbleg i T i =] R e .
Sharting Digiinl Gt [RG1681 Hamo: | -] - .y

Starting Analog Cut [MAg400 " Hame: =] = oy
HS4 WG Filtering

[ [
Filler Frequency J || —] Ewr
TEH: LLLIF

Hmiber of Samples | 1

Gouriter] | Countar? |

Tyttt | Disnbdod =]
input gt
Moy =1 | =1 | =
Dtsabha Furction: J 5 Podarity:
Latch Function: | =] 3 Potarity | ~]
Prefoad Function: | =] » Polarihe | =]
Clear Functicec | =] — =1
Marker: | =] » Potarity: | =]
Mareh: [ -]
| Hes24 ok | cance |

The Active mode group box allows the user to select if inputs are active high (Positive logic) or active low (Negative logic). It is
important that this setting matches the jumper settings on the hardware.

The High-Speed Counters group box contains all the windows that are used to configure the four available high-speed counters
on the Horner OCS. To configure a counter, the user needs to set the type, mode, and counts per rev.

The type drop down includes the following options:

Disabled
Frequency
Totalize
Pulse
Quadrature

Marker (Only available in counter #3 if counter #1 is set to quadrature.)

The mode drop-down items are set according to the type selection. The Counts Per Rev. window is enabled/disabled according
to the type selection as well.
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8.4: Digital / PWM Output Configuration
8.4.1: Solid State Digital Outputs

Solid-state digital outputs are generally used to activate lamps, low voltage solenoids, relays, and other low voltage and low
current devices.

NOTE: The digital outputs used on some controllers are sourcing outputs. This means the output applies a positive voltage to the
output pin when turned ON. When turned off, the output applies approximately zero volts with respect to the I/0 ground. Use the
Documentation Page to view the datasheet for a specific controller for specifics on a module's I/O.

J2
ov
1G-3CIVE.E:
® O V+
J4
- +

016
a1

Q14

The digital outputs used in the OCS have electronic short circuit protection and current limiting. While these electronic
protections work in most applications, some application may require external fusing on these outputs.

The digital outputs in the OCS are typically controlled via %Q bits in the register mapping. Some of the outputs are designed for
high-speed applications and can be used for PWM or frequency output applications.

When the controller is stopped, the operation of each output is configurable. The outputs can hold the state they were in before
the controller stopped or they can go to a predetermined state. By default, digital outputs turn off.

NOTE: The digital outputs feature an output fault bit. %132 will turn on if any of the outputs experience a short circuit, over-current
or the output driver overheats.
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8.4.2: Relay Outputs

Relay outputs are designed to switch loads that typically have high voltage or current requirements or require the isolation that
relays provide. Relay outputs are not available on all controllers, see the datasheet. NOTE: The design of the OCS does not
require external coil power for the relays to function. The relays will activate anytime the OCS is powered. There are several
factors that should be considered when using relays:

¢ Relay Life — Relays are mechanical devices that have a long but limited life. Typically, switching more current limits the
life of relays. Please check the data sheets at the end of this manual for expected relay life.

e Current / Temperature De-Rating — Products containing relays often have total current limits based on the ambient
temperature of the application. Please see the product data sheet for current / temperature de-rating information for
relays.

¢ Fusing — External fusing is generally required to protect the relays, devices and wiring from shorts or overloads.

WARNING: To protect the module and associated wiring from load faults, use external (5A) fuse(s) as shown. Fuses of lower
current or fusing for the entire system need to be in place to assure the maximum current rating of the unit is not exceeded.

WARNING: Connecting high voltage to any I/O pin can cause high voltage to appear at other I/O pins.

Below is an example of Relay Fusing:

12-24VDC

OV on J1:O—

HE-03T

Protection for Inductive Loads - Inductive loads can cause reverse currents when they shut off that can shorten the life of
relay contacts. Some protective measures need to be determined by an engineer. Below you will find recommendations that will
work for many applications. If you have additional questions on protection from inductive load, consult an application engineer or
Horner Technical Support. Details on devices that may protect outputs can be found in the Spark Quencher Datasheet,
MANO0962, which is located on the website.

Output State on Controller Stop - When the controller is stopped, the operation of each output is configurable. The outputs
can hold the state they were in before the controller stopped or they can go to a predetermined state. By default, relay outputs
turn off.
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8.4.3: Digital Output Configuration

Home > Hardware Configuration [select Device Type/Model#] > Local I/O Tab > I/0 / Config Button > Module Setup >
Digital Out/PWM

Select Hardware Configuration from the Home menu and ensure that the correct Device Type and Model# are selected. Then
select the Local 1/O tab.

Hardware Configuration

Controler | Local /0 | CAN1 (CSCAN) /O | CAN2 CsCAN) 1/0 | LAN1 10 | LAN21/0 |

Series [Canvas OCS Series ] Description:
c.\;gas Touch screen Operator Control Station with
Device Type |Can\ras 7D ﬂ fixed /O
Model #  [HE-CV-070D-02 = Properties
i 2 480 by 800 LCD
— Network Ports ! Display Type: | by
CAN1 Il:gc,w ~| Config Keypad Type: |5fundlon keys
M : |2048 K
CAN2 [CsCAN <] _Corfig Program Memory: | Bytes

Network Type:  |[CsCAN

Config
Advanced Ladder Functions
LAN2 |E_|‘1322 - Config Supports Analog Data

Real Time Clock Support

Supports Retentive Data
Serial Ports Config |

OCS Wi-Fi Module Config

Auto Config

ok | Cancal | | Help

After selecting Local I/0, select the Config button next to the I/O connector.

Hardware Configuration x
Controller Local 'O |CAN1 (CSCAN) 10| LANT 10|
e -
X0 ypaz
Empty — - Config
oK | Cancel | Help

The Module Configuration screen will appear, select the Module Setup tab. See below.
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Module Configuration

1/0 Mad | Module Setup |
Module

(Mudel XL1/Otype 6

Description: Please Refer User Manual for register values

0K

1 } Cancel | Apphy |
HG-211

The Module Setup allows a user to configure four types of I/O. NOTE: Not all controllers offer all four types. Refer to the
controller's datasheet the using Horner's Documentation Search page.

Module Configuration E
O Map Moduie Selup
8
Degital In / HSC Degital Ont / PWM
Analog kn Analog Out
— oK | cacel | sy |F

Select Digital Out/PWM to open the Digital / PWM Output Configuration dialogue.
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Digital / PWM Output Configuration *
a1 02
& Nomal & Nownal Stasting Analog Out. 7220427 il 5 20
T Pwil H1 P B2
" HSC1 Dutput " HSC2 Dulput Statting Dighal Inc [11617 - 4
" Steppei " Slepper
P State on Controler Stop
P #1 Duty Cycle defaul: [ I
P 82 Didy Cocle defaul: [ I~
Pt #1 Frequency: [ ™
P B2 Frequency: [i -
Output State on Controller Stop
3 5 [ 7 8
J ﬂ a] J a|afala
9 10 1 12
4|3 3|43
Legend

i] =0FF J =0N . =Hold Last Siate

ok | concal |

The Q1 and Q2 group boxes allow the user to specify the operation of the multifunction outputs.

PWM State On Controller Stop - Contains items that allow the user to specify how the PWM outputs behave when the
controller is stopped. These items can either hold their value or default to some value when the controller is stopped.

NOTE: The PWM outputs are set to the OFF state at power-up and during program download and remain in that state until the
unitis placed in RUN.

Output State On Controller Stop - Contains items to allow the user to specify how the remaining digital outputs behave when
the controller is stopped. These items can either hold their value or default to some value when the controller is stopped. NOTE:
The number of Output States on Controller Stop vary by product.

Stop State - When a controller stops running ladder logic, the state of most output /O modules can be configured. By default
digital outputs turn OFF and analog outputs go to a zero output level. Outputs can be configures to hold the last state the outputs
was in when the controller stopped, or it can be configured to go to a predefined state. NOTE: When a controller is in DO I/O
mode the outputs are still controlled by the values in the controller's registers.

NOTE: The number of Output State on Controller Stop varies by controller. See the datasheet on the Documentation Page for
more details.
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8.5: Analog Input Configuration

The analog inputs on the OCS allow voltage or current measurement from a variety of devices. The voltage or current mode is
set though jumpers on the unit and settings in Cscape. Each channel can be separately configured for voltage or current mode.

The analog inputs have a digital filter that can be used to filter electrical noise that may be unavoidable in some installations. The
downside to digital filtering is the inputs will respond more slowly to sudden changes in the actual input.

Home > Hardware Configuration [select Device Type/Model#] > Local I/O Tab > I/0 / Config Button > Module Setup >
Analog In

Select Hardware Configuration from the Home menu and ensure that the correct Device Type and Model# are selected. Then
select the Local 1/O tab.

Hardware Configuration X

Controller | Local 140 | CAN1 (CsCAN) LO | CAN2 (CsCAN) /0 | LANT 1O | LANZ 10 |

Series Canvas OCS Series - Description;
c‘:;"s [Touch screen Operator Control Station with
Deweatipe [ 5] k facd L0
Model & HE-CV-070D-02 = Properties
D Type: 480 by 800 LCD
Network Ports ajlies | by
CANT m T Keypad Type |5 function keys
m Mem: 2048 K Bytes
cAN2 [GsCAN <] _Conba bz o | T
Network Type:  [CsCAN
LANT |ETN300 ~| Config

Advanced Ladder Functions

300 -| Config Supports Analog Data
Real Time Clock Support

LANZ2 [ET)

. Config ‘Swuurts Retentive Data
OCS Wi-Fi Module Config
Auto Config
ok | cancel | ‘ Help
After selecting Local I/O, select the Config button next to the I/0 connector.
Harcware Configuration x
Conftroller Local O \CAM (CSCAN) /0 | LANT 110
XL 1O type 2 ¥ .|
mpty [ — EaPTY m—T] Config
OK Cancel Help

The Module Configuration screen will appear, select the Module Setup tab.
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The Module Setup allows a user to configure four types of I/O. NOTE: Not all controllers offer all four types. Refer to the
controller's datasheet on the Horner website's Documentation Page for more information regarding specific models.

Medule Configuration X |
AN
VO Map  Modde Setup |
il
Digtal In / HSC Digial Out / PWM
Andlog n Analog Out
= oK | cancal dopy | =
o e
Select Analog In to open the Analog Input Configuration dialogue:
' Analog Input Configuration >
Charmel 1:
[<zima =l
0.0V
0, 20
Charnel 3:
T -]
Chennal 4;
|4 20me -]
Charnel 5
[ =
Channel &:
[ =]
Filtar Constant:
a
[a]:4 I Cancel

L-v:.:m

The Channel x drop down windows allow the user to specify the mode for each analog input to operate. The Channel x drop
down windows are enabled/disabled according to which model is being configured. All of the models have the following modes
available: 0..10V, 0..20mA, and 4..20mA.
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8.5.1: Universal Analog Inputs - Model 5

The universal analog inputs provide a high resolution, very flexible interface for a variety of analog inputs. These inputs include
voltage, current, theremocouple, RTD, and millivolt. Each channel can be configured separately using jumpers and configuration
settings in Cscape.

Like the standard analog inputs, these inputs have a digital filter that can be used to filter electrical noise that may be
unavoidable in some installations. The downside to digital filtering is the inputs will respond more slowly to sudden changes in
the actual input.

Analog In for Model 5
Channels 1 & 2

0..10vV

0..20mA

4..20mA

100mV

PT100 DIN RTD, 1/20°C
Type J Thermocouple, 1/20°C

Type K Thermocouple, 1/20°C

Type N Thermocouple, 1/20°C

Type T Thermocouple, 1/20°C

Type E Thermocouple, 1/20°C

Type R Thermocouple, 1/20°C

Type S Thermocouple, 1/20°C

Type B Thermocouple, 1/20°C

* The Filter Constant provides filtering to all channels.

Model 5 Universal Analog Input Configuration

1. Select Analog In to access the Analog Input Configuration menu.

2. Select any of the Analog input types from the drop-downs by clicking the down arrow beneath each corresponding
Channel, as seen below:
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| Analeg Input Configuration X
|

| Channel:

THET £l

o |

0. Z0mefy

4 20ieA

100

FTI00 DINATD, 1/20 Deg. C

Type J Themocouple, 1520 Deg ©

Typa K Thismocouple. 120 Deg.

Type N Thesmoooupbe. 1,20 Deg. C©

Type T Thermocouple. 1720 Deg. C

Typé E Thernooouple, 1/20 Deg. C

Type R Thesmooouphe. 120 Deg. ©
c
[

Type S Thermocouple, 1/20 Deg
Type B Thermocouple, 1/20 Dey

| =
Channel &
| =l
Fitis Congtant
P
ok | concel

HG-433

3. Ensure the proper wiring is used for each of the pins on the Universal Analog Inputs as seen in the image and table

below:
20mA Analog In
0-10 V Analog In mV In Thermocouple In
20mv +  —
NC 1OOmV++ +
+ 100mvV- —| Loop PWR
0-10VDC - -
HG-1239  NOTE: Be sure to wire OV to V1.
HG-1236 HG-1237 HG-1238
RTD In
4-20 mA Analog Out 0-10V Analog Out
20mA 10VDC
L — + — +
B B | B
HG-1240 =
HG-1241 HG-1242

Table for Model 5 Universal Wiring
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J3 Connector for Universal Wiring

T1+ TC (1+) or RTD (1+) or 100mV (1+)
T1- TC (1-) or RTD (1-) or 100mV (1-)
T2+ TC (2+) or RTD (2+) or 100mV (2+)
T2- TC (2-) or RTD (2-) or 100mV (2-)
AQ1 10V or 20mA OUT (1)
AQ2 10V or 20mA OUT (2)

ov Common

MA1 0-20mA IN (1)

VA 0-10V IN (1)

ov Common
MA2 0-20mA IN (2)

V2 0-10VIN (2)

ov Common

8.5.2: Universal Analog Inputs - Model 6

The Universal Analog Inputs on the Model 6 10 board are unique from other Horner series input/output cards in that they are
configurable through the module configuration instead of having to change jumper settings in order to setup the input type.

Analog In for Model 6
Channels 1-6

0..10v

0..20mA

4.20mA

Disable

0-60mV

PT100 DIN RTD, 1/10°C
PT1000 DIN RTD, 1/10°C
Type J Thermocouple, 1/10°C
Type K Thermocouple, 1/10°C
Type N Thermocouple, 1/10°C
Type T Thermocouple, 1/10°C
Type E Thermocouple, 1/10°C
Type R Thermocouple, 1/10°C
Type S Thermocouple, 1/10°C
Type B Thermocouple, 1/10°C

Model 6 Universal Analog Input Type Configuration

1. Select Analog In to access the Analog Input Configuration menu.

2. Select any of the Analog input types from the drop-downs by clicking the down arrow beneath each corresponding
Channel, as seen below:

Page 93 of 209



I HORNER

AUTOMATION GROUP

Chapter 8: General I/O Configuration

Analog Input Configuration *

Channel 1: Filter Constant
1oy 2 [ -
ooy |

[T

4 Hms
Dizable

0-G0em

FT100 DIiNRTD
FT1000 Di ATD
Type J Thermacouple
Type K Theimosauple
Type N Themocouple
Type T Tharmocouple
Type E Thermotauple
Type B Themocouple
Type S Tharmocouple
| Type B Tharmocouple

Channed b

[Disable ~]

d o

H._

KG-434
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3. Ensure the proper wiring is used for each of the 3 pins A, B, and C on the Universal Analog Inputs as seen in the reference
image below:

NC

+
0-10vDC

HG-224

mV In

Thermocouple In

4-20 mA Analog Out

20mA R

20mA Analog In - Not
Self-Powered

20mA+ _—
Loop PR |
24vDC —

NC.

20mA Analog In -
Self-Powered

20mA—__+
{m III

0-10 V Analog Out
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8.5.3: Scaling Analog Inputs & Examples

To access the Advanced Math Scaling function, select Home > View > Project Toolbox. This will open a side bar, and then
select Advanced Math > Scale.

Example 1

The Cscape Scale function, found in the Advanced Math functions, allows for very easy conversion of the raw input value into a
meaningful reading. For example, a pressure transducer may be specified as a 4-20mA signal to signify a 0-2000 psi pressure
reading. With the analog channel set to the 4-20mA range, the raw analog input value, which is in INT format ranges from 0 to
4mA to 32000 for 20mA. Use the Scale function to obtain an Integer pressure reading using the 0-32000 raw input range and the
sensor’s 0-2000psi output range.

1
ALW_ON |_5“""’
@ | | -

Enalog_TnputT
n_

1 %5007
2 41001 1IN

s PSI_Reading
QF%R00001

2000 max

Example 2:

If readings with fractions are required, the raw Integer input value must first be translated in REAL, or Floating Point Format, see
note below. The Cscape INT-to-REAL Conversion function may be used to convert the raw input value from INT to REAL format
in an intermediate memory location. The SCALE function, specified as REAL type, may be used to scale the converted raw value
into a reading that supports digits beyond the decimal place, i.e. 475.25psi.

Int Scale
O g Analog Trpull| HEAL

|]_
2 %5007 Analog R
5 L& RO0003 %— IN1
32000 max

=

. 07 ™ ps| feading REAL

20004 max

8.6: Analog Outputs

NOTE: Refer to the datasheet for details on jumper settings.

The analog outputs on Horner OCS devices provide high resolution voltage or current outputs. The voltage or current selection is
controlled with jumpers and configuration settings in Cscape.
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NOTE: Each channel can be separately configured for voltage or current mode.

When the controller is stopped, the operation of each output is configurable. The outputs can hold the
state they were in before the controller stopped or they can go to a predetermined value. By default,
analog outputs are set to a value of zero (0).

The following figure illustrates the Analog Output Configuration dialog. To open the I/O configuration dialogs, select Controller >
Hardware Configuration > Local I/O > Config > Module Setup.

Analog Output Configuration X

Output value on STOP ~ Output Mode

AQY- Goto: [0 [v" Hold Last Value 0.10v 'I
AQI0-Goto: [0 [ Hold Last Value 0.20mA
4.20maA

AQ11-Goto: [0 [* Hold Last Yalue Disable |

AQ12- Goto: |0 [ Hold Last Value Disable ‘rl

oK | Cancel |

HG-021

The Output value on Stop group box contains items that allow the user to specify how the analog output channels behave when
the controller is stopped. The outputs can either hold their value or default to a value when the controller is stopped.

The Output Mode group box allows the user to select the operating modes for each of the analog outputs. The modes include the
following:

e 010V
e (0-20mA
o 4-20mA

For more information on Stop State, refer to the "Cscape Configuration".
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Chapter 9: High Speed I/0 (HSC/PWM)

0. OV VI W 99
9.2: High Speed 110 GloSSary ... ... 100
9.3: High Speed Counter (HSC) FUNCtiONS ... ... .. 101
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9.5: HSC Functions Register Maps ... .. ... 105
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9.7: High Speed Output Functions Register Map ... ... . 112
9.8: HSC 11O FIlering ... e 116

9.1: Overview

In addition to the compliment of simple analog and digital I/O, several of the OCS I/O modules support High Speed Counting
(HSC) I/O functions and may also support Pulse Width Modulation (PWM) Output functions (non-relay modules). The HSC
functions include internal timing, frequency, totalizing, pulse width/period, and quadrature measurement. The PWM functions
include traditional PWM (with variable rate and duty cycle) and a stepper (limited functionality) with variable acceleration and
deceleration rates.

The OCS contains a Field-Programmable Gate Array (FPGA), which is an integrated configurable circuit that allows the OCS
to be programmed to have either two high-speed counters or four high-speed counters. The OCS ships with two high-speed
counters, but a customer can contact Horner Technical Support to receive a file that will configure the unit to have four. These
modes are not supported simultaneously. Two counter mode supports Quadrature mode and two stepper outputs, while four
counter mode does not support Quadrature mode and supports only one stepper output.

This chapter describes the operation of these high level I/O functions. For configuration details of these functions, see "Cscape
Configuration”.
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9.2: High Speed I/O Glossary

Glossary of High Speed I/O Terms

Accumulator Register used to accumulate or store up a sum or count of many items or events.
Clear A special function to zero out the value in a specific register. (Not used with Frequency or Period
Measurement.)
Disable A special function to prevent the counter from running.
Encoder A sensor or transducer for converting rotary motion or position to a series of electronic pulses

An integrated, configurable circuit that allows the controller to be programmed to have either two

FPGA high-speed counters or four high-speed counters.

The number of times an electromagnetic signal repeats an identical cycle in a unit of time, usually

Frequency Input one second.

A special function that uses a digital logic circuit to store one or more bits. A latch has a data input,
a clock input and an output. When the clock input is active, data on the input is "latched" or stored
and transferred to the output register either immediately or when the clock input goes inactive. The
output retains its value until the clock goes active again.

Latch (strobe)

Input into the OCS that indicates a particular position. Typically, an encoder has a marker output

Marker that represents a specific point in the rotation.

A Polarity pull-down box is associated with each function and indicates the manner in which the

Relaity trigger happens (e.g., High level, Low Level, Falling Edge, Rising Edge).

A special function used to trigger loading of a value into a register upon an event. (Not used with

eleadiioad) Frequency or Period Measurement.)

A high-speed device that expresses the phase relationship between two periodic quantities of the
Quadrature same period when the phase difference between them is one fourth of a period. A coupler in which
the two output signals are 90° out of phase.

Totalizer A counter that sums the total number of cycles applied to its input.
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9.3: High Speed Counter (HSC) Functions

The supports two high speed, configurable counters. There are four dedicated inputs that can be configured to a number of
different options. Each of the two counters can run in one of five modes. Those modes are Totalizer, Frequency Counter, Pulse
Width Measurement, Period Measurement and Quadrature measurement. For some modes, more than one HSC input may be
consumed. The measurement values are provided to ladder in a %Al register. Refer to the Register chapter for more details.

9.3.1: Frequency

In frequency mode, the frequency of the input signal is written to the accumulator in terms of Hertz (cycles/second). When using
frequency mode, four update selections are provided which specify the width of the sample window.

NOTE: Selecting a shorter sample window provides a quicker measurement (faster response) but lowers the frequency
accuracy (resolution) and increases the minimum frequency measurement limit. In this mode the Disable and Latch special
functions are allowed. Refer to the"High Speed I/O Glossary " on the previous page"High Speed I/O Glossary " on the
previous pagefor a description of these functions.

9.3.2: Totalize

In totalize mode, the accumulator is simply incremented or decremented each time the input transitions in a specific direction.
The totalizer supports the following modes:

This mode ties the input to the counter to an internal 10MHz or 1MHz clock. The special functions
Internal .
can be used to accurately time events.
This increments the accumulator when the input is enabled.
Count Up NOTE: Two inputs can be assigned. Either input can cause the counter to increment. The
second input can also be disabled.
This decrements the accumulator when the input is enabled.
Count Down NOTE: Two inputs can be assigned. Either input can cause the counter to decrement. The
second input can also be disabled.
Up/Down (Input 1 In this mode, Input 1 (assigned to any of the four inputs) increments the counter, while Input 2
Up/Input 2 Down) (also assigned to any of the 4 inputs) decrements the counter.
. This mode uses input 1 as a clock signal to increment or decrement the counter and then uses
CIk/Dir (Input 1 Clk, . . L : ) o
. input 2 to decide the direction. Input 2 disabled increments the counter, while input 2 enabled
Input 2 Dir)
decrements the counter.

NOTE: The totalize mode enables the Disable, Latch, Preload, and Clear special functions. Refer to the "High Speed 1/0
Glossary " on the previous page for a description of these functions.
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NOTE: Counter triggers off the rising edge of the signal.

A

Rising Edge Signal Falling Edge Signal

Three different options are available to reset the current count:

The totalize function also supports an option which compares the current accumulator value with a supplied Preset Value (PV),
which is provided through a %AQ, and drives a physical digital output based on the that comparison.

NOTE: This option (available for HSC1 and HSC2 only) drives Q1 or Q2 output point (respectively) once the associated
totalizer accumulator reaches (or exceeds) the PV value. To enable this function, the corresponding PWM function output
(Q1 or Q2) must be configured for HSCx Output.

NOTE: Q1 and Q2 are PWM function outputs that may be configured independently as one of the following: standard digital
output, PWM, HSCx or stepper output.

Preset values may be modified during run-time. A preset value of zero disables (resets) the totalizer compares function output
causing the output to remain low.

9.3.3: Pulse Width Measurement

In pulse width measurement mode, the high-speed input can measure the width of a pulse stream in one of two modes and
provides a continuous indication of the last sampled value. In this mode the Disable and Latch special functions are allowed.
Refer to the "High Speed I/O Glossary " on page 100 for a description of these functions.

Width High 1 ps Counts — In this sub-mode the accumulator value will contain the number of 1 us counts the pulse is high.

Width High

Width Low 1 pus Counts — In this sub-mode the accumulator value will contain the number of 1 ps counts the pulse is low.

Width Low
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9.3.4: Period Measurement

In period measurement mode, the high-speed input can measure the period of a pulse stream in one of two modes and provides
a continuous indication of the last sampled value. In this mode, the Disable and Latch special functions are allowed. Refer to the
"High Speed I/0O Glossary " on page 100 for a description of these functions.

Period Rising Edges 1 ps Counts — In this sub-mode the period of the input signal is reported in one (1) us units. The period
measurement will start on the rising edge of the input.

Period from
Rising Edge

Period Falling Edges 1 ps Counts — In this sub-mode the period of the input signal is reported in 1 ps units. The period
measurement will start on the falling edge of the input.

L

I

Period from
Falling Edge

9.3.5: Quadrature

Quadrature mode uses two HSC inputs, any of the four HSC inputs can be assigned for this purpose.Quadrature mode works
much like the totalizer except the accumulator will automatically increment or decrement based on the rotation phase of the two
inputs. See the following example for more details. Quadrature inputs are typically used for reporting the value of an encoder.

Two modes are available for quadrature that select whether the accumulator counts up or down when the phase of Input 1 leads
Input 2. Check your encoder’s documentation to determine the output form it uses or try both modes to determine if the encoder
counts up when expected.

—

J 1 (leading)

90°
phase «——
shift

Using the above waveforms and a HSC input configuration of “Quadrature” - “1 leads 2, count up,” the accumulator will count up
when 1 is rising and 2 is low, 1 is high and 2 is rising, 1 is falling and 2 is high, and when 1 is low and 2 is falling. This results in 4
counts per revolution. So in order to determine the number of cycles, the accumulator would have to be divided by 4.

Marker reset operation is configured in the special operations and can be assigned to any of the 4 high speed inputs or can be
assigned to be controlled by a “Q” bit in ladder.

NOTE: The quadrature mode enables the Disable, Latch, Preload, Clear and Marker special functions. Refer to the "High
Speed I/O Glossary " on page 100for a description of these functions.

9.3.6: Register Match

Totalizer & Quadrature counter modes support a register match function. When the accumulator value matches either the Match
1 or Match 2 value configured in the corresponding %AQ registers, a high-speed output can Turn On, Turn Off, or Toggle. An
internal %l register mirrors the output state whether the high-speed output is configured or not. The output can be reset in
program logic using the corresponding %Q registers.

1. 2-Counter Mode has Register Match support for both counters.
2. 4-Counter Mode has Register Match support only for counters 1 and 2.

Page 103 of 209



8.

HORNER

S O UP Chapter 9: High Speed I/0O (HSC/PWM)

The High-Speed Outputs are %Q1 for Counter 1 and %Q2 for Counter 2. They operate as high-speed
outputs, independent of the controller scan rate, when configured as ‘HSC Output’ in the Digital Out/PWM
configuration in Cscape.

The High-Speed Output state reflects in the status register “High Speed Out”, e.g. %10009 for Counter 1
(the update speed of the status bit is scan rate dependent)

The High-Speed Output can be reset through ladder with the assigned output, e.g. %Q0022 for Counter 1
Both Match 1 and Match 2 values will trigger the match function.

If the output is already triggered by any Match register while using ‘Turn On’ or ‘Turn Off modes,
subsequent matches will not affect the output.

If using ‘Toggle’ mode, every match of either Match value will toggle the output to the opposite state.

9.4: HSC Functions

The high-speed input on the OCS contains many optional tasks. All of which can be disabled, or set to an internal pre-assigned
register (Assigned %Q) or to one of the external high speed inputs (External Input #1, 2, 3, or 4), or they can be set as an
“overflow interrupt” or “underflow interrupt” meaning that they will occur when either the Overflow or Underflow input has been
activated.

9.4.1:

Disable: When the Disable function is active, it will “disable” the high-speed inputs and no longer count
pulses until it is re-enabled

Latch: When the Latch function is active, it takes the current value of the Accumulator and moves it into the
“Latch Value” register

Preload: When the pre-load function is active, it will take the value from the “Preload” register and put it into
the “Accumulator” for the corresponding Counter.

Clear: When the clear function is active, it will move a value of 0 into the “Accumulator” for the
corresponding counter.

Marker: When the marker function is enabled, it acts as a dynamic enable/disable for the Disable, Latch,
Preload, and Clear functions. If the marker is enabled and “Assigned %Q” is selected, then both the
“Disable” and the “Disable Marker” bits need to be set high in order to disable the high-speed input. If the
Marker is set for one of the inputs, then the input will need to be “High” in order to use any of the Disable,
Clear, Preload, or Latch functions.

Status Bits

There are three status bits (%l registers for each high-speed counter):

Overflow Flag: This status bit turns high when the Accumulator “overflows”, it moves from 4,294,967,295
(-1 if Signed) to 0, this bit can be reset with the “Output Reset Bit”. See Table 9.4.

Underflow Flag: This status bit turns high when the Accumulator “underflows”, it moves from 0 to
4,294,967,295 (-1 if Signed), this bit can also be reset with the “Output Reset Bit”.

NOTE: For the Overflow and Underflow flag registers, if using some sort of counter that counts both up and down,
going over the threshold to go negative, triggers the underflow, and then going back over the threshold back into
positive numbers will trigger the positive register to go active.

High Speed Out: This register will follow the high-speed output assigned to the counter, it is important to
note that this register is still populated within the scan time so the value in this register may not be up to
date depending on the timing of the output (it should be up to date within one scan).
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9.5: HSC Functions Register Maps

The register assignments for the high-speed I/O can be reassigned via a setting in Cscape. The values shown are the DEFAULT
values and may not match the same starting point as the values shown below.

9.5.1: 1/0 Mapping 4-Counter Mode

Default Analog Output Registers for HSC

Register Function
%AQ401 —402 Preload Value (Counter1)
%AQ403 — 404 Match1 Value (Counter1)
%AQ405 — 406 Match2 Value (Counter1)
%AQ407 — 408 Preload Value (Counter2)
%AQ409 —410 Match1 Value (Counter2)
%AQ411 —412 Match2 Value (Counter2)
%AQ413 —414 Preload Value (Counter3)
%AQ415—-416 Reserved
%AQ417 —418 Reserved
%AQ419 —420 Preload Value (Counter4)

Register

Default Analog Input Registers for HSC

Function

%Al1401 —402

Accumulator/Count Value (Counter1)

%Al1403 — 404

Latch Value (Counter1)

%AI405 — 406

Accumulator/Count Value (Counter2)

%AI407 — 408 Latch Value (Counter2)
%AI409 — 410 Accumulator/Count Value (Counter3)
%AI411 —412 Latch Value (Counter3)
%AI413 —414 Accumulator/Count Value (Counter4)
%AI415 - 416 Latch Value (Counter4)
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Default Output Registers for HSC

Register Function

%Q1601 Latch Trigger (Counter1)

%Q1602 Preload Trigger (Counter1)
%Q1603 Clear Trigger (Counter1)

%Q1604 Disable Counter (Counter1)
%Q1605 Direction (Counter1)

%Q1606 Underflow/Overflow/HSCQ Reset (Counter1) ( High — Reset)
%Q1607 Preload Disable (Counter1) (High — Disable)
%Q1608 Latch Disable (Counter1)(High — Disable)
%Q1609 Reserved

%Q1610 Reserved

%Q1611 Reserved

%Q1612 Reserved

%Q1613 Reserved

%Q1614 Reserved

%Q1615 Reserved

%Q1616 Reserved

%Q1617 Latch Trigger (Counter2)

%Q1618 Preload Trigger (Counter2)
%Q1619 Clear Trigger (Counter2)

%Q1620 Disable Counter (Counter2)
%Q1621 Direction (Counter2)

%Q1622 Underflow/Overflow/HSCQ Reset (Counter2) ( High — Reset)
%Q1623 Preload Disable(Counter2) (High — Disable)
%Q1624 Latch Disable (Counter2)(High — Disable)
%Q1625 Reserved

%Q1626 Reserved

%Q1627 Reserved

%Q1628 Reserved

%Q1629 Reserved

%Q1630 Reserved

%Q1631 Reserved

%Q1632 Reserved

%Q1633 Latch Trigger (Counter3)

%Q1634 Preload Trigger (Counter3)
%Q1635 Clear Trigger (Counter3)

%Q1636 Disable Counter (Counter3)
%Q1637 Direction (Counter3)

%Q1638 Underflow/Overflow/HSCQ Reset (Counter3) ( High — Reset)
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Default Output Registers for HSC

Register Function
%Q1639 Preload Disable(Counter3) (High — Disable)
%Q1640 Latch Disable (Counter3)(High — Disable)
%Q1641 Reserved
%Q1642 Reserved
%Q1643 Reserved
%Q1644 Reserved
%Q1645 Reserved
%Q1646 Reserved
%Q1647 Reserved
%Q1648 Reserved
%Q1649 Latch Trigger (Counter4)
%Q1650 Preload Trigger (Counter4)
%Q1651 Clear Trigger (Counter4)
%Q1652 Disable Counter (Counter4)
%Q1653 Direction (Counter4)
%Q1654 Underflow/Overflow/HSCQ Reset (Counter4) ( High — Reset)
%Q1655 Preload Disable(Counter4) (High — Disable)
%Q1656 Latch Disable (Counter4) (High — Disable)
%Q1657 Reserved
%Q1658 Reserved
%Q1659 Reserved
%Q1660 Reserved
%Q1661 Reserved
%Q1662 Reserved
%Q1663 Reserved
%Q1664 Reserved

Default Input Registers for HSC
Register Function
%I11601 Overflow Flag (Counter1)
%11602 Underflow Flag (Counter1)
%11603 HSCQ (Counter1)
%11604 Reserved (Counter1)
%11605 Overflow Flag (Counter2)
%11606 Underflow Flag (Counter2)
%11607 HSCQ (Counter2)
%11608 Reserved (Counter2)
%11609 Overflow Flag (Counter3)
%11610 Underflow Flag (Counter3)
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Default Input Registers for HSC

Register Function

%I11611 HSCQ (Counter3)
%I11612 Reserved (Counter3)
%11613 Overflow Flag (Counter4)
%11614 Underflow Flag (Counter4)
%11615 HSCQ (Counter4)
%11616 Reserved (Counter4)
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9.6: High Speed Output Functions

On units that support high-speed output functions, two dedicated outputs are available that can be configured for one of four
modes of operation. Those modes are Normal, PWM, HSC Match and Stepper.

9.6.1: Normal

When either Q1 or Q2 is configured for Normal operation, the digital output registers %Q1 and %Q2 drives that respective
output.

9.6.2: PWM

When either Q1 or Q2 is configured for PWM, the PWM function drives that respective output. Both PWM channels may be
individually enabled and can have independent frequency and duty cycles.

The PWMs require two parameters (%AQs) to be set for operation. These parameters may be set at run-time.

Duty Cycle — The Duty Cycle is a 32-bit value from 0 to 32,000 indicating the relative duty cycle of the output. For example, a
value of 8000 would indicate a 25% duty cycle, a value of 16,000 would indicate a 50% duty cycle. Zero (0) turns the output off,
32,000 turns the output on.

Duty Cycle
HEAZT

Frequency — The Frequency is a 32-bit value indicating the output frequency in Hertz. One over the frequency is the period.

- Pariad

At controller power-up or during a download, the PWM output is maintained at zero until both the Frequency and the Duty cycle
are loaded with non-zero values. When the controller is placed in stop mode, the state of the PWM outputs is dependent on the
PWM State on Controller Stop configuration. This configuration allows for either hold-last-state or specific frequency and duty
cycle counts. Specifying zero for either the period or duty causes the PWM output to remain low during stop mode.
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9.6.3: PWM Output Waveform

24 \olts

/ PWM OFF :

i : 20%
| Rise . Fall
Time Time
O <Y I - T e FUUT TP .

PWM Output Waveform Table \

Rise Time 150ns Max
Fall Time 150ns Max
PWM Period | Frequency = 1/Period

1.6.4: High Speed Counter Match

When either Q1 or Q2 is configured for HSC Output operation, their output state is based on a comparison between the counter
accumulator and match registers. Refer to the "HSC Functions Register Maps" on page 105 for more details.
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9.6.4: Stepper Function

The OCS supports two stepper functions, one on each high-speed output when in two counter mode. In four counter mode, the
OCS supports one stepper function

The Stepper requires five parameters (%AQs) to be set for operation. These parameters may be set at run-time but are ‘latched’
when the stepper is commanded to start:

Sets the frequency for the first cycle during the acceleration phase and the frequency of the last cycle
during the deceleration phase. When an acceleration or deceleration count is specified, the Start
Frequency must be greater than 0 and must not exceed the run frequency or an error is generated.

Sets the frequency for the last cycle during the acceleration phase, the consistent frequency during the
run phase, and the frequency of the first cycle during the deceleration mode. The Run Frequency must
be greater than 0 and must not exceed 5000Hz (standard).

Start Frequency
(pulses per second)

Run Frequency
(pulses per second)

Sets the number of cycles to occur within the acceleration phase. The frequency of the cycles within
Acceleration Count | this mode will vary linearly between the specified Start and Run frequency. The Accel count must not
equal 1 or an error is generated. Setting this value to zero disables this phase.

Sets the number of cycles to occur within the run phase. The frequency of the cycles within this mode
Run Count is constant at the specified Run frequency. The Run count may be any value. Setting this value to zero
disables this phase.

Sets the number of cycles to occur within the deceleration phase. The frequency of the cycles within
Deceleration Count | this phase will vary linearly between the specified Run and Stop frequency. The Decel count must not
equal 1 or an error is generated. Setting this value to zero disables this phase.

The stepper provides two Boolean registers to provide stepper status:

A high indication on this register indicates the stepper sequence can be started (i.e. not currently busy)

RCELIZTID and also when the move is completed.

A high indication on this register indicates that one of the analog parameters specified above is invalid
Error or the stepper action was aborted before the operation was complete. This register is cleared on the
next start command if the error was corrected.

The stepper requires one discrete register to control the stepper action. Setting this register starts the stepper cycle. This register
must remain set to complete the entire cycle. Clearing this register before the cycle is complete aborts the step sequence and
sets the error bit.

NOTE: Setting the PLC mode to stop while the stepper is in operation causes the stepper output to immediately drop to zero
and the current stepper count to be lost.

NOTE: The stepper output level may cause damage or be incompatible with some motor drive inputs. Consult drive
documentation to determine if output level and type is compatible.
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9.7: High Speed Output Functions Register Map

The register assignments for the high speed I/O can be moved via a setting in Cscape. The values shown are the DEFAULT
values and may not match the same starting point as the values shown below.

9.7.1: 1/0 Mapping 2—-Counter Mode

Default Analog Output Registers for PWM & Stepper

Register PWM Stepper
%AQ421 — 422 Duty Cycle (PWM1) Start Frequency (Stepper1)
%AQ423 — 424 Frequency (PWM1) Run Frequency (Stepper1)
%AQ425 - 426 Acceleration Count (Stepper1)
%AQ427 — 428 Run Count (Stepper1)
%AQ429 — 430 Deceleration Count (Stepper1)
%AQ431 —432 Duty Cycle (PWM2) Start Frequency (Stepper2)
%AQ433 — 434 Frequency (PWM2) Run Frequency (Stepper2)
%AQ435 — 436 Acceleration Count (Stepper2)
%AQ437 — 438 Run Count (Stepper2)
%AQ439 — 440 Deceleration Count (Stepper2)
Default Input Registers for PWM & Stepper
Register PWM Stepper
%11617 Ready/Done (Stepper1)
%11618 Error (Stepper1)
%I11619 Ready/Done (Stepper2)
%I11620 Error (Stepper2)
Default Output Registers for PWM & Stepper
Register PWM Stepper
%Q1 PWM Output 1 Stepper 1 Output
%Q2 PWM Output 2 Stepper 2 Output
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9.7.2: 1/0 Mapping 4-Counter Mode
Register PWM Stepper

%AQ421 — 422 Duty Cycle (PWM1) Start Frequency (Stepper1)
%AQ423 — 424 Frequency (PWM1) Run Frequency (Stepper1)
%AQ425 — 426 Acceleration Count (Stepper1)
%AQ427 — 428 Run Count (Stepper1)
%AQ429 — 430 Deceleration Count (Stepper1)
%AQ431—-432 Duty Cycle (PWM2)
%AQ433 —434 Frequency (PWM2)
%AQ435 — 436
%AQ437 — 438
%AQ439 — 440

Default Input Registers for PWM & Stepper

Register PWM Stepper
%1617 Ready/Done (Stepper1)
%I11618 Error (Stepper1)

Default Output Registers for PWM & Stepper
Register PWM Stepper
%Q1 PWM Output 1 Stepper 1 Output
%Q2 PWM Output 2 Stepper 2 Output
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Duty Cycle

Frequency

To get a 50% Duty Cycle @ 10kHz
waveform on PWM1:

Set %AQ421-422 = 16,000

Set %AQ423-424 = 10,000

Example 2

Duty Cycle

Frequency

To geta 50% Duty Cycle on PW1 and
90% Duty Cycle on PWM2 @ 1kHz
waveform:

Set %AQ421-422 = 16,000
Set %AQ431-432 = 28,800
(duty cycle (32000 * 0.9))

Set %AQ423-424 = 1,000
Set %AQ433-434 = 1,000

Example 3

Duty Cycle

Frequency

To turn PWM 1 output ON all the time

Set %AQ421-422 = 32,000

Set %AQ423-424 = Any Value

Example 4

Duty Cycle

Frequency

To turn PWM 1 output OFF all the time

Set %AQ421-422=0

Set %AQ423-424 = Any Value
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Start Frequency

Run Frequency

Accel Count

Run Count

Decel Count

10,000,000 steps
control sequence

Set %AQ421-422
= 2500 (Hz)

Set %AQ423-
424= 5000 (Hz)

Set %AQ425-426 =
1,000,000 (Steps)

Set %AQ427-428 =
8,000,000 (Steps)

Set %AQ429-430 =
1,0000,000 (Steps)

When the start bit is energized, the example starts at 2.5kHz and ramps up to 5kHz during the first 1,000,000 steps. Then, it
runs at 5kHz for the next 8,000,000 steps. Finally, during the last 1,000,000 steps it slows to a stop.

Example 2
Start Frequency | Run Frequency Accel Count Run Count Decel Count
5,000,000 steps | Set %AQ421-422 | Set %AQ423-424 | Set %AQ425-426 = | Set %AQ427-428 = | Set %AQ429-430 =
control sequence | =500 (Hz) =1000 (Hz) 2,000,000 (Steps) | 2,000,000 (Steps) 1,000,000 (Steps)

When the start bit is energized, the example starts at 0.5 kHz and ramps up to 1 kHz during the first 2,000,000 steps. Then, it
runs at 1 kHz for the next 2,000,000 steps. Finally, during the last 1,000,000 steps it slows to a stop.

Example 3
Start Frequency | Run Frequency Accel Count Run Count Decel Count
6,000,000 steps | Set %AQ421-422 | Set %AQ423-424 | Set %AQ425-426 | Set %AQ427-428 = | Set %AQ429-430 =
control sequence | =50 (Hz) =250 (Hz) =150,00 (Steps) 5,500,000 (Steps) 350,000 (Steps)

When the start bit is energized, the following example starts at 50Hz and ramps up to 250Hz during the first 150,000 steps.
Then, it runs at 250Hz for the next 5,500,000 steps. During the last 350,000 steps it slows to a stop.

NOTE: Prior to the start of a move, the Ready/Done bit for that channel must be ON (%133 or %135 for channel 1 and 2
respectfully). The Ready/Done bit will turn OFF during the move, and then back ON once the move is completed.

NOTE: The pulse generation hardware on the OCS can generate any frequency that can be evenly divided into 10MHz
(10,000,000Hz) under the maximum recommended frequencies for each model. This results in a very smooth operation at

lower frequencies, with a progressively choppier operation at higher frequencies, as the units reach their maximum
recommended frequency.
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Selecting Digital In/HSC configuration opens up the following dialog where in HSC I/O Filtering is available.

Digital / HSC Input Configuration *
— Digital inputs active mode ~ Counter Modes
& 2 Counter mode  MNote: 2 Channel Supports:
& Podiive Logi o 1) 2HSC
it || @ T 2| 2Quadrature
" Megative Logic  on the product 3) 2-Stepper Outputs
L
~HSC I/0 Mapping '
Statting DigitalIn: ~ [%11601 Name: | ~| @» o
Starting Analog In: |°/.,.-‘-\I401 Name:[ Ll el w3
Starting Digital Out.  [%01501 Name: | | @& 32
Statting Analog Out: [%40401  Name: | | T 112
/" ~HSC /0 Filtering -\
[~ 219 ™ 2o ™ 2z [~ zn2
Filter Frequency )l 1500 = KHz
JkHz 10MHz
Number of Samples ; /JI 35 ::I
- i
. 7
Counter1 Il:guntglzl
Type: | Totalizer -
| J Input1 Input2
Mode |Internal Ll |Intemal Clock 10 MHz LI | -
Disable Function; |Pisabled ¥| e > Polarity:  |High level hd
Latch Function; |Disabled b I > Polarity:  |High level -
Preload Function:  |Disabled v e > Polarity:  |High level vl
Clear Function: |Disabled w| s Polarity: - |High level v|
Marker: = I S—— = |
Match: | Disable v
ok | concel |

Input signal is filtered based on the filter frequency and Number of samples selected. User has to select Filter Frequency and
Number of samples based on the frequency of the Input signal.

Filter Frequency: To set the filter, choose a value that is: 4*Number of Samples*Expected Max Hz on the high-speed inputs.
Number of samples: The input must be stable for this many samples before the HSC accumulator is affected by any change.
The state (high or low) of the high-speed input is sampled with every rising input edge of the filter frequency. The rising edges of
the filter frequency are totaled in a sample counter, and when that total equals the number of samples configured, the sample
counter is reset. If the high-speed input state did not change by the time of the sample counter reset, that state, high or low, is

passed on to the high-speed accumulator. If the high-speed input state changes during the sample counting, the sample counter
is reset to zero and the process starts over.
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Figure 1: Input Signal

ARV AARANAAARARARANAA

Figure 2: Filter Frequency: Example IMHz

Number of samples: 4
HG-012

If user selects filter frequency as 1MHz and Number of samples as 4, then Input signal is sampled for 4 samples and if the signal
is stable for 4 samples i.e. 4us then the signal is passed to Accumulator.

If the Input state is changed in between the sampling counts, then the count is reset, and the Input state is again checked for
given number of samples.

Refer to Dotted lines in the Figure 2, after 2 samples the state of input signal changes to 1, so the counter is again started to
count 4 samples, to pass the signal to accumulator.

There will be a delay in passing the input signal to accumulator since we are filtering the Input signal and the delay is based on
the selected filter frequency and Number of samples. In the above example filter frequency is 1MHz (1us) and number of
samples: 4, so the minimum delay in input signal will be 4ps.

Figure 3: Input signal before filtering

Figure 4: Input signal after filtering

HG013

This delay will be 4ps.
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All Canvas 7D OCS models provide two independent serial ports, on the first 8-pin modular jack, which is labeled MJ1/MJ2. The
MJ1 serial port is RS-232 while the MJ2 port is RS-485. By default, MJ1 can be connected to the COM port of a PC running
Cscape, for OCS programming. In addition, both MJ1 and MJ2 can be used for application-specific communication, using a
variety of standard data exchange protocols.

The second 8-pin modular jack, which is labeled MJ3, provides a multiplexed serial port, which can be configured for either RS-
232 or RS-485. MJ3 can be optionally set for OCS programming via the System Menu for connection to the COM port of a PC
running Cscape.

10.1:

The MJ1

Port Descriptions

serial port contains an RS-232 interface with RTS/CTS handshaking. The MJ2 serial port contains a half-duplex RS-

485 interface with no handshaking. The MJ3 serial port can be configured as either RS-232 or RS-485. The MJ2 and MJ3 RS-
485 interfaces provide switchable termination and bias resistors internally, which can be enabled/disabled with DIP switches.

10.2: Wiring
MJ1/2 Serial Ports
PIN | SIGNAL | DIRECTION | SIGNAL | DIRECTION
TXD ouT - -
RXD IN - -
ov COMMON ov COMMON
MJ1: RS-232 w/Full Handshakin
sz: R§-425 H;I:Du:Ieis e 5 ;%\r/n% out ;550\;1% out
4 RTS ouT - -
3 CTS IN - -
HG-008 2 -- -- RX-/TX- IN/OUT
1 - -- RX+/TX+ IN/OUT
NOTE: Attach optional ferrite core with a minimum of two turns of serial cable.

MJ3 Serial Ports
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HG-008

MJ1: RS-232 w/Full Handshaking
MJ2: RS-485 Half-Duplex

MJ3 Pins

PIN SIGNAL DIRECTION

8 TXD RS-232 ouT

7 RXD RS-232 IN

6 ov GROUND
5 +5V @ 60mA ouT

4 TX-RS-485 ouT

3 TX+ RS-485 ouT

2 RX- RS-485 IN

1 RX+ RS-485 IN

Page 120 of 209




I.I HORNER

AUTOMATION GROUP

Chapter 10: Serial Communications

10.3: DIP Switches

The DIP switches are used to provide a built-in termination to both the MJ1, MJ2 & MJ3 ports if needed. The termination for
these ports should only be used if this deviced is located at either end of the multidrop/daisy-chained RS-485 network.

D SWITCH NAME FUNCTION DEFAULT
1 MJ3 RS-485 Termination ON = Terminated OFF
B 1 e [oom=
HG-E52 4 MJ2 RS-485 Termination ON = Terminated OFF

10.4: RS-485 Termination

Proper RS-485 termination minimizes signal reflections and improves reliability.
Both the MJ2 and MJ3 serial ports allow an internal termination resistor to be placed across Pins 1 and 2 by DIP Switch Setting.

Only the two devices physically located at the endpoints of the RS-485 network should be terminated.

10.5: RS-485 Biasing

RS-485 biasing passively asserts a line-idle state when no device is actively transmitting, which is useful for multi-drop RS-485
networking.

Both the MJ2 and MJ3 serial ports allow internal bias resistors to be switched in, pulling pin 1 up to 3.3V and pulling pin 2 down to
ground. The Set Serial Ports item in the System Menu can be used to enable RS-485 biasing. Also, an application graphics
screen that writes to %SR164 can do the same thing. Setting %SR164.1 enables MJ2 biasing and setting %SR164.2 enables
MJ3 biasing.

If biasing is used, it should be enabled in only one of the devices attached to the RS-485 network.
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10.6: Cscape Programming via Serial Port

The Canvas 7D OCS MJ1 and MJ3 serial ports support CsCAN Programming Protocol. If a PC COM port is connected to the
Canvas 7D OCS MJ1 or MJ3 serial port, Cscape can access the Canvas 7D OCS for programming and monitoring.
Programming can also be done via the CAN port, USB A port, or Ethernet.

10.7: Ladder-Controlled Serial Communication

Using Serial Communication function blocks, MJ1, MJ2 and MJ3 serial ports support Generic Modbus Master and Modbus Slave
Protocols. In addition, external modems can be connected and accessed using Init and Dial and Answer Modem function blocks.

10.8: Configuration via Mini-B USB

NOTE: The unit must be connected via the mini-USB port to the PC or laptop.

Itis possible to load the program and monitor data via the Mini-B USB. To load via Mini-B USB, configure the communications
port in Cscape as follows:

Select Tools from the toolbar > Application Settings > Communications > USB button
Itis possible to download or upload and use the data monitoring functions once connected.

NOTE: Itis advisable to use an isolated USB cable between the PC or laptop and the Canvas 7D when third party devices are
connected to theCanvas 7D to avoid damage to the PC or laptop and/or the Canvas 7D.
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111 Port DesCriptiON 124
11,2 CAN POt Wiring .o 124
11.3: Cscape Programming via CAN .. 125
11.4: Ladder-Controlled CAN Communication ... .. 125
11.5: Using CAN for 1/0 Expansion (Network 1/O) ... ... 125

NOTE: For additional CAN information, refer to the CAN Networks manual, MAN0799 (MAN0799) using Horner's
Documentation Search page.

OCS models provide a CAN network port, which is implemented with 5-pin connectors. The CAN port allows the OCS to
exchange global data with other OCS controllers and to access remote Network 1/0 devices (SmartStix, Smart Blocks and Smart
Rail Modules). The port also supports pass-through communications for programming multiple OCS controllers over the CsCAN
network. Also, the CAN port supports CsCAN, CANopen, J1939, and DeviceNet Master (layer 3 as a selectable option).

11.1: Port Description

The OCS CAN ports implement the ISO 11898-2 physical layer and the CAN 2.0A data link layer standards. Also, since the CAN
ports are powered by an internal isolated power supply, external CAN power is not required.

NOTE: The CAN port does not supply power to the network.

11.2: CAN Port Wiring

Use the CAN Connector when using CsCAN or other CAN network. Torque rating: 4.5 - 7 inelbs (0.50 - 0.78 N*m)

CAN Network & Power Port Pin Assignment

Signal Signal Description
V- CAN and Device Ground - Black
CN_L CAN Data Low - Blue
SHLD Shield Ground - None
CN_H CAN Data High - White
V+ Only used for Remote I/O. Not required for local device power.
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11.3: Cscape Programming via CAN

The CAN port supports CsCAN Programming Protocol. If a PC has a CAN interface installed (via PCl card or USB), and the PC
CAN port is connected to the OCS CAN port, Cscape can access the OCS for programming and monitoring.

In addition, the OCS supports single-point-programming of all OCS devices that are connected to the CAN port network. If the
PC COM port is connected to the OCS MJ1 serial port, the OCS can act as a pass-through gateway allowing Cscape to access
all OCS devices that are attached to the CAN port network.

11.4: Ladder-Controlled CAN Communication

Using Put and Get Network Words function blocks, the CAN1 port can exchange digital and analog global data with other
devices (nodes) attached to the CAN network.

In addition, Put and Get Network Heartbeat function blocks allow nodes on the CAN network to regularly announce their
presence and to detect the presence (or absence) of other nodes on the network.

11.5: Using CAN for I/0 Expansion (Network 1/O)

Connecting network I/O devices (SmartStix, SmartBlock, SmartMod, or SmartRail) to the OCS CAN1 port allows the OCS-I/O to
be economically expanded and distributed. A variety of modules are available for this purpose.
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12.1: Ethernet Module Protocols and Features ... ... ... .. . . . . 127
12.2: Ethernet Module Specifications ... ... .. .. 127
12.3: Ethernet Module Configuration ... ... ... 128
12.4: Ethernet Configuration — IP Parameters ... ... ... . ... . 131
12.5: Ethernet Module Protocol Configuration ... ... . ... . 131

12.1: Ethernet Module Protocols and Features

The Canvas 7D controller supports the following:

—_

Downloadable Protocols: Modbus Client

ETN300 Protocols: ICMP (Ping), EGD, Modbus Slave, Ethernet I/P, FTP, ASCII over TCP/IP

2
3.  Supports a maximum of 4 WebMI simultaneous connections
4

Ethernet SmartRail

The following table describes the Ethernet Module Protocols and features supported by the Ethernet port on the Canvas 7D.

Protocol / Feature

Protocol / Feature Description

ICMP (Ping) Internet Control Message Protocol

EGD Ethernet Global Data

SRTP Slave (90-30 Service Request) Service Request Transfer Protocol

CsCAN TCP Server Horner APG CsCAN over Ethernet (for Cscape to OCS programming)
Modbus Slave Modbus over Ethernet

Ethernet/ IP

ODVA CIP over Ethernet

FTP (File Server)

File Transfer Protocol

ASClI over TCP/IP

ASCII Data over Ethernet

NTP Protocol

Network Time Protocol (Obtain clock from web-based server)

12.2: Ethernet Module Specifications

Speeds

10 BaseT Ethernet (10Mbps) 100 BaseTx Fast Ethernet (100Mbps)

Modes

Half or Full Duplex

Auto-Negotiation

Both 10/100Mbps and Half/Full Duplex

Connector Type

Shielded RJ-45

Cable Type (Recommended)

CATS5 (or better) UTP

Port

Auto MDI/MDI-X (Auto Crossover)
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12.3: Ethernet Module Configuration

NOTE: The following configuration is required for all applications regardless of the protocols used. Additional configuration
procedures must be performed for each protocol used.

To configure the Ethernet Module, use Cscape Programming Software to perform the following steps:

1. Onthe main Cscape screen, select the Controller menu and its Hardware Configuration sub-menu to open the
Hardware Configuration dialog.

2. If configuring a different OCS Model than the one shown in the Hardware Configuration dialog, click on the topmost
Config button, select the desired OCS Model, and then click OK.

Hardware Configuration X

Controller | Local L0 | CANT (CsCAN) VO | CAN2 (CsCAN) 10 | LaNT 1O | LaNZ 10 |

Series [Canvas OCS Series -] - Description:
c.t:;as Touch screen Operator Control Station with
Device Type ‘Can\ras 70 ﬂ k fixed /0
Model #  [HE-CV-0700-02 o] [ Froperies
i 3 480 by 800 LCD
Network Ports Display Type: | by
CANT m Config Keypad Type: |5fundion keys
Program M; ¢ (2048 K
CAN2 [CsCAN 7] _Config m Memory: (2048 K Bes

Network Type: |C5CAN

ETN300

0 z] [t | 5
Advanced Functions

LANZ [ETNID0 +| Config Supports Analog Data

Real Time Clock Support

Supports Retentive Data
Serial Ports Config |

OCS Wi-F Module Config

3. Click the Config button to the right of the LAN1 for LAN 1 or LAN2 for LAN 2, revealing the Ethernet Module
Configuration dialog.
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LAN1 Canfiguration >(

Conliguration Detal

™ Use DHCP

Shatic: Configuation Dipnamic coriliguralion Gt sellings fom
IPAddresz: [ 192 168, 254 . 128 Mt W [charc Configuration = | [ Uoe CAM 1D for last Octet
NetMask: [ 265 265 285 0 Name: 8 [Ghahc Conguration = |

W [Shtc Conliguration  w |
o IStan Canfiguration j

(L2} |

ONSServer: [0 0 0 . 0 Mame: |

Shabus Mame: |

I
I
Gaeway [ 0 . 0. 0.0 [ Harme: |
I
I
Varsion: |

Loflafled Lafladle

| Marme; | S50, |

Protocol Suppost
Flesiderit Protocols

C]ICMP Fing) Configure Selected Protocal
[C] EGD (Ethernet Global Data)

] SRTP Slawe (30-30 Service Request)

[ Medbuws TCP/UDP Server

[] Ethemet IP 170 Adapter (UDP)

[C] FTP (File Server)

] ASCH TCR/IP Server

[CINTP PretacaliObtain clock from web based server)

Downloadable Protoccls
ETH1/1 [~ Nene - =] | I | |
ETH1/2 [+ Pane - 3 I I I I

0K | Cancel

4. Configure the Ethernet Module parameters as follows:
IP Address: Enter the static IP Address for the Ethernet Module being configured.

NOTE: IP Addresses are entered as four numbers, each ranging from 0 to 255. These four numbers are called octets, and they
are always separated by decimal points.

Net Mask: Enter the Net Mask (sometimes called Subnet Mask) being used by all nodes on the local network. Typical local
networks use Class C IP Addresses, in which case the low octet (rightmost number) is used to uniquely identify each node on the
local network. In this case, the default Net Mask value of 255.255.255.0 should be used.

Gateway: Enter the IP Address of a Gateway Server on the local network that allows for communication outside of the local
network. To prevent the Ethernet Module from communicating outside the local network, set the Default Gateway IP Address to
0.0.0.0 (the default setting).

Status Register: Enter an OCS Register reference (such as %R100) to indicate which 16-bit OCS register will have the
Ethernet Status word written to it. The table shows how this register value is formatted and explains the meaning of each bit in
the Status Word.
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Ethernet Status Word Register Format
High Byte Low Byte
Bit 16| Bit 15| Bit 14| Bit 13| Bit 12| Bit 11| Bit 10| Bit9 | Bit8| Bit 7| Bit6| Bit5| Bit4 | Bit3 | Bit2 | Bit1
0 0 Dup | Spd 0 Rx Tx | Link TCP Connections
. L Status Values
Status Bit Status Indication — -
Minimum | Maximum
0 Reserved Always 0
Dup Link Duplex (Auto-Negotiated) 0 = Half Duplex ;:pﬁ:)l(l
Spd Link Speed (Auto-Negotiated) 0=10Mbps | 1=100 Mbps
Rx Receive State 0 = Inactive 1= Active
Tx Transmit State 0 = Inactive 1= Active
Link Link State 0 =Down 1=Up
Total Number of Active TCP Connections
TCP Connections (CsCAN, SRTP, Modbus, Ethernet IP, 0 40
FTP, HTTP)

Version Register: Enter an OCS Register reference (such as %R101) to indicate which 16-bit OCS register will have the
Ethernet Firmware Version written to it. The value stored in the Version Register is (Ethernet Firmware Version * 100). For
example, for Ethernet Firmware Version 4.30, the Version register will contain 430.

Get Setting From: “Get settings from” allows the programmer to either configure the IP Address, Net Mask, or Gateway for two
functions: Configuration or Register.

Configuration: The configuration for the IP Address, Net Mask, or the Gateway will be assigned using the value in the Default
Settings in this window.

Register: The configuration for the IP Address, Net Mask, or the Gateway will be assigned using the values in the registers
assigned.

NOTE: The low octet of the IP Address can be replaced with the unit's CAN Network ID, by checking the Use CAN ID for last
Octet checkbox.
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12.4: Ethernet Configuration — IP Parameters

For primary operation, the IP address, Net Mask, and Gateway should be set in the LAN config of the Cscape Hardware
Configuration. There are options to get IP parameters from the LAN Config or to get parameters from registers. It is possible to
set the Ethernet IP parameters from the OCS System Menu, but only as a temporary measure. The following points on IP
parameter configuration should be considered.

IP Parameters in Non-Volatile RAM: The IP parameters of the Cscape LAN Config are written to non-volatile RAM on power
down. IP parameter settings made in the System Menu are not written to non-volatile RAM. Any IP parameters settings made in
the System Menu will be lost after cycling power to the unit. It will revert to the last downloaded Cscape LAN Config that was
loaded into non-volatile RAM at power down.

“Cscape LAN Config”/ “Get Settings from” Configuration: When ‘Get settings from'’ is set to Configuration, the IP
parameters specified under ‘Default Settings’ is used after downloading to the controller. The IP parameters are represented in
System Menu / Set Networks and can be edited. However, any edits made from System Menu / Set Networks is not retained
through a power cycle. After power cycle, the unit reverts to the last downloaded Cscape LAN Config that was loaded into non-
volatile RAM at power down.

“Cscape LAN Config” / “Get Settings from” Register: When ‘Get settings from' is set to Register, the IP parameters are
retrieved from the OCS registers assigned in LAN Config. Configured registers must be populated with the desired IP
parameters:

B The IP parameters are represented in System Menu / Set Networks.
B The IP parameters cannot be edited from System Menu / Set Networks while the unit is in run mode.

®  The IP parameters always follow the values in the registers unless the OCS unit is placed in idle mode. Then the IP
parameters can be edited in System Menu / Set Networks. When the OCS is placed back into run mode, it reverts to
the registers for IP parameters.

12.5: Ethernet Module Protocol Configuration

The Protocol Support area contains a list of all the protocols supported by the platform being configured. To activate a protocol,
check its checkbox.

For protocols that require additional configuration, click on a listed protocol to select it and then click the Configure Selected
Protocol button. This will open a new dialog with configuration options for the selected protocol.

For detailed information on individual protocol configuration, refer to latest version of the Ethernet Manual, SUP0740.
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30 OV IV W 133
13.2: Protocol Device Driver Selection ... ... ... . 133
13.3: Network Configuration .. . 135
13.4: Device List and Device Configuration ... ... ... . 136
13.5: Scan List 138

13.1: Overview

Through loadable protocol device drivers, certain models of the OCS family can provide the ability to exchange data with remote
devices such as variable-frequency drives, PLCs and remote 1/O devices. This feature greatly expands the OCS’s control
capability with negligible effect on the OCS ’s ladder scan time.

Remote devices that communicate serially must do so under certain rules of data transfer known as a protocol. Many device
manufactures have created their own protocol for communications with their device. For a OCS to communicate with a specific
device, it must be loaded with the corresponding serial communications protocol device driver that supports that protocol.

A limited number of protocol device drivers are packaged with the Cscape distribution; however, as more are developed, they
will be made available as add-on packages. A device driver is typically distributed as a Windows module, which contains the
configuration menus, help files and the target executable driver code. When updating device drivers, an install routine loads the
device driver to the Cscape directory structure and makes that driver available to Cscape applications.

Once installed, the protocol device driver can be included as part of a Cscape application by selecting it from a list of installed
protocol device drivers and attaching it to the desired serial port (Home > Protocols). Only one protocol device driver can be
associated with a serial port, though some OCS models support multiple protocols on a single Ethernet port.

Once the protocol is selected for a specific port, that port must be configured to match the bit transfer size and rate of the target
device(s). This is configured under the Network Config menu, which contains port specific information such as the basic serial
port parameters (i.e. baud rate, stop bits parity, retries, etc.). In addition to the serial port parameters, this menu also contains the
transaction scan update control configuration and any network level protocol specific configuration.

Once the network is configured, each device on the serial communications network must be configured. For some
communications (i.e. RS-232), the network can be limited to one device. The devices are configured under the Device Config
menu, which contains an arbitrary device name, the device ID and optionally a OCS status register that contains any device fault
information.

Once each device(s) is configured, a Scan List of entries must be created which defines the transfer of data between a local
(OCS ) register(s) and a remote device register(s). These entries are created under the Data Mapping menu, which contains a
OCS register, a target device ID, a target device register address, the number of registers to transfer, and update type.

Each entry can be configured for one of two types of initiating a transaction: Polled and Triggered. Polled type entries initiate a
transaction with the remote device on every transaction scan. Triggered type entries only initiate a transaction when a
corresponding local (OCS ) binary trigger register is set. Once a triggered type transaction completes, the protocol device driver
resets the local (OCS ) binary register to indicate completion.

These basic types are also subdivided into read or write operations. For polled operations, a Read operation only reads from a
remote device. Likewise a Read/Write operation continuously reads from the remote device unless the target OCS register value
changes from one ladder scan to another. In this case, the new OCS value is written to the target device. For triggered
operations, only a read or write action is available.

When downloaded to the OCS , the Scan List is scanned sequentially to generate data transactions with the remote device. This
transaction scanning can be on a continual basis (automatic) or controlled from ladder logic (manual) once a complex
connection is created via a program. The specific transaction-scanning mode is selected from the Network Config menu.

Please refer to the Cscape Help file for more information on Downloadable Protocols Configuration.

13.2: Protocol Device Driver Selection

From the Cscape Home > Protocols menu, select the port drop-down box to select a protocol device driver. All protocol device
drivers currently loaded in Cscape are displayed in the drop down selection along with their version numbers. A selected
protocol can be removed by selecting None from the drop-down selection. Some OCS models can be limited in the number of
ports or number of protocol device drivers that can be selected. Once a protocol is selected, the Network, Devices and Data

Page 133 of 209



II HORNER

AUTOMATION GROUP

Chapter 13: Protocol Configuration

(Scan List) must be configured through corresponding dialogues accessible through the respective buttons (Network, Devices
and Scan List).

Protocol Configuration X
Serial Protocols
(AL Iz Bradley DFT v 4.00 | Network | Devices | Scan List | Display |
Allen Bradley DF1 v 4.00 ~
MJZ2 | Animatics Smarthotor Protocol v 4,00 Metworl | Devices | Scan List | Displa_l,lf'«'&..:':'el
BACHetMSTP server v 5.04 .
COM E[ﬁg%lmﬂ; :?1%00 Metworl | Devices | Scan List | Display./y alid ':'il
GE SMP [Senes 90 Protocal] v 4.06 b
M3 [ Taone | Wetwork | Device | & can List | Display/validate |
Swap Serial Port Settings |
— Ethemet
ETN1A | Maone - LI Metwork | Devices | Scan Lis | |
ETN1/2 [~None - =] Metwork | Devices | s | |
ETN2/1 |- Nene - ~| Network | Devi | | Display/yalid |
ETNZ/2 I None - ﬂ RE | Devices | Scan List | Display/a :i'fl
-Fil | Mone - ;I MHetwork | Devices | Scan List | Diizplaypali |
fi-Fi2 | Mane - ;I MNetwor | Device | Scan List | Display/falidate |

ok | Cancel |

NOTE: If the MJ1 port is to be used in the Protocol Config, it will no longer be available for Cscape programming unless the
controller is put into IDLE mode.

Three fields must be configured after a protocol is selected:
1. Network
2. Devices
3. Scan List
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13.3: Network Configuration

Metwark Config (Modbus Master) t ‘

Pett Conliguration
N Piotocct [Modbuz RTU_+]
Party. [None =] Mode: [Rs.232 *
DataBis: [g -] Reies: 2 (0:258)

SwopBits 1 Teeout [10000  mSec
Handshake: [Hone - SlaveSpeed [Fan |
~ Update Scan
= Automstic
Update [rderyst ||:|7m5ec RescquiaTene: W S es
' Marusal
Tigger. | Name: | -] -
1D Sedeck I N | ;I 180T
~ Master ID / Address
Addeess: h
~ Status
Hegi:ier:| Nm;' j A4y e

Protocal Hep | ok | Concel

Network Configuration provides the required parameters to configure the network. Each protocol is different and may not require
the entire Network Config field. Please refer to the table below for the options in the Network Config field.

Network Protocols

Baud Rate, Data
Bits, Stop Bits, These field define the bit level transfer over the serial port.
Parity
None — No handshake lines are used
Multidrop Full — Rx remains active while Tx is occurring.
Handshake u! p Fu x_ i IV.WI. X i _U|g
Multidrop Half — Rx is shut off while Tx is occurring.
Radio Modem — Wait for CTS acknowledgment before transmitting (legacy radio modem support).
Protocol If a driver supports multiple protocols, it is selected here, (i.e. Modbus supports RTU or ANSI).
Mode Specifies if port operates in RS-232 or RS-485 mode.
Retries Specifies number of times a transaction is retried on a failed response.
Timeout Specifies the amount of time for a device to wait for a valid response.
Update Interval — Specifies the update interval at which all the mapped
entries are executed.
Automatic — - - -
Reacquire Time — Specifies the amount of time to wait before attempting
Update Scan N . . .
communications with an offline device.
Trigger — Specifies the binary register that a single transaction scan of the
Manual .

Scan List.
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Network Protocols

ID Select — If an analog is specified in the field, the ID Select filter is
enabled.

Specifies the starting OCS register of eight (8) consecutive registers (4-32bit counters), which provide

Sl [z E ey an indication of the network health.

Scanner Address |Specifies the OCS’s device (network) ID if a master ID is required by the protocol.

Protocol Help Provides protocol specific help.

13.4: Device List and Device Configuration
13.4.1: Device List

€ B! Device List (Modbus Master) =t

| Hame [ o | Sestu | O Beree

el

This configuration list is reached from the Device button on the Protocol Config screen and provides a list of the configured
devices on the Network. Devices must be created and exist in this list before corresponding Scan List entries can be created for
this device. Typically, the number of entries is limited to 64 devices.

¢ Add - Opens the Device Config dialog to add a new device to the list.
¢ Delete - Remove selected device from list (all corresponding Scan List entries are also removed).

¢ Config - Invoke the Device Config dialog for the currently selected device. This can also be accomplished
by double-clicking a device entry.

¢ Mapping - Invoke the Scan List limiting the entries displayed for the selected device.
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13.4.2: Device Configuration
. Dialog x ;

! Dievvice |

Hame |

I 1 [5kave Addms]
Devico Options

™ Swap vds on 3204 dala
™ Tapet rshans 324 on single regisher raquest

Davicn Type: [Modicon PLC S-0igt Addressing -

Mode: |E'='\-1ce Supports all modbus weke function codes = |
Disable Device
Regaer | Mosrs: | -] -
Status
[7 Enstls
| r
| Suddeess _l ]
| |
(o fea |
Ok Cancyl

HG122
This configuration is reached from the device list when adding or modifying an existing device. While each protocol is somewhat
different and can contain protocol specific field, all protocols typically support at least:
* Device Name - Specifies a tag name for this device. This tag name is used in the Data Mapping
configuration to identify this device. This allows device addresses to be modified without the need to
update all associated Data Mapping entries.

¢ Device ID - Specifies the target device communications ID or station address.

¢ Swap Words on 32-bit Data - If a Scan List entry is configured to transfer 32-bits and this option is
checked, the high and low 16-bit values are swapped when transferred between the target and OCS.

* Disable Device - From Cscape 9.90 SP3 and firmware 15.40 onwards, disable device feature has been
added in protocol device configuration. This option is used to disable a particular slave configured in the
network. Single bit register has to be configured to use this function. Setting the bit high disables the slave
and OCS will not send any serial (TCP for ethernet protocols) packets only to this slave until the bit is high.
Setting the bit low enables the communication with the slave again.

e Status Enable - This checkbox enables device status to be displayed and controlled from two consecutive
16-bit registers.

e Status Address - Enter the starting 16-bit OCS register of two consecutive registers used for device
status. The first register contains the protocol device driver specific error code while the second register
contains the index of the offending Scan List entry.

¢ Status Modes:

a. Stop on Error - Specifies that communications be only reattempted after offline status when the
corresponding device status register is cleared.

b. Retry on Error - Specifies that communications be reattempted either during the reacquire
interval or when the corresponding device status register is cleared.
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13.5: Scan List

B Sean List Modbus Mastes)

Edt  View  Sort

Iredes | Lol Mana | Regater | Twpe [ DevMame |10 | Taget | Length |

Echt Mlaserees

U

Filter By Dianaca: IN 3

T

'''''

This configuration list is reached from the Scan List button on the Protocol Config screen or the Mapping button on the Device
List screen and provides a Scan List of the Data Mapping entries. To transfer data between the OCS and remote target, a Scan
List must be created that defines each transaction. Each mapping entry (transaction) contains the source and destination

registers, the number of consecutive registers transferred, the direction of the transfer and what triggers the transfer. Typically,
the number of entries is limited to 512.

NOTE: The order of the Scan List is the order in which the transactions occur. Sort functions are provided to change

the order of the list. Each entry also has an identifying index. If the device status register is enabled and a transaction failure
occurs, the status register indicates the index number of the transaction that failed.
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13.5.1: Menu

Edit > Copy All - Copies Scan List to clipboard in a tab delimited format suitable for pasting into an
application like Microsoft Excel.

Edit > Paste - Loads Scan List from clipboard. Pasted items are added to the scan list even if they are
duplicates.
View > Toggle All Name View - Expands Scan List such that each point and corresponding local name is
displayed.
Sort Scan List by different criteria. The firmware will scan the devices based on the order they are
displayed or sorted. There are four ways to sort the scan list:

a. By Local Address — Sorts the list by local register address in increasing order.

b. By Target Address — Sorts the list by target register address in increasing order.
c. By Device Name — Sorts by device name, then target address.
d

Interleave Devices — This sort evenly distributes request among the different devices. Instead of
requesting 100 blocks from device A, then 100 blocks from device B, one requests is sent to
device A, then one request is sent to device B until all the data has been requested. This is useful
for devices that may have a timeout timer because the time between each scan for a particular
device is minimized. This sorting options usually doesn’t affect performance.

13.5.2: Buttons

Add - Opens the Data Mapping dialog to add a new entry to the Scan List.
Delete - Removes selected entry from Scan List

Config - Opens the Data Mapping dialog for the currently selected entry. This can also be accomplished by
double-clicking an entry.

Edit Names - Invokes the Edit Names dialog for the currently selected entry. The Edit Names dialog
provides the ability to create OCS program names for each point in the transaction.

13.5.3: Display Control

Filter by Device - Limits displayed entries to only those assigned to the indicated device. To show all entries select —All--.
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: Data Mapping Configuration (Scan List Entry)

I Dialeg *

Target

Diennce Hame |!=-:I m ﬂ
Dievice Registes| | I 2t .access
Length |1

Local
Riegittar | Mare: | -

UpdataType
i+ Polled Read ™ Tiiggerad Raad
™ Polled ReadMwiile I Triggered Wite

" Polled Readsw/ile Init

Trigger Flegister | Name: | =l

Cancel |

Device Name - Selects the target device (by tag name) to use for this transaction. Only those device
entries previously created from the Device Config menu are available.

Device Register - Specifies the target device’s register to use for this transaction. This designation is
target-specific. The configuration menu displays an error if a specified address is unacceptable. Generally,
the data type of the local (OCS ) register must match the data type of the device register.

The Right Arrow button - Displays protocol device driver specific help for the target addressing. Note that
some devices can require register addresses that exist on 8-bit, 16-bit or 32-bit boundaries.

Local Register - Specifies the local (OCS ) register that is the source or destination for the transaction.

Local Name [Optional] - Optionally allows selection of a OCS register by name <or> creation of a name
for a register already selected by direct reference. Created names can be used thereafter to specify the
local (OCS ) register in ladder or graphics address fields.

32-Bit Access - Allows two local (OCS ) 16-bit registers to be treated as a single 32-bit value. For
example, if the value in either 16-bit register is modified, both registers are written to the device. Device-
specific, 32-bit word swapping options also apply to this designation. Since the transaction is treated as a
32-bit access, the length is generally limited to 16. Note that some protocols can disable this feature.
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Specifies the number of consecutive device registers that are transferred in this transaction. Note
that some protocols can limit the length that can be transferred. However, typically the length is
limited to 32. The configuration menu displays an error if a specified length is unacceptable.

If allowed, specifying a length greater than one (multiple consecutive register transfers
per transaction) is more efficient than creating a single transaction for each register. This
grouping of registers per transaction can significantly reduce the transaction scan time; however,
update types that include writing on a polled basis require additional consideration.

On Read/Write and Read/Write/Init update types, the write transaction only occurs when the
local (OCS ) register value changes. If the length is greater than 1 for Read/Write and
Read/Write/Init types, only the local register(s) that change in value are written. More specifically,
only one write transaction occurs per scan per mapping entry for the register or consecutive sub-
group of local registers that changed in value. Depending on the protocol, the number of points
written with that write transaction are limited either to one or the number of consecutive points that
changed value.

Therefore, if several local registers (specified in a single mapping entry) change in value
prior to a transaction scan, it takes SEVERAL transaction scans to complete all the write
operations. Furthermore, all write operations are completed before a read operation is
scheduled.

For Manual Update (transaction) scans (i.e. dialup modem), it is recommended that all
Read/Write Scan List entry lengths be limited to 1.

This field specifies the direction and what triggers the transfer of data between the OCS and target device for a mapping entry.
¢ Polled Read - On every transaction scan, a read-only target device register(s) transaction occurs.

« Polled Read/Write

a.

On every transaction scan, a read target device register transaction occurs unless a local register
value has changed. The write transaction only updates those local registers that have changed in
value. If several non-consecutive local registers (contained in a single mapping entry) change
value between transaction scans, it takes several consecutive transaction scans to write each
changed register.

When the OCS is placed in RUN mode, the initial action for this mapping type is a read
target register transaction. This transaction initializes the local (OCS ) register(s) to match that
of the remote device register(s). Thereafter, any change to the corresponding OCS register(s)
triggers a write operation to the remote device.

Page 141 of 209



§ HORNER

AUTOMATION GROUP
Chapter 13: Protocol Configuration

Polled Read/Write/Init
a. Onevery transaction scan, a read target device register transaction occurs unless a local register
value has changed. The write transaction only updates those local registers that have changed in
value. If several non-consecutive local registers (contained in a single mapping entry) change
value between transaction scans, it takes several consecutive scans to write each changed
register.

b. On every transaction scan, a read target device register transaction occurs unless a local register
value has changed. The write transaction only updates those local registers that have changed in
value. If several non-consecutive local registers (contained in a single mapping entry) change
value between transaction scans, it takes several consecutive scans to write each changed
register.

c. Whenthe OCS is placed in RUN mode, the initial action for this mapping type is a write
target register transaction. This transaction initializes the target device register(s) to match that
of the local (OCS ) register(s). Thereafter, any change to the corresponding OCS register(s)
triggers a write operation to the remote device.

d. Theinitial write transaction does not occur until after the first logic scan of the OCS . This allows
registers to be initialized locally before Writing to the target device register(s).

Triggered Read - A read transaction is triggered by a high level on a separately designated OCS (binary)
trigger register. Once the read transaction is complete (or the device is offline), the OCS trigger register is
cleared by the OCS . This update type can be used for occasional data accesses such as retrieving trend
data. Note that this operation increases the associated transaction scan time and can cause the Update
Interval Exceeded Counter to increment on a tightly adjusted update interval.

Triggered Write - A write transaction is triggered by a high level on a separately designated OCS (binary)
trigger register. Once the write transaction is complete (or the device is offline) the OCS trigger register is
cleared by OCS . This function can be used for occasional data accesses such as sending recipe data.
Note that this operation increases the associated transaction scan time and can cause the Update Interval
Time Exceeded Counter to increment on a tightly adjusted update interval.
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This chapter presents the user interface (or operator view) of the Canvas 7D and some of the model specific characteristics of
the Canvas 7D as compared to the rest of the OCS line. This chapter does NOT cover building screens or using the Cscape
graphics editor. For instructions on creating screens and using the graphics editor, refer to the graphics editor help file.

14.1: Screen Specifications

Display Type 7" TFT Color

Screen Brightness 800cd/m?2 (nits)

Resolution QVGA (800x480)

Color 16-bit (65,535)

Screen Memory 17MB

User-Programmable Screens 1023

Backlight LED - 50,000-hour life

Brightness Control 0-100% via System Register %SR57
Number of Keys 6
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14.2: Displaying and Entering Data

Control Mode

AutoTun

Process

Calculating

PID START AUTO

TUNE

| - « [

i A L
Ti
—C-L_|IE

Multiple objects are provided for displaying data such as virtual panel lights, push buttons, numeric value displays, bar graphs,
meters, graphs and animated bitmaps. On the Canvas 7D, these graphical objects (through ladder manipulation of attribute bits)
can change color, flash, or change visibility to attract operator attention.

On objects that accept user input, the input is provided by touching the object or alternately changing an OCS register (i.e.
function key registers). Objects that allow input generally have a raised 3D appearance. An exception is the binary type objects,
such as buttons, which are shown in a depressed 3D appearance when in the ON state. Objects that normally accept touch input
may be disabled through program control (through ladder manipulation of an attribute bit). If an object is disabled, the object’s
representation changes to a 2D appearance.

On objects that represent non-discrete information, more action may be required beyond that of simply touching the object. For
example, the slider object requires the operator to touch and slide the control in the direction desired. Alternately, alpha-numeric
entry objects invoke a pop-up alpha-numeric keypad for additional user input. The alpha-numeric keypad is discussed below.

NOTE: If the numeric entry object displays >>>>>>> the value is too big to display in the field or is above the maximum for an
editable field. Likewise, if the numeric entry object displays <<<<<<<in a numeric field, the value is too small to display or is
below the minimum for an editable field.
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14.3: Alpha-Numeric Keypad

To allow entry of a specific number or text, several of the input objects invoke a pop-up alpha-numeric keypad when the object is
touched. An example of the alpha-numeric keypad invoked from a numeric input object is shown below. Once invoked, the
operator may touch the appropriate keys to enter a specific value. When entering a value, the alpha-numeric keypad is in one of
two modes [new-value or edit-valuel].

New-Value Mode - Generally, when the alpha-numeric keypad is first invoked, it is placed in new-value mode. Initially, the
alpha-numeric keypad displays the current value with all the digits being highlighted. Once the first digit is entered, the current
value is erased from the display and the new digit is placed in the first location. Thereafter, no digits are highlighted, and new
digits are added to the rightmost position while the other digits are shifted left.

Edit-Value Mode - Edit-value mode may be entered from the initial new-value mode by pressing either the left or right arrow key
before any digit key is pressed. The result will be a single character highlighted. The user may then either touch a key to change
the digit at the selected position or the up and down arrows may be used to add or sub-tract (respectively) from the selected digit.

0000000000

Once the desired value is entered, pressing the Enter key moves that value into the object (and the corresponding OCS register)
and the alpha-numeric keypad disappears. Alternately, pressing the ESC key any time before the Enter key cancels the
operation, leaves the objects current value unchanged, and the alpha-numeric keypad disappears.

NOTE: Each numeric entry object has a configured minimum and maximum value. If the operator enters a value outside of the
configured range, the new value is ignored when Enter is pressed and the current object value is NOT changed.
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Since the alpha-numeric keypad services several different graphical objects, certain keys on the alpha-numeric keypad may be
disabled (grayed) when the keypad is invoked for certain objects. The following describes the alpha-numeric keypad variation

based on object.

Alpha-Numeric Keypad Variations

Numeric Object

When editing a numeric value, the [+/-] or the [.] key are disabled (grayed) if the objectis NOT
configured for floating-point value or a signed value.

Password Object

When editing a password value, the arrow keys, [+/-], and the [.] keys are disabled. Additionally,
overwrite mode is disabled. When entering digits, the pop-up keypad hides the value by
displaying ** alternately for each digit.

ASCII Object

When editing an ASCII value, an ASCII keypad is displayed. The ASCII keypad has 3 modes:
numeric, symbols and alpha. In Alpha mode, the Caps Lock button may be pressed to access
capital letters. Typing a character will overwrite the entire old string and start a new entry. Press
the backspace arrow to delete the previous character. Pressing Enter will save the entry, pressing
ESC will cancel the edit and return the string to the previous value.

Text Table Object

When editing a Text Table Object, all the keys except the Up and Down arrow keys are grayed
and disabled. The next text selection is made by pressing either the Up or Down arrow.

Time/Date Object

When editing a Time/Date Table Object, all the keys except the Up, Down, Left and Right arrow
keys are grayed and disabled. The specific field (i.e. hour or minutes) is selected using the Left
and Right arrows. The value in the selected field is changed by pressing either the Up or Down
arrow.

14.4: Screen Navigation

To allow the operator to change screens, a Screen Jump Object is generally used. This object may be visually represented as a
3-D button (responding to touch) or remain invisible and logically tied to an OCS register. An optional system ICON may be
configured for display along with the legend, which aids in identifying the object as one that causes a screen change.

Screen Jump Object

grg.

Reactor
Configure Temnper atur e

Seconds
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14.5: Ladder-Based Screen Navigation

Ladder logic can use several techniques to control screen navigation. Coils can be tied to %D registers to make them screen
coils. These coils have two modes: switch and alarm. If the ladder program energizes an alarm display coil, the screen
associated with this coil is displayed and overrides the normal user screens. This is designed to show alarm conditions or to
display other ladder-detected events. When the text coil is de-energized, the previous screen that was being viewed before the
alarm is returned.

The switch display coil switches to the associated screen when it is energized. Once it is de-energized, the screen remains until
it is switched by the user or ladder.

Input_t [] Force Screen: 1
— | —
AT0001 Screen 1
Input_2 [') Switch Screen: 2
— | —
710002

Screen 2

HG-OI5

There is also a system register that can be used to for control-based screen navigation. %SR1 can be read to determine the
current screen or written to change the current screen. Refer to the On-Line help in Cscape for more information on control-
based screen navigation.

14.6: Beeper Acknowledgment

The Canvas 7D contains an internal beeper that provides an audible acknowledgment when an operator touches a graphic
object that accepts touch input. When the graphic object is enabled, a short 5ms tone is emitted. When the graphic object is
disabled, a longer 100ms tone is emitted to announce that the graphical object is not currently accepting the touch input.

If beep acknowledgement is not desired, the beeper function can be disabled from the System Menu.
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14.7: Touch (Slip) Sensitivity

Touch slip sensitivity is preset to meet most applications; however, adjustment is available to reduce the sensitivity for touch
release. That is, once a graphical object (button) is touched and held by a finger, the default touch slip sensitivity allows for a
slight slip of the finger on the graphical object before the Canvas 7D assumes touch been released (equates to approximately a
quarter inch of movement with a stylus).

In some applications (such as jog buttons) where the operator is pushing a button for a period of time, the amount of slip while
holding a button pressed may exceed the default sensitivity. To increase the amount of tolerable slip and prevent false releases
of the button, the Canvas 7D allows adjustment of the allowable slide up to 5x the default value.

To enable the touch (slip) sensitivity, first an OCS data register must be allocated through the Graphics Editor Configuration
menu for Display Settings. Once a Touch Sensitivity register is assigned, that register may be modified [range = 1 (Low) to 5
(High)] to the desired slide amount. If a value outside the valid range is entered in the touch sensitivity register, it is ignored, and
the last valid value is used.

14.8: Alarms

Alarm presentation to the operator is highly configurable and beyond the scope of this document to describe fully. For more
information, refer to the graphics editor help file in CSCAPE. This section presents a typical configuration thereby providing an
introductory description on what the operator should expect.

The alarm object is generally used to enunciate alarms to the operator. While the display characteristics of this object is
configurable, it is generally displayed as a button that changes colors to indicate the highest state of the alarm(s) in the alarm
group it is monitoring. The following indicates the priority of the alarm states and the default colors associated with these states.

Alarms

description
MM/dd HH:mm -ACT -severity

description
MM/dd HH:mm -ACK -severity

description
MM/dd HH:mm -RTN -severity

To view, acknowledge and/or clear alarms, the operator must access the alarm viewer. This is accomplished by touching an
(enabled) alarm object. When accessed, the alarm viewer is displayed as pop-up alarm viewer dialog.
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14.8.1: Alarm Viewer

** Undefined Alarm2 **
RTN: 01/01 00:19** Undefined Alarm2 **

** Undefined Alarm1 **
RTHM: 01/01 00:19** Undefined Alarm1 **

** Undefined Alarm3 **
ALM: 01/01 00:19** Undefined Alarm3 **

The currently selected entry is indicated by a blue highlight which can be moved up or down by directly touching an entry.

The current state of the displayed alarm is indicated by its color and optionally by an abbreviated indicator after the date/time
stamp (ALM, ACK, RTN). The operator can acknowledge an alarm by selecting it from the list and touching the ACK button. The
operator can also clear an alarm if that function is enabled in the alarm object. If not enabled, the Clear buttons are grayed and
do not respond to touch. Once view operations are complete, simply touch the Esc button to remove the pop-up alarm viewer.

NOTE: OCS registers %SR181 and %SR182 are available for ladder use, which indicate presence of unacknowledged or
acknowledged alarm (respectively). The screen designer may implement these registers to switch screens or activate the
beeper to attract the operator’s attention.
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14.9: Removable Media

The Removable Media Object is generally used to inform the operator on the current state of the removable media device and
allow access to its file structure. The Removable Media Object is displayed as a button that changes colors to indicate the
current state of the removable media device. The following indicates the device states and the default colors associated with

these states.

To view and perform file operations, the operator must access the removable viewer. This is accomplished by either touching an
(enabled) removable media object or through the System Menu. When accessed, the removable media viewer is displayed as
pop-up removable media dialog.

NOTE: The Removable Media Object can be configured to open the removable media viewer at a certain directory complete with
restrictions on transversing back up the file path. This may be used to restrict operator access to non-critical files.

SD Card USB Drive
Niﬂi ate modifie : y
[1307-28.BMPbmp 02Apr2024 13:06:58 File 1.15MB
[11307-29.BMP.bmp 02Apr2024 13:07:02 File 1.15MB
[11307-30.BMPbmp 02Apr2024 13:07:04 File 1.15MB
[1307-31.BMPbmp 02Apr2024 13:07:16 File 1.15MB
[11307-32.BMPbmp 02Apr2024 13:07:18 File 1.15MB
[)1307-33.BMPbmp 02Apr2024 13:07:24 File 1.15MB
[1)1307-34.BMP.bmp 02Apr2024 13:07:26 File 1.15MB
[1307-35.BMPbmp 02Apr2024 13:07:26 File 1.15MB
[11307-36.BMPbmp 02Apr2024 13:07:26 File 1.15MB
[711307-37.BMP.bmp 02ApM4 13:07:28 File 1.15MB

02-Apr-2024
Make | Load - =N
o j T E ﬁ A | . 1 s ﬁ 15MB L File 12Fie(s)

In media for switching between the SDcard & USB menu is done by clicking on the SDcard & USB drive button located on the top
of the menu.

The currently selected entry is indicated by a grey highlight which can be moved up or down by directly touching an entry.

File operations are accomplished by pressing the appropriate button at the bottom of the Removable Media Viewer. The
configuration of the removable media object that invokes the Removable Media Viewer defines what buttons are enabled and
available to the user. A button is grayed and does not respond to touch if configured as disabled.
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The <

(Enter) button (if enabled) performs certain operations based on the selected file’s type:

- Change display to parent directory

<DIR> Change display to child directory

bmp, jpeg|| Display bitmap (if compatible format)

pgm Load application (if compatible model and version)

Alternately, the (enter) button can be configured to simply load the ASCII representation of the file path (including the file name)
to a group of OCS registers. That pathname can then be used by ladder for opening and manipulating that file.

Once view operations are complete, simply touch the Esc button to remove the pop-up removable media viewer.

If the removable media is used in an application, the Removable Media Device requires changing by the operator, and the
application is attempting to write to the removable media when it is removed, the screen designer should create objects that
allow the operator to temporarily halt access to the removable media. This prevents corruption to the file system if the removable
media is removed during a file-write sequence. The graphic objects should set OCS register %SR174.1 (when requesting the
card be removed) and provide an indicator based on OCS register %SR174.2 (which indicates that it is safe to remove the

removable media).

Halt RM Activity

Safe for Removal |¥

HL-e4
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14.10: Screen Saver

The Canvas 7D screen backlight life is typically five (5) years when in continuous use. If the application does not require
interaction with the Canvas 7D for long periods of time, the backlight life can be extended by using the screen saver function.
When enabled through the System Menu, the backlight is shut off (screen goes black) after a specified time of no touch activity
on the screen. When the screen saver shuts off the backlight, any operator touch on the screen or function keys reactivates the
backlight.

NOTE: When the screen saver is active (backlight shut off), any initial touch activity on the screen (or function key) to reactivate
the backlight is otherwise ignored by the Canvas 7D. Any additional touch activity is also ignored by the Canvas 7D for
approximately one second thereafter.

It is possible for the application to temporarily disable the screen saver by generating a positive transition to %SR57.16 (coil
only) at a rate faster than the screen saver timeout value. This may be desired while waiting for alarm acknowledgement.

14.11: Screen Brightness

The Canvas 7D provides a feature that allows screen dimming for night operation. To enable this feature, the application must
access and control system register %SR57 (Display Backlight Brightness). Screen brightness is continuously variable by driving
%SR57 through the range of 100 (full bright) to O (full off). It is left to the screen designer on if and how to present a Screen
Brightness control to the user.

NOTE: The backlight life can be extended by dimming or powering off the backlight.
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14.12: Touch Screen Pressure

The Horner Canvas series OCS controllers have a resistive touch screen that allows mechanically detecting touch events. The
resistive touch screen works by measuring the resistance between two layers of conductive film.

PET FILM +——— SPACER DOT
TOP CIRCUIT LAYER — 4 |ITO CONDUCTIVE COATING
[TO CONDUCTIVE COATING — BOTTOM CIRCUIT LAYER

GLASS OR ACRYLIC BACKING PANEL

HG-186

NOTE: Touch creates contact between resistive circuit layers, closing a switch.

With a unique change to the touch monitoring firmware user can measure the pressure being exerted on the touch screen. This
allows the OCS programmer to be notified of the touch pressure and it can configure the pressure required to accept a touch
event.

There are two system registers that provide this touch feature:

B %SR9 (/0 Name - TCH_PRESSURE) - Records the highest-pressure level of the last touch on the screen that
exceeds the threshold value set in %SR10. This is a range of 0 to 3000. Zero (0) indicates no pressure and 3000 is the
maximum amount of pressure that can be measured.

®  %SR10 (/O Name - TCH_PRESSURE_TSH) - This register sets the pressure threshold to indicate a touch. A value of
200 is typically the lightest touch, 600 is moderate and 1000+ is a heavy touch.

These new features allow customizing the feel of the touch screen and can be used to add unique user interface features such
as having different operations depending on the force of the touch.
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15.1: Video ObJeCt OVerVIiOW . 156
15.2: Opening Video Object in CSCape ... ... ... 157
15.3: Video Properties Configuration ... . ... .. 159
15.4: Video Object Performance ... ... ... 161
16.5: Web Cameras ... ... ... . 161

15.1: Video Object Overview

The Video Object feature allows two options for video type: Stream and Playback. The Video Object trigger is used to start, stop,
and pause video, and the System Register provides the status of the video object, which supports various resolutions and
frames per second.

Video Properties X

Video Type
¢ Steam  Enter Channel No

| | 16-BIT

* Playback Ernter Target Path

| | @@ an
Contral
Triager | | & .o
Status | L, 16-BIT
Display Properties

# Variable Aspect Ratio  4x3Aspect Ratio ¢ 16x9 Aspect Ratio Attributess>>

Jump Back Screen

Address / Screen number.

|‘| L| 18T Screen > |

I Simulate ESC
I~ Allow ESC to Retun

ok | Concel |

Specifications of Video Properties

4 channels supported through USB hub

Streaming Channels

1 channel can be viewed at a time

Playback Formats .mp4, .mov, .mpg, .wmv
Variable Aspect Ratio
Resolution 4x3 Aspect Ratio
16x9 Aspect Ratio
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15.2: Opening Video Object in Cscape

1. Open the Screen by selecting under the “User Interface > Main Screen” from the project navigator.
2. In the Project toolbox click on video object.

@) GRLBESEDDOHDH#=NB LOBEBEBEMA & -

Home Edit Logic Editing User Interface Debug Tools My Account Help

|@ Project Nawgatorl@ Program Variables @ Set Target ID :I Hardware Config _'J L
|ﬁ Project Toolbax | Define jow &=l Set Local I QOConned l
g Qutput Window c}? Connection Wizard ib\" Disconnect :ﬂ e \_,
View Controller
T Project Navigator I X Project Toolbox ax |:_| Scre
o . .
5 Project Navigator Fixed Objects
= = u untitled2 [253] [Unknown Mode]* = W
= i :I:,i Hardware Configuration Live Text Data ﬂ
5_:_; B Control |E| Live Graphic Data %
3 E.,' FoicModles @' Lamp/Indicator Bzl
! a% Main Loop Modules o %
. fﬁﬂ main WO Bar Graph ‘g
-a% Subroutine Modules & Meter I.‘)
a0 UDFB Modules —=
= SetPoints © Gauge x|
i @ Data Logging & Clock T
-3 User Interface |
h Calend
: @ Screen Thumbnail alendar E
B GIB Main Screen ]’_j Trend Graph Q
i T Screen 1 (1) 2 x-v Graph Y
a8 Alarms . : : o
Audio M Animated Picture/Graphic 2
g Recipe Database [E:I Video | B
Reports " e
Graphic Alarms i
@ Web ® Video . @
3. Click on the grid.
4. Then double click on the object to open the Video Properties dialog.
T Project Taoolbox o x 1 i ——
z B Screeni (1) A main
S | ® Fixed Objects
0
= | @ Live Text Data ﬂ
% B Live Graphic Data 3‘)
A @ Lamp/Indicator E -
B0 Bar Graph E
T @ meter =
i S Gauge Irs
2 Clock
5| Wl het
g Calendar 5
{2 Trend Grapgh @%
¥ »-r Graph =Y
@ Animated Picture/Graphic Q

B4 video

é Graphic Alarms

@ Touch Objects |

@ Clipart |

-
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5. Then double click on the icon in the middle to open the Video Properties dialog.

Display Properties
& Vaiable Aspect Ratio ¢ 4x3AspectRatie 1629 Aspect Ratio

Video Properties 4
Video Type
" Stieam  Enter Chanrel No
[ M ame: ] ;I 16-BiT
7* Playback Enter Target Path
| Name: | | @ s
~ Control
Trigger | Marme; | | @& .o
Statug I Marme: I ;] 1T

Attributess > > |

_JLIITID Elack SL-IBGII

Address / Screen number:
|1 Mame:

I~ Simulate ESC
I Allow ESC to Retum

ﬂ 16BIT Screen)l

aK Cancel
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15.3: Video Properties Configuration
15.3.1: Video Type

Video Properties X

Video Twpe
¢~ Stream | Enter Channel Mo

I | 16-BIT

+ Playback | Enter Target Path
I ﬂ L=-cir JAN

1~ Contral
Trigger | ‘ﬂ @& .o
Status [ _>| 16-EIT
Display Properties

* Varable &spect Ratio ¢ 4x3AspectRatin ¢ 16x9 Aspect Ratio Attributes >> |

Jump Back Screen-

Address / Screen number;

|-| Ll BT Screen >
I Simulate ESC
[ Allow ESC to Retum

0K | Cancel

There are two options for video type: Stream and Playback.

Stream — This option can be selected to view live video from a web cam. Four channels are supported through the USB hub.
Only one channel can be viewed at a time. Enter Channel Number directly or through registers in the Enter Channel No field.

Playback — This option can be selected to view videos that are stored in Removable Media on the controller. Videos present in

both A (microSD) and B (USB) drives are supported and can be viewed. Supported formats including .mp4, .mov, .mpg, and
.wmv, can be played.

Select Playback and enter video name in the Enter Target Path field either directly or through registers.
For example: Test1.mp4 (from microSD) or B:\Test2.mp4 (from USB).

Page 159 of 209



II HORNER

AUTOMATION GROUP
Chapter 15: Video Object

15.3.2: Control

Video Properties X

Video Type
" Siream  Enter Channel No
| _, 16-EIT

(¢" Playback Enter Target Path

| LI < <N

Control

Trigger | LI @ .o

Status ] ﬂ 16-E1T

Display Properties

* Variable Aspect Ratio ¢ 4u3 Aspect Ratio  © 16#9 Aspect Ratio Attributesy>>

Jump Back Screen
Address / Screen number:

1 A 1667 Scieen >

[ Simulate ESC
™ Allow ESC to Retun

oK | Cancel |

Trigger - The video control trigger is used to start, stop and pause video. Video trigger is done by bit level addressing. The
trigger reserves eight (8) bits and uses the first two (2) bits.

NOTE: The least significant bit is Bit 1.

: High = Start
Bit 1
Low = Stop
High=P
Bit 2 ig ause
Low = Play

Status - The Video Control System Bit provides the status of the Video Object. The status word is 16-bits and should be viewed
in hexadecimal format.

0x0001 Video is currently playing

0x0002 Video is paused

0x00010 Channel number cannot be greater than 4

0x0020 File not present or corrupted

0x0040 Frame per second not supported or not compatible
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15.3.3: Configuring Display Properties

Video Properties X

Video Type
" Stearn  Enter Channel No

| J 16-817

¢ Playback Enter Target Path
I o @

-Cantral

Trigger | Ll L
Status | Ll 1o

Display Properties

& Variable &spect Ratin © 4x3 Aspect Ratio ¢ 169 Aspect Ratio Attributesy »> |

Jump Back Screen
Address / Screen number:

I 2| s Soeen|

™ Simulate ESC
I~ Allow ESC to Rietum

| 0K I Cancel

Variable Aspect Ratio
Resolution Options 4x3 Aspect Ratio
16x9 Aspect Ratio

15.4: Video Object Performance

1.  When Video Object is active, navigating to System Menu or any popup window, causes Video Object to be
inactive.

2. Video Object can be made active in both Idle and Run modes.

3. If Frames Per Second of the configured video is different from the video that is configured in Cscape,
frames can be missed during the video.

15.5: Web Cameras

If multiple web cameras are directly connected to the OCS, then only one web cam will be considered. If user needs to connect
multiple web cams, USB hub needs to be used. A maximum of four channels (web cameras) are supported.
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16.1: Audio SPecCifiCatioNS .. . 163
16.2: Audio ConfiguratioN .. 164
16.3: AUIO FIleS 165

16.1: Audio Specifications

Audio Files Specifications

Formats Supported .MP3 & WAV

Audio Channel Type Supported Stereo

# of Files Supported 256 Audio Files can be configured

Bit Rates Supported 64kbps, 128kbps (recommended), 192kbps, 256kbps, 1411kbps
.MP3 Format Bit Rate Range 96 to 320kbps

.WAV Bit Rate Usually 1411kbps

Sampling Rate Supported 24000Hz to 44100Hz

« Only one audio file can be played at a time.
« If multiple bits are simultaneously triggered, only the least significant bit will

Audio Playback ; o L
be acted upon. After completing playback, the next least significant bit will be
acted upon.
. . Files must be presentin Removable Media for playback and are NOT downloaded
File Location

from Cscape.
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16.2: Audio Configuration

1. In Cscape, select the controller series and model number by selecting Controller > Hardware
Configuration from the toolbar. Click OK.

2. Next select Program from the toolbar and then Audio Config. This following dialog will open:

Huslic k4
Trggers | Mane | ] . xn
Slahst ] ml j wen xF
Auada Hex

Irdess | Auaches Target Path

or | caees

HIG=024

= Triggers — Set the trigger bit high to play the audio file.

NOTE: The bit needs to be left on to continue playing. The bit will be set to low after the file is finished laying.

®  Status — This register gives the status of the audio files, see table below.
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1st and 2nd Status Registers

Bit Number Description
Bit 1 to Bit 8 Volume Control (0-100)
1st Status Register Bit9 Play Control (1=Pause, 0=Play)
Bits 10-16 Not Used
Bit 1 Cannot open ALSA Lib
Bit 2 Cannot open MP3 Lib
Bit 3 Audio output device cannot be setup
Bit4 Cannot open input Audio Stream
Bit5 Memory allocation failed
2nd Status Register Bit 6 Buffer is not free
Bit 7 Write Fail
Bit 8 Short Write
Bit9 Recover Error
Bit 10 Filename Error
Bits 11-16 Not Used

16.3: Audio Files

= Index — Index of all the audio files will be assigned automatically when audio files are added.

= Audio Target Path — This gives information about the path of the audio file, audio filename, and format of
the audio files added to the list.

Ay Y
1
Toggms [ZROO00T  Mawres | EE_EL
Shafin ['_11;:.]-5[.-,. ;|m| 3 (L T
s Flaz
bdew | Audio Tasget Paih
1 Teatmpd
2 BAT sl e
3 AT est2mpd
add By | =l
0K, Careel
- [ ok | _cox |

Add - Selecting this button display the following window, where an audio filename with full path needs to be configure. The
Modify and Delete button are also available in the Audio Config dialog.
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Audio File X
Enter File name with Full path
| Name: | ]
Cancel
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Chapter 17: Removable Media

17.1: microSD Cards
17.2: Using the Removable Media Manager ... ... ... . 169

7.3 Log Data . 170
17.4: View and Capture SCreeNS ... ... .. 170
17.5: Removable Media ObjeCt ... ... . 170
17.6: FUNCHION BIOCKS iN CSCaPe ... . o 171
7T Flenames . 172
17.8: System Registers used With RM .. 172

All Horner controllers models provide a Removable Media slot, labeled Memory Card, which supports standard microSD flash
memory cards. microSD cards can be used to save and load applications, to capture graphics screens, and to log data for later
retrieval.

17.1: microSD Cards

MicroSD cards(Memory Cards) with up to 32GB of flash memory, are compatible with the Horner controller Memory Card slot.

The Memory Card slot is equipped with a “push-in, push-out” connector and a microSD card can be safely inserted into the
Memory Card slot whether the Horner controller power is On or Off.

®  Toinstall a microSD card: Align its 8-pin gold edge connector down, facing the front of the Horner controller unit as
shown above; then carefully push it all the way into the Memory Card slot. Ensure that it clicks into place.

®  Toremove the microSD card: Push down on the top of the card gently to release the spring. The card pops up for
removal.
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17.1.1: microSD File System

The microSD Memory Card slot uses the PC-compatible FAT32 File System. This means that a PC, with a microSD-compatible
card reader, can read files that have been written by the Horner controller and can write files that can be read by the Horner
controller.

However, the Horner controller does not support long filenames, but instead implements the 8.3 filename format. This means
that all file and directory names must consist of up to eight (8) characters, followed by an optional dot, and an optional extension
with up to three (3) characters.

Directories and sub-directories can be nested up to 16 levels deep as long as each path name string does not exceed 147
characters.

17.2: Using the Removable Media Manager

The Removable Media Manager is an interactive Horner controller screen that performs the following functions:
Display total capacity, and available space in kilobytes

Browse file and directory lists

Delete files and directories

Format a microSD card

© Qa0 T o

Load and save application programs
f.  View screen capture bitmaps

The Removable Media Manager can be accessed via the System Menu or by using Cscape to place a Removable Media
Manager object on an application graphics screen.

SD Card USB Drive
Name Date modified pe Size
m CAPTURES 01Jan2000 03:32:30 Dir 1.15 MB
i fonts 22Mar2024 11:33:10 Dir 6.17 MB
W horner 25Mar2024 12:22:58 Dir 478.41 KB
w keys 22Mar2024 11:33:08 Dir 447.85 KB
W livegraphics 22Mar2024 11:33:10 Dir 0 bytes
& System Volume Information 25Mar2024 12:23:44 Dir 88 bytes
[ canvas.Imq 22Mar2024 11:33:10 File 1.66 MB
[ JCFHASHFILE.HSH 01Jan2000 00:04:44 File 45 bytes
() DEFAULT.PGM 01Jan2000 00:52:08 File 3.83 KB
[ force 22MM4 11:33:08 File 0 bytes

ﬂ Total: 66.96 MB Used: 12.88 MB Free: 54.08 MB
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17.3: Log Data

Using Read and Write Removable Media function blocks, an application ladder program can read and write Horner controller
register data in the form of comma-delimited files, with a .csv extension. These files are compatible with standard database and
spreadsheet PC programs. In addition, an application ladder program can use Rename and Delete Removable Media function
blocks to rename and delete files.

17.4: View and Capture Screens

The Horner controller File System uses bitmap files with the .BMP extension or JPEG files with the .JPG extension to store
Horner controller graphic screen captures.

To view a captured Horner controller screen, use the Removable Media Manager to find and highlight the desire .BMP or .JPG

file, and then press Enter. A

To capture an Horner controller screen, turning on the assigned Screen Capture Control Register will capture the current
Horner controller graphics screen and write it to the microSD card using the assigned Screen Capture Filename.

Before capturing an Horner controller screen, Cscape must first be used to assign a Screen Capture Control Register and
Filename in the application. To do this, first open the User interface menu then select the Screen Capture item of the Config
menu and then enter a Control Register and Filename.

To capture an Horner controller screen, turning On the assigned Screen Capture Control Register will capture the current
Hornercontroller graphics screen and write it to the microSD card using the assigned Screen Capture Filename. To view a
captured Horner controller screen, use the Removable Media Manager to find and highlight the desired .BMP or .JPG file, and
then press Enter.

17.5: Removable Media Object

The configuration of the Removable Media Object that loads the Removable Media Viewer defines what buttons are enabled
and available to the user.

The iJ (Enter) button (if enabled) performs certain operations based on the selected file’s type:

. Change display to parent directory
<DIR> Change display to child directory
pgm Load application (if compatible model and version)

Alternately, by checking the ‘Write Selected Filename’ option, the RM Manager object will load the currently displayed path and
filename into a block of registers for use with other Removable Media functions. The register block is assigned in the ‘File Select’
config found in the Config menu of the graphic/screen editor.

Once view operations are complete, simply touch the Esc button to remove the pop-up removable media viewer.
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17.6: Function Blocks in Cscape

NOTE: For detailed information regarding RM function blocks and parameters, refer to the Help File in Cscape Software.
Refer to ‘USB flash Media support for RM Functions’ for USB flash drive access details.

The following RM functional blocks are available in Cscape Software. These function blocks will reference:

a. microSD when filename is prefixed with ‘A:’ or nothing
b. USB A flash drive when filename is prefixed with ‘B’
Allows reading of a comma-separated value file from the microSD interface into the controller
Read RM csv .
register space.
. Allows writing of a comma-separated value file to the microSD interface from the controller
Write RM csv .
register space.
Rename RM csv Allows renaming a file on the RM card. The data in the file is not changed.
Delete RM csv Allows deleting a file on the RM card
Copy RM csv Allows copying a file on the RM card. The data in the file is not changed.

17.6.1: Program Features

a.

C.

Datalog Configuration - This feature allows the controller to periodically log register values to Removable
Media. The register data is stored in .csv (comma separated value) format, which is compatible with 3rd
party PC applications, such as Microsoft Excel.

Report Editor - This feature allows the OCS to be configured to generate text printouts which incorporate
data from the registers embedded in the text. The reports can be printed using a serial interface printer
through any of the serial ports of the OCS or can be saved on the removable media of the device.

Recipes Editor - Recipes allow the user to send or update multiple registers simultaneously.

17.6.2: Graphic/Screen Editor

a.
b.

Trends - The historic support feature in the trend object utilizes Removable Media.

Removable Media - This is a graphic object used to access files and functions pertaining to Removable
Media.

Recipes - This is a graphic object that is used in conjunction with the recipe editor which is mentioned
above.
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17.6.3: Additional Configuration

a. Alarms - Alarm data can be logged to a .csv file stored on Removable Media.

b. Screen Capture - The screen capture function allows a bitmap or jpeg image of the displayed OCS screen
to be written to the Removable Media card.

c. Filename Counters - The filename counters can be accessed wherever Removable Media functions
require a path name. A typical application is the auto-incrementing of a file name when doing screen
captures.

d. File Select - File Select is used to specify the register block that is used with the Removable Media
Manager object ‘Write Selected Filename’ option.

17.7: Filenames

The RM function blocks support the flash with a Windows standard FAT-16 file system. All names must be limited to the “8.3”
format where the filename contains eight characters a period then a three-character extension.

The entire filename including any path must be less than or equal to 147 characters.

When creating filenames and directories, it is sometimes desirable to include parts of the current date or time. There are six
special symbols that can be entered into a filename that are replaced by the OCS with current time and date information.

Filename Special Symbols |

Symbol Description Example
$Y Substitutes the current 2-digit year 2015=15
$M Substitutes the current month with a 2-digit code March =03
$D Substitutes the current day 22nd =22
$h Substitutes the current hour in 24-hour format 5pm=17
$m Substitutes the current minute 45=45
$s Substitutes the current second 34=34

NOTE: All the symbols start with the dollar sign ($) character. Date symbols are in upper case, time symbols are in lower
case.

The following are examples of the substituted time/date filenames:

Current date and time: March 1, 2015 5:45:34 PM

Filename: Data$M$D.csv = Data0301.csv

Filename: Year$Y\Month$M\aa$D_$h.csv = Year15\Month03\aa01_17.csv
Filename: Month_$M\Day $D\$h_$m_$s.csv = Month_03\Day_01\17_45 34.csv

17.8: System Registers used with RM

%SR174 — Removable Media Protect. Write a one (1) to %SR174 to prohibit read/write access to the removable media card.
Write a zero (0) to allow access.

%SR175 Status — This shows the current status of the RM interface.

%SR176 Free Space — This 32-bit register shows the free space on the RM card in bytes.
%SR178 Card Capacity — This 32-bit register shows the total card capacity in kilobytes.
Possible status values are shown in the table:

RM interface OK

Card present but unknown format

No card in slot

Card present, but not supported

AlW[IN]|=2]|O

Card swapped before operation was complete
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RM Status Values
5 Unknown error
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Chapter 18: Clone Unit

8. MaKe ClONe
18,2 Load ClONe . 177

"Clone Unit" feature allows the user to “clone” the OCS of the exact same model. This feature “clones” application program and
unit settings stored in battery-backed RAM of an OCS into the RM. Refer to "Removable Media" on page 1 for more details. It
can then be used to clone a different OCS (exact same model).

This feature can be used for:
®  Replacing an OCS by another unit of the same model.

®  Duplicating or “clone” units without a PC.

18.1: Make Clone

The user needs to perform the following to Clone:

Step 1: The ‘Clone Unit’ can be accessed by going to the ‘System Menu’ of the OCS then select Removable Media, select “make
Clone” has been added at the end of the removable media.

SYSTEM MENU (X) Close

= X

Performance Diagnostics Capacity

oL £ @

Fail Safe

Serial Port Time & Date .
(aleo e Media

04-Apr-24 IP1:192.168.254.128 Cv-070D-00 0] 4 (11

L

10:27:07 IP2: 000.000.000.000 CAN ID: 253 Run Linear View
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Step 2: Selecting “Make Clone” will open the make clone window, press YES to make “CLONE ".

SD Card
0007 Jpg 0008.jpg AUTOLOAD.PGM

0o ] M A -7 cex oo

NOTE: Free/Total — displays number of free and total bytes in Removable Media

Make/Create Clone option enables user to duplicate/Clone application file, all unit settings and all register values from battery-
backed RAM. Selecting Make Clone brings up the screen below for the user:

Are you sure you want to make clone?

Make/Create clone can also be triggered by setting %SR164.9 bit to “1” from Ladder program or graphics. Once the operation is
completed, this bit is made zero by the firmware. When Make Clone operation is triggered by this SR bit, it does not ask the user
for confirmation for making clone. The success / failure of the operation is also not noti-fied on screen to the user.

In case of failure of “Make Clone” operation, %SR164.11 bit is set to “1” by the firmware and never reset.
NOTE: Backup of registers in flash memory is not performed by Clone Feature. Refer to "Fail-Safe System".
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18.2: Load Clone

This option loads the application, all unit settings and register values from Removable media to the battery-backed RAM
(Regardless of AutoLoad settings) and then resets the OCS for the settings to take effect.

User needs to perform the following to Load Clone:
Step 1: Select “Load clone” from removable media of OCS as shown below:

SD Card USB Drive
EERn
N 2te modified _ e
i CAPTURES 02Apr2024 12:22.02 Dir 5.76 MB
[JAUTOLOAD.PGM 02Apr2024 12:26:17 File 295.34 KB
[T DEFAULT.PGM 02Apr2024 12:26.06 File 294.67 KB

Step 2: Select “Load clone” in the menu option at bottom of the screen, “Load Clone” popup window will get open then select
Yes to “Load clone”.

Step 3: User needs to confirm Load Clone as shown below:

Are you sure you want to load clone?

Step 4: After confirmation, all unit settings and register values will be loaded from Removable media to the Battery backed RAM
(Regardless of AutoLoad settings) and then OCS resets for the settings to take effect.

NOTE: For security enabled files, Load clone asks for password validation before loading the application.

Load Clone can also be triggered by setting %SR164.10 bit to “1” from Ladder program or graphics. Once the operation is
completed, this bit is made zero by the firmware. When Load Clone operation is triggered by this SR bit, it does not ask the user
for confirmation for loading clone. The success / failure of the operation is also not notified on screen to the user.

In case of failure of “Load Clone” operation, %SR164.12 bit is set to “1” by the firmware and never reset.
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19.1: Forthe Canvas Series ... ... .. ... 179
19.2: Fail-Safe System OVerVieW ... . 179
0.3 SettiNGS . 180
19.4: BackUp/Restore Data ... ... ... ... . 180
19.5: Clear Backup Data ... ... ... 182
10.6: AUtOL Oad .. 184
0.7 AU O RUN 186
19.1: For the Canvas Series

The Fail-Safe System is a set of features that allow an application to continue running in the event of certain types of "soft"
failures. These "soft" failures include:

19.2:

Retentive Register or Application flash corruption due to, for example, an excessive EMI, Electromagnetic
Interference, event.

Battery-Backed Register RAM or Application flash corruption due to, for example, an excessive EMI, Electromagnetic
Interference, event.

Fail-Safe System Overview

The Fail-Safe System has the following capabilities:

Manually backup the current Retentive Register Settings into flash memory.
Manually restore Register Settings from the values previously backed up in flash memory to battery-backed RAM.
Detect corrupted Register Settings at power-up and then automatically restore them from flash.

Detect corrupted or empty application in flash memory at power-up and then automatically load the AUTOLOAD.PGM
application file from Removable Media (Compact flash or microSD).

If an automatic Register Restore or Application Load occurs, the OCS can automatically be placed in RUN mode.

The fail-safe system can be accessed by going to the System Menu of the controller, by selecting “fail-safe” the following menu
will be displayed:

ﬂ Home SYSTEM MENU > FAIL SAFE

Auto run
Backup/Restore Data
Auto Load SD

Auto Load USB

02-Apr-24 IP1:192.168.254.128 Cv-070D-00
12:37.54 IP2: 000.000.000.000 CAN ID: 253
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19.3: Settings

To use the Fail-Safe feature, the following steps are required:

1. From “Make Clone” option, create AUTOLOAD.PGM file or through Cscape, create AUTOLOAD.PGM for the
application program using ‘Export to Removable Media’.

2. Place the Removable Media with AUTOLOAD.PGM in the device.
3. Setthe ‘Enable AutoLoad’ option in the device to YES.

4. Setthe ‘Enable AutoRun’ option to YES if the controller needs to be placed in RUN mode automatically after automatic
restore of data or AutoLoad operation.

5. Backup the current battery-backed RAM Register contents in onboard flash memory using System Menu options.

19.4: Backup/Restore Data

Selecting this option brings up a screen having four operations:
= Backup OCS Data.
®  Restore OCS Data.
= Clear Backup Data.
= Exit

e _

19.4.1: Backup OCS Data

When initiated, this will allow the user to manually copy battery-backed RAM contents on to the onboard flash memory of the
OCS. This will have the effect of backing up all the registers and controller settings (Network ID, etc.) that would otherwise be
lost due to a battery failure. %SR164.4 is set to 1 when backup operation is performed.
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Create New Backup?

19.4.2: Restore OCS Data

When initiated, this will allow the user to manually copy the backed-up data from the onboard flash to the battery-backed RAM.

A restore operation will be automatically initiated if 1) a backup has been previously created and 2) on power-up the battery-
backed RAM registers fail their check.

The following steps are required:
1. Place the controller in IDLE mode.
2. Copy data from onboard flash memory to OCS battery-backed RAM
3. Resetthe Controller.
4. Putthe controller in RUN mode if the AutoRun setting is ‘Yes’, or else it will remain in IDLE mode.

Are You Sure? This will cause System Reset!

C=] [

%SR164.3 is set to 1 only when an automatic restore operation is performed, not on a manual one. This bit is reset to the value
of “0” when a new backup is created.

Restoring of data can be manually performed by selecting RESTORE option from the Backup / Restore Data menu. This will
cause the controller to reset.
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19.5: Clear Backup Data

When initiated, the backup data will be erased from the onboard flash and no backup will exist. %SR164.4 and %SR164.3 is
reset to 0 when backed up data is erased.

-

Exit: Goes back to the previous screen.
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The OCS follows the following sequence in execution of Automatic Restore:

7 0CS Power
I |
. Cycle J

|

Battery Backed RAM
Registers chack faikad

Ty
T

"y
oy
Backup ™.
~. Bxists?

.,
Ty
.,

No

'

Controller placed in
IDLE mode

L

Application
Program erased

¥

Data copied from Onboard FLASH 1o
DCS Battery backed RAM

l

Controllar
Resets

) L
Aﬁu n. e __=| OCS putin

- enabled? IDLE made

Bt
Ty
Bt

'I'IB

OCS put in

EUN Made
HG-097 L J
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19.6: AutoLoad

This System Menu option allows the user to specify whether the OCS automatically loads the application AUTOLOAD.PGM
located in Removable Media.

When the AutoLoad setting is enabled (set to YES), it can either be manually initiated or automatically initiated at power-up.
The automatic initiation will happen only in the following two cases:
= When there is no application program in the OCS and a valid AUTOLOAD.PGM is available in the
removable media of the device.

= When the program residing in onboard memory is corrupted and a valid AUTOLOAD.PGM is available in
the removable media of the device.

AutolLoad can be manually initiated when the SYS-F3 key is pressed (OCS can be in any of the following mode —
Idle/Run/DOIO). This also requires a valid AUTOLOAD.PGM to be present in the removable media of the device.

When the AutoLoad setting is not enabled (set to NO), OCS will be in IDLE mode and the application is not loaded.

If the AUTOLOAD.PGM is security enabled, the user will be prompted to enter the password before loading the application. The
application will be loaded from the Removable media only after getting the correct password.

%SR164.6 can be set to enable AutoLoad feature.

ﬁ Home SYSTEM MENU > FAIL SAFE

Auto run
Backup/Restore Data
Auto Load SD

Auto Load USB

02-Apr-24 IP1:192.168.254.128 Cv-070D-00
12:37:54 IP2: 000.000.000.000 CAN ID: 253

No = Does not load AUTOLOAD.PGM automatically when application program is absent or
corrupted.

Yes = Loads AUTOLOAD.PGM file automatically from Removable Media when application
program is absent or corrupted.

Enable AutoLoad
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The OCS follows the following sequence in execution of AutoLoad:

- ™,
@'mar up OCS|
v

‘1[

Application Program absent or
Application Program corrupted

OCS putin IDLE
mode

AutoLoad run
— sequence failed (with
reasons for failure)

AUTOLOAD.PGM
present in the RM of
the device?

Yes

v

‘ AutoLoad initiated ‘

Y Y
AutoRun . _ OCS putin IDLE
Enabled? - Mode

OCS putin
RUMN Mode

G D26
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19.7: AutoRun

This System Menu option, when enabled (YES), allows the user to automatically place the OCS into RUN mode after the
AutoLoad operation or automatic Restore Data operation.

When the AutoRun setting is disabled (NO), the OCS remains in the IDLE mode after a Restore Data or AutoLoad operation.
%SR164.5 can be set by putting the system into RUN mode automatically, once an AutoLoad has been performed or an
Automatic Restore has occurred.

If for any reason the AutoLoad-Run (Loading the AUTOLOAD.PGM automatically and OCS put in RUN mode) sequence does
not succeed, a pop-up message box saying "AUTO-LOAD-RUN SEQUENCE FAILED" will be displayed. It will also show the

reason for its failure. On acknowledging this message box, the AutoLoad-Run sequence will be terminated, controller will return
to the first user-screen and will be placed in IDLE mode.

A Home SYSTEM MENU > FAIL SAFE

Auto run
Backup/Restore Data
Auto Load SD

Auto Load USB

02-Apr-24 IP1:192.168.254.128 Cv-070D-00
12:37:54 IP2: 000.000.000.000 CAN ID: 253

Enable AutoRun

No = OCS will be in IDLE mode after AutoLoad or Automatic Restore.
Yes = OCS will automatically be placed into RUN mode after AutoLoad or Automatic Restore.

“Enable AutoLoad” displays the following options:

Enable AutoLoad

No = Does not load AUTOLOAD.PGM automatically when application program is absent or
corrupted.

Yes = Loads AUTOLOAD.PGM file automatically from Removable Media when application
program is absent or corrupted.
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Chapter 20: Modbus Communications

20.1: Modbus Slave OVerVieW ... 188
20.2: Modbus Master OVerVieW .. ... . 189
20.3: Modbus Addressing Table ... ... . 190

For complete Modbus instructions, please refer to the Help file in Cscape.

Modbus (serial) is a popular, de-facto standard protocol that allows industrial devices from multiple manufacturers to easily
share data in real-time. For Modbus serial communications, the Canvas 7D can act as either a Master or a Slave.

Modbus protocol (serial) allows for one master and multiple slaves. The master always initiates the conversation by sending a
request to a particular slave. Only the addressed slave will send a response when the request is completed. Should the slave be
unable to complete the request, it returns the appropriate error response. Should the slave be unable to respond, the master’s
timeout timer expires to provide an indication of No Response.

20.1: Modbus Slave Overview

For complete Modbus Slave instructions, please refer to the Help file in Cscape.
The Modbus slave function block, when used with the appropriate Modem and/or Open Function Blocks, allows the primary
serial port on the controller to act as a Modbus slave. The Modbus function supports both ASCII and RTU modes of operation

across a range of baud rates and protocol frames. Also supported is port activity status, an inactivity timer, support for call-on
exception, and support for store and forward (repeater) operation for radio modems.

The "20.3: Modbus Addressing Table" on page 190 section describes the supported Modbus Commands as well as the Modbus
Map for Canvas 7D References (%R, %M, etc.).
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20.2: Modbus Master Overview

For complete Modbus Master instructions, please refer to the Help file in Cscape.

When acting as a Modbus master, there are two primary mechanisms used by the Canvas 7D to allow the user to specify the
data to be read/written from/to the slaves.

Modbus Master Function Block—This is for serial only. This is an advanced feature that should only be used in rare
occasions.

Protocol Config—The Protocol Config is configured in the Hardware Configuration dialog box in Cscape (serial). Refer to the
"20.3: Modbus Addressing Table" on the next page. This is the preferred method in most applications.

After the protocol has been selected from the dropdown menu, the Network, Devices, and Scan List become available. The
Protocol Config is configured on three different levels:

®  Network—Parameters, such as the polling rate of the data scan, are specified along with timeout values, retry, and re-
acquisition settings. Serial configuration, baud rate, parity, etc. are also set here.

®  Devices—For every slave to be polled, configuration details are added in the Devices dialog box. This includes Slave
ID (serial). Under Device Type, the Modbus addressing style matching that specified in the slave’s user documentation
may be selected. For instance, some slaves specify Modbus addresses (i.e. 40,001), and others specify offsets (i.e.
0000).

= Hex or Decimal—Some specify addresses in hex, and others in decimal. By allowing the user to select the
Modbus addressing style for each slave on the network, minimal address conversion is required. Also, if the
slave is another Horner product (i.e. another OCS), the “Native Addressing” option can be selected (i.e. %R1,
%M17, etc.), and this skips the conversion to Modbus style altogether.

®  Scan List—This is where the specific Modbus addresses to be read/written from/to each slave are specified. Up to 32
words of data can be read at the same time.

NOTE: Once configuration has been completed on the Network and Devices level, Modbus data can be directly read/written
from graphics objects in the Cscape screen editor. This is available even if the Modbus register is not listed on the scan list.
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20.3: Modbus Addressing Table

To access Canvas 7D registers, a Modbus Master must be configured with the appropriate register type and offset. This is
usually accomplished with one of two methods:

Method 1: The first method uses Traditional Modbus References, in which the high digit represents the register type, and the
lower digits represent the register offset (starting with Register 1 for each type). Since only four register types can be
represented in this manner, Canvas 7D Modbus Function Blocks pack several Canvas 7D register types into each Modbus
register type. Starting addresses of each Canvas 7D register type are shown in the Traditional Modbus Reference column of the
Mobus Table.

Method 2: The second method requires the Modbus Master to be configured with a specific Modbus Command and Modbus
Offset. The supported Modbus commands and the associated offsets are also illustrated in Modbus Table.

Canvas 7D Modbus Master Mapping
Maxi Trad. Modbus Expanded Modb
Reference ;):Lnguem Reference Modbus Ref. Modbus Command(s) gﬁs::
(5 Digits) (6 Digits)

%I1 2048 10001 010001 0
%IG1 256 13001 013001 3000
%S1 256 14001 014001 Read Input Status (2) 4000
%K1 5 15001 015001 5000

%Q1 2048 00001 000001 0
%M1 2048 03001 003001 Read Coil Status (1) 3000
%T1 2048 06001 006001 Force Coil (5) 6000
%QG1 256 09001 009001 Force Multiple Coils (15) 9000

%AI1 512 30001 030001 0
%AIG1 32 33001 033001 . 3000

Read Input Register (4)

%SR1 256 34001 034001 4000

%AQ1 512 40001 040001 0
%R1 2488 40513 040513 ) ] 512

Read Holding Register (3)
%R1 2048 43001 043001 . 3000
%AQG1 32 46001 046001 Load Register (6) 6000
2 Load Multiple Registers (16)
%R1 9999 - 410001 10000
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Chapter 21: Canvas OCS Battery

21 Saf Oty
21.2: Replacing the Battery ... ... 193

21.1: Safety

The Canvas OCS has an improved memory architecture that does not require a battery for program or register retention. The
onboard lithium coin-cell battery runs the real time clock and is user replaceable with an expected lifetime of seven (7) to ten
(10) years.

Environmental conditions, including extreme temperatures and humidity, can affect battery life. If the battery older than seven (7)
toten (10) years old, it is recommended that it be replaced as preventative maintenance. NOTE: Use only the proper battery type
listed.

NOTE: Use only the proper battery type listed.

WARNING: DO NOT USE IF BATTERY IS LEAKING OR HAS BEEN DAMAGED.

WARNING: LITHIUM BATTERIES MAY EXPLODE OR CATCH FIRE IF MISTREATED.

WARNING: DO NOT RECHARGE, DISASSEMBLE, HEAT ABOVE 100° C (212° F) INCINERATE, OR PUNCTURE.

WARNING: EXPLOSION HAZARD — BATTERIES MUST BE ONLY BE CHANGED IN AN AREA KNOWN TO BE NON-
HAZARDOUS.

WARNING: Disposal of lithium batteries must be done in accordance with federal, state, and local regulations. Be sure to
consult with the appropriate regulatory agencies before disposing batteries. In addition, do not recharge, disassemble, heat
or incinerate lithium batteries.

WARNING: Do not make substitutions for the battery. Be sure to only use the authorized part number to replace the battery.
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21.2: Replacing the Battery

The Canvas OCS uses a lithium coin-type battery with part no. HE-BAT013, with harness and connector available from Horner
APG.

WARNING: Replacing the battery is a delicate procedure. If unsure about the procedure, please contact Horner

Tech Support via

H-oa
Below are the steps to replace the battery:
1. Make sure the user program and any data stored in retentive memory is backed up.
2. Disconnect all power from the Canvas OCS unit including I/O power.

3. On the back of the Canvas OCS model, remove the back cover by removing four screws found in the corners of the
panel.

NOTE: In some models, a board must also be removed.

4. Connect the new battery into the adjacent connector first and then carefully remove the old battery. With a small piece
of tape provided, attach the new battery to the board.

5. Dispose of the old battery properly; see the above warning on disposal regulations.
Carefully place the back panel (and board if necessary) and replace the four screws.

7. Apply power to the unit. Check that the battery error is no longer reported. If the unit still reports the error, remove the
battery immediately and contact Technical Support.

Page 193 of 209


https://hornerautomation.com/contact-us/

II HORNER

AUTOMATION GROUP

Firmware
Update




II HORNER

AUTOMATION GROUP
Chapter 22: Firmware Updates

Chapter 22: Firmware Updates

22.1: Check for Current Firmware RevisSioNn ... ... . 195
22.2: Firmware Update Details ... .. .. ... 196
22.3: Download FirmWare ... 196

22.4: Firmware Update Steps

The Canvas 7D OCS products contain field updatable firmware to allow new features to be added to the product. Firmware
updates should only be performed when a new feature or correction is required.

WARNING: Firmware updates should only be performed when the equipment being controlled by the OCS is in a
safe, non-operational state. Communication or hardware failures during the firmware update process can cause the
controller to behave erratically resulting in injury or equipment damage. Make sure the functions of the equipment
work properly after a firmware update before returning the device to an operational mode.

22.1: Check for Current Firmware Revision

To check the firmware revision on a controller, open System Menu > View Status.

ﬁ Home SYSTEM MENU > DIAGNOSTICS > VERSION 4= Back

Firmware Rev 16.33.201
FPGA Rev 0.2
OS Version

System Version

02-Apr-24 IP1:192.168.254.128 Cv-070D-00
12:02:54 IP2: 000.000.000.000 CAN ID: 253
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22.2: Firmware Update Details

NOTE: Updating firmware will clear the application program, screens, configurations, and register data. If required, make sure to
backup program and register data before updating firmware. The controller's User Manual has instructions for doing backups.

Method A: Removable Media Method — The controller firmware is updated by a bootloader, using a microSD card or USB
Flash drive (not through the Cscape Firmware Update Wizard). To update or change firmware:

1. Download desired Firmware set from the Horner APG website. Verify NOTE: Files from the Horner website come as a .ZIP file
which need to be unzipped and placed in the root of the drive for them to function properly.

2.Save Firmware files to microSD card or USB, these are the removable media devices.

22.3: Download Firmware

In North America, visit https://hornerautomation.com. Then click Support > Downloads > Controller Firmware and download
the most recent firmware set with the correct communication protocol.

-OR-
In Europe, visit http://www.hornerautomation.eu and click Support > Firmware tab and download the desired firmware (an
account is required to access firmware updates, create one if necessary).

22.4: Firmware Update Steps

Update firmware in an Canvas 7D by completing the following steps:

—_

Unzip all files from downloaded.zip file ("Download Firmware" on the previous page) onto removable media or USB.
Plug the removable media or USB into a powered-up OCS controller.
Press and hold the SYSTEM key until the SYSTEM RECOVERY SCREEN appears.

Select “System Upgrade SD or USB” option then press YES for upgrade system from SD or USB.

2
3
4
5. After validating the package firmware upgrade will starts.
6. When Operation Completed appears, Power-cycle the OCS controller and wait for it to boot up.
7. Press SYSTEM key, select Diagnostics then select versions and press the Enter button

8. Check firmware version.

9

If any of the version numbers are incorrect, verify the correct files were copied to the removable media device and
repeat the steps above

For more Firmware Update information refer to the Firmware Update Manual, MAN1011, which can be found on the Horner
website. NOTE: User must register and be logged into website in order to download this manual.

Page 196 of 209


https://hornerautomation.com/
http://www.hornerautomation.eu/
https://hornerautomation.com/documentation-search/?cmdm_direct_download_id=122961

II HORNER

AUTOMATION GROUP

Chapter 22: Firmware Updates

SYSTEM RECOVERY SCREEN

X oot

1o

Replace System Graphics USB

.

Are you sure you want to upgrade system from SD?

=0 )

Perforning Upgrade for Primary
Expected Time: 2 Minutes ...
done

l;tpg-r\nde complete for Primary. Please power cycle the deviee ..
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Chapter 23: Troubleshooting

23.1: Connecting to the OC S .. 199
23.2: Local Controller and Local /O ... ... . 201
23.3: CSCAN NetWOTK .. 201
23.4: USB Interfaces ... ... ... . 202
23.5: Basic Troubleshooting .. ... ... 203
23.6: Technical Support Contacts ... ... .. .. . 203

23.1: Connecting to the OCS

Cscape connects to the local controller automatically when the serial connection is made. The status bar below shows an
example of a successful connection. This status bar is located in the bottom right-hand corner of the Cscape window.

'|L|:u:al:253 Target:253(R) [no Forces]

In general, the Target number should match the Local number. The exception to this is when the controller is being used as a
"pass through" unit where other controllers on a CsCAN network could be accessed through the local controller. See Cscape
Help File for more details.

Determine connection status by examining feedback next to Local & Target in the status bar of Cscape.

Cscape Target & Local Numbers

Local: #Ht If a number shows next to Local then communication is established to the local controller.

Cscape is unable to access the COM port of the PC. This could mean that Cscape is configured for a
Local: No Port COM port that is not present or that another program has control of the COM port. Only one Cscape
window can access a port at a time. Subsequent instances of Cscape opened will indicate No Port.

Cscape has accessed a PC COM port but is not communicating with the controller. This typically occurs

IHEISEL LD (e when the controller is not physically connected.

Unknown communication error. Close Cscape, power cycle the controller and reopen Cscape with a

. 222
Local: 777 blank project. Check Local.

If 1 (idle), R (run), or D (do I/0) shows next to Target number, then communication is established to the

VERREEAL ) target controller.

Communication is not established to the target controller. Check node ID of controller and set Target to

- #(?
VEEE 24t match. Make sure local connection is established.
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23.1.1: Serial Port — MJ1 Programming

Controller must be powered up.

Ensure that the correct COM port is selected in Cscape. Tools > Applications Settings >
Communications.

Ensure that a cable with proper pinout is being used between PC and controller port MJ1.

Check that a Loaded Protocol or ladder is not actively using MJ1. Taking the controller out of Run Mode
from the System Menu on the controller will make MJ1 available to Cscape.

Successful communications with USB-to-serial adapters vary. If in doubt, Horner APG offers a USB to
serial adapter: part number HE-CPK.

23.1.2: USB Port - Mini B Programming

4.

Controller must be powered up.

Ensure that the correct COM port is selected in Cscape.Tools > Applications Settings >
Communications > Configure.

Be sure that the USB cable is connected between the PC and the controller. Check Windows Device
Manager to ensure that the USB driver is properly installed and to verity the port number.

The Mini-B USB port driver installs.

23.1.3: ETN Port Programming

Controller must be powered up.

Ensure that the correct IP address is given in the Ethernet field and correct Mode is selected, in Cscape:
Tools > Applications Settings > Communications.

Ensure that an Ethernet connection has been established by pinging the controller from the Windows DOS
prompt.
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23.2: Local Controller and Local I/0
The System Menu provides the following status indications that are useful for troubleshooting and system maintenance. To view
the System Menu, press the System key.

®m  Self-test results, diagnostics.

®  RUN and OK status

= Network status and usage

= Average logic scan rate

= Application memory usage

® | oaded firmware versions

® | oaded protocols

®  Removable media access

23.2.1: Local I/0 Troubleshooting Checklist

1. Verify the controller is in RUN mode.

n

Check diagnostics to ensure controller passed self-tests. View Diags in System Menu or in Cscape, click
Controller/Diagnostics.

Check data sheets to ensure proper wiring.
Ensure that hardware jumpers and software configuration for I/O match.
Check data sheets for voltage and current limits.

Take ladder out of the picture. From Cscape set controller to “Do I1/O” mode. In this mode inputs can be
monitored, and outputs set from a data watch window in Cscape without interference from the ladder
program. Some I/O problems are only a result of a mistake in the ladder program.

o0 ko

WARNING: Setting outputs ON in Do I/O mode can result in injury or cause machinery to engage in an unsafe manner

depending on the application and the environment.

23.3: CsCAN Network

For complete information on setting up a CsCAN network, refer to CAN Networks manual (MANQO799) by using Horner's
Documentation Search page.

Network status, node ID, errors, and baud rate in the controller System Menu are all in reference to the CsCAN network. These
indications can provide performance feedback on the CsCAN network and can also be used to aid in troubleshooting.
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23.3.1: CsCAN Network Troubleshooting Checklist

1.

10.
11.

12.
13.

14.

23.4:

Use the proper Belden wire type or equivalent for the network as specified in the CAN Networks Manual,
MANO799.

The Horner OCS does not provide 24VDC to the network. An external voltage source must be used for
other devices such as SmartStix I/O.

Check voltage at both ends of the network to ensure that voltage meets specifications of attached devices.

Proper termination is required. Use 121Q (or 120Q) resistors at each end of the network. The resistors
should be placed across the CAN_HI and CAN_LO terminals.

Measure the resistance between CAN_HIl and CAN_LO. If the network is properly wired and terminated,
there should be around 60Q.

Check for duplicate node ID’s.

Keep proper wires together. One twisted pair is for V+ and V- and the other twisted pair is used for CAN_HI
and CAN_LO.

Make sure the baud rate is the same for all controllers on the network.
Assure shields are connected at one end of each segment—they are not continuous through the network.
Do not exceed the maximum length determined by the baud rate and cable type.

Total drop length for each drop should not exceed 6m (20’). A drop may include more than one node. The
drop length adds to the overall network length.

Network should be wired in "straight line" fashion, not in a "star" pattern.
In applications requiring multiple power supplies, make sure the V- of all supplies is connected and to earth
ground at one place only.

In some electrically noisy environments, it may be necessary to add repeaters to the network. Repeaters
can be used to add additional nodes and/or distance to the network and protect the signal against noisy
environments.

USB Interfaces

Plugging and unplugging USB devices while the OCS is powered up can cause the OCS to reset. In
general, branded USB memory sticks will not cause this problem, however, with the advent of USB 3.0 and
larger / faster memory devices this cannot be guaranteed.

Larger USB devices such as hard-drives etc. should only be attached and removed when the OCS is
powered down.

The resets are caused by short sharp current spikes when devices are added or removed from the OCS,
these spikes can exceed the USB specification but are usually very short and mostly do not cause
problems. Some devices however draw a longer larger current as they power up causing a brief dip in the
OCS internal supplies leading to a reset.

Standard SanDisk and Kingston ranges with read times less than 120MB/sec. should not cause resets.
The display will flicker when a device is added or removed.
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23.5: Basic Troubleshooting

OCS does not read media card. The media card should be formatted with the controller.

Make sure the project file is saved as a .pgm file and not a .csp file. In addition, the file
OCS will not download project file. must be .pgm. The file's I/O configuration must match the controller configuration for it to
download.

23.6: Technical Support Contacts

For manual updates and assistance, contact Technical Support at the following locations:
North America:

Tel: (317) 916-4274

Fax: (317) 639-4279

Website: https://hornerautomation.com
Email: APGUSATechSupport@heapg.com
Europe:

Tel: (+) 353-21-4321-266

Fax: (+353)-21-4321826

Website: https://www.hornerautomation.eu
Email: technical.support@horner-apg.com

Page 203 of 209


https://hornerautomation.com/
mailto:techsppt@heapg.com
https://www.hornerautomation.eu/
mailto:technical.support@horner-apg.com

II HORNER

AUTOMATION GROUP

Index

PPPPPPP



lIHORNER

AUTOMATION GROUP

INDEX

A
AlarMS ..o 149
Alpha-NumericKeypad ...................................... 146
Analog Input Configuration .................................. 89
Analog Outputs ... ... 96
AudioFiles ... 165
Audio Playback
Audio Configuration ..................................... 164
AudioFiles ... 163
Autoload ... 184
AutoRuUN ... 186
B
Back Cover Dimensions ....................................... 18
Backup/RestoreData ...................................... 180
Basic Troubleshooting ....................................... 203
Beeper Acknowledgment ................................... 148
Built-in Digital and Analog I/O Overview ................... 78
(o
CAN Communications ................................co. 124
CAN1 PortWiring ........................................ 124
Cscape Programming ................................... 125
/O EXpansion ... 125
Ladder-Controlled ....................................... 125
Port Description ... 124
Canvas OCSBattery ....................................... 192
ReplacingtheBattery ................................... 193
Safely ... 192
Check for Current Firmware Revision .................... 195
Clearance/Adequate Space ................................ 21
CloneUnit ... 175
LoadClone .................cooiiiii 177
MakeClone ... 175
Communicating via MJ1 Serial Port ......................... 73
Communicating via On Board EthernetPort .............. 74
ConfigurationviaMini-BUSB ............................... 122
Connectingtothe OCS ..................................... 199
CsCANNetwork ... 201
CsCAN Network Troubleshooting Checklist ............. 202
Cscape Configuration .................................... 67,76
Establishing Communications ........................... 68
viaMJ1 Serial Port ... 73
via On Board EthernetPort ............................... 74

Cscape Programming via CAN ............................ 125
Cscape Programming via Serial Port ..................... 122
Cscape StatusBar ... 67
Cscape Target & Local Numbers .......................... 199
D
Device List and Device Configuration ..................... 136
Digital / HSC Input Configuration ............................ 80
Digital / PWM Output Configuration ......................... 84
Digital Output Configuration ................................. 86
Dimensions ... 19
Dip Switches ........... ... . 121
Displayingand EnteringData ............................... 145
Download Firmware ......................................... 196
E
Electrical Installation .......................................... 24
Ground Specifications .................................... 24
How to Test for Good Ground ........................... 24
Primary Power Port ... ... . ... 25
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DipSwitches ... . 121
Ladder-Controlled ....................................... 122
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